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Preface

This guide describes how to install and configure Oracle Utilities Advanced Spatial and 
Operational Analytics (OUASA) version 2.4.1.

Audience
This guide is intended for anyone interested in understanding or performing the process of 
installing or configuring Oracle Utilities Advanced Spatial and Operational Analytics v2.4.1.

Prerequisite Knowledge
OUASA requires a few other software products for it to function. The person reading this guide 
should have experience of working on or installing the following products:

• Oracle Database Server

• Oracle Business Intelligence Enterprise Edition

• Oracle Warehouse Builder

• Oracle Data Integrator

Related Documents
For more information, refer to the following documents in the Oracle Utilities Advanced Spatial 
and Operational Analytics documentation library:

• Oracle Utilities Advanced Spatial and Operational Analytics Release Notes

• Oracle Utilities Advanced Spatial and Operational Analytics Quick Install Guide

• Oracle Utilities Advanced Spatial and Operational Analytics Administration Guide

• Oracle Utilities Advanced Spatial and Operational Analytics User's Guide

• Data Mapping Guide for Oracle Utilities Meter Data Management Extractors and Schema

• Data Mapping Guide for Oracle Utilities Mobile Workforce Management Extractors and Schema

• Data Mapping Guide for Oracle Utilities Work and Asset Management Extractors and Schema

• Data Mapping Guide for Oracle Utilities Network Management System Extractors and Schema

• Data Mapping Guide for Oracle Utilities Customer Care and Billing Extractors and Schema

• Data Mapping Guide for Oracle Utilities Operational Device Management Extractors and Schema

• Metrics Reference Guide for Oracle Utilities Meter Data Analytics
Preface - iv 
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• Metrics Reference Guide for Oracle Utilities Work and Asset Analytics

• Metrics Reference Guide for Oracle Utilities Customer Analytics, Oracle Utilities Revenue Analytics, Oracle 
Utilities Credit & Collections Analytics

• Metrics Reference Guide for Oracle Utilities Mobile Workforce Analytics

• Metrics Reference Guide for Oracle Utilities Exception Analytics

• Metrics Reference Guide for Oracle Utilities Distribution Analytics, Oracle Utilities Outage Analytics

• Metrics Reference Guide for Oracle Utilities Operational Device Analytics

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.

Acronyms
The list of Acronyms used in this guide are as explained below: 

• OUASA: Oracle Utilities Advanced Spatial and Operational Analytics

• OBIEE: Oracle Business Intelligence Enterprise Edition

• ODI: Oracle Data Integrator

• OWB: Oracle Warehouse Builder

• CC&B: Oracle Utilities Customer Care and Billing 

• NMS: Oracle Utilities Network Management System

• ODM: Oracle Utilities Operational Device Management

• WAM: Oracle Utilities Work and Asset Management

• MWM: Oracle Utilities Mobile Workforce Management

• MDM: Oracle Utilities Meter Data Management

• ETL: Extraction, Transformation, and Loading

• GG: Oracle Golden Gate
Preface - v 
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Chapter 1 
 Introduction 

This chapter provides an overview of the installation of Oracle Utilities Advanced Spatial and 
Operational Analytics, including: 

• About Oracle Utilities Advanced Spatial and Operational Analytics Installation

• What’s New in Oracle Utilities Advanced Spatial and Operational Analytics v2.4.1

• Architectural Changes

• Schema Changes

• Extract-Transform-Load Changes

• Installation Changes

About Oracle Utilities Advanced Spatial and Operational Analytics 
Installation

Oracle Utilities Advanced Spatial and Operational Analytics (OUASA) version 2.4.1 installation 
consists of the following components, each of which needs to be installed for a successful 
installation:

• Star schema definitions

• Extract, Transform, and Load (ETL) process built on Oracle Data Integrator (ODI) 
Note that in this release of OUASA v2.4.1, this ETL component is only supported for Oracle 
Utilities Operational Device Management (ODM) source application

• ETL process built on Oracle Warehouse Builder (OWB)

• Pre-built analytics' dashboards based on Oracle Business Intelligence Enterprise Edition 
(OBIEE)

• Admin tool installation 

Note: The term Oracle Utilities Advanced Spatial and Operational Analytics 
refers to the five components mentioned in the above list. Only these five 
components are required for a typical installation. This document provides 
information about these components in detail.

What’s New in Oracle Utilities Advanced Spatial and Operational 
Analytics v2.4.1

Oracle Utilities Advanced Spatial and Operational Analytics v2.4.1 has the following new features:
Introduction 1-1 
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Installation Changes
• Oracle Utilities Operational Device Extractor and Schema

• Oracle Utilities Operational Device Analytics

• ETL component based on Oracle Data Integrator (ODI) 

Architectural Changes
The architectural changes are as follows:

• A new administration tool based on application express feature of the Oracle Database is 
introduced to configure Oracle Data Integrator (ODI) and Oracle Golden Gate.

• New Oracle Data Integrator (ODI) based ELT has been added for Oracle Utilities 
Operational Device Management (ODM) source application.

Schema Changes
A new group of dashboards grouped under Oracle Utilities Operational Device Analytics has 
been added. This group provides reporting metrics on the Oracle Utilities Operational Device 
Management application.

Extract-Transform-Load Changes
Oracle Utilities Advanced Spatial and Operational Analytics v2.4.1 marks the beginning of 
transition from Oracle Warehouse Builder (OWB) based ETL to Oracle Data Integrator (ODI) 
based ETL. This release introduces new ODI based ETL for Oracle Utilities Operational Device 
Management (ODM). Most of the existing ETLs will be moved out to ODI in a phased manner in 
upcoming Oracle Utilities Advanced Spatial and Operational Analytics releases.

Installation Changes 
Automated Deployments for ETL Component based on ODI is done using ODI - SDK code, 
which is written in java and scripts has been developed around them.
Introduction 1-2 
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Chapter 2 
 Installation Overview

This chapter gives a detailed overview of Oracle Utilities Advanced Spatial and Operational 
Analytics installation.It includes the following sections:

• Installation Scenarios

• Application Architecture

• Installation Types

• Installation Components

• Media Pack Components

• Supported Source Application Versions

Installation Scenarios 
The following installation scenarios are discussed with respective flow chart diagrams:

• Installation Scenario 1, where Oracle Utilities Operational Device Management (ODM) is 
not one of the source applications and initial installation is for ETL Component based on 
OWB. Refer to Installation Scenario 1 flow chart for the details. 

• Installation Scenario 2, where the source application is Oracle Utilities Operational Device 
Management (ODM). Refer to Installation Scenario 2 flow chart for the details. 

• Installation Scenario 3, where Oracle Utilities Operational Device Management (ODM) is 
one of the source applications and customer along with this also has one or more other edge 
applications such as Oracle Utilities Meter Data Management, Oracle Utilities Mobile 
Workforce Management, etc. installed as sources. Refer to Installation Scenario 3 for the 
details. 

• Installation Scenario 4 for the customers who are upgrading to Oracle Utilities Advanced 
Spatial and Operational Analytics version 2.4.1 from an earlier released version. Refer to the 
Installation Scenario 4 flow chart for the details.

See Installation Components for the list of components comprising the Oracle Utilities 
Advanced Spatial and Operational Analytics product.

See Supported Source Application Versions for the supported source application versions.

Certain prerequisite softwares may need to be installed for installing each of these components. 
See Prerequisite Software for the list of prerequisite software necessary for installing each 
component.
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Installation Scenarios
Installation Scenario 1 
Installation Scenario 1, where Oracle Utilities Operational Device Management (ODM) is not one 
of the source applications and initial installation is for ETL component based on OWB. 

The following diagram shows the graphical representation of the workflow for the initial 
installation for ETL components based on OWB (applicable when the customer is installing 
extractor and schema for products other than Oracle Utilities Operational Device Management):
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Installation Scenarios
Installation Scenario 2
The source application is Oracle Utilities Operational Device Management (ODM) for ETL 
component based on ODI. This installation is applicable only if customer is installing Oracle 
Utilities Operational Device Extractor and Schema.

The following diagram shows the graphical representation of workflow for the initial installation 
process: 
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Installation Scenarios
Installation Scenario 3
Oracle Utilities Operational Device Management (ODM) is one of the source applications and 
customer also has one or more other edge applications such as Oracle Utilities Meter Data 
Management, Oracle Utilities Mobile Workforce Management, etc. as sources. This initial 
installation is for customers who are using both ETL component based on OWB and ETL 
component based on ODI. 

The following figure shows the graphical representation of workflow for the initial installation:
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Installation Scenarios
Installation Scenario 4 
This installation type is for upgrade customers who are upgrading from an earlier version of 
Oracle Utilities Advanced Spatial and Operational Analytics to Oracle Utilities Advanced Spatial 
and Operational Analytics v2.4.1. 

The following figure shows the graphical representation of the workflow for the upgrade process:
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Application Architecture
Application Architecture
The following diagram shows the architecture of the Oracle Utilities Advanced Spatial and 
Operational Analytics (OUASA) product when using ETL based on Oracle Warehouse Builder 
(OWB):

The following diagram shows the architecture of the Oracle Utilities Advanced Spatial and       
Operational Analytics (OUASA) product when using ETL based on Oracle Data Integrator 
(ODI):
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Installation Types
Installation Components
The Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.1 product installation 
consists of the following components:

Note that each of the components listed below has to be installed to complete 
the Oracle Utilities Advanced Spatial and Operational Analytics installation.

• Oracle Utilities Advanced Spatial and Operational Analytics  Database component containing 
star schemas and product metadata.

• Oracle Utilities Advanced Spatial and Operational Analytics ETL Component based on 
Oracle Data Integrator (ODI). 
Note that the Oracle Utilities Advanced Spatial and Operational Analytics ETL component 
based on ODI should be installed on a database server. This installation is required only if 
you are installing Oracle Utilities Operational Device Extractor and Schema.

• Oracle Utilities Advanced Spatial and Operational Analytics ETL workflows based on Oracle 
Warehouse Builder (OWB). 
Note that the Oracle Utilities Advanced Spatial and Operational Analytics ETL component 
should be installed on a database server. This is applicable if you have installed extractor and 
schema for edge application products other than Oracle Utilities Operational Device 
Management (ODM).

• Oracle Utilities Advanced Spatial and Operational Analytics Dashboards components and 
answers based on Oracle Business Intelligence Enterprise Edition (OBIEE). 
Note that the Oracle Utilities Advanced Spatial and Operational Analytics Dashboard 
components should be installed where OBIEE is installed on the server. 

• Oracle Utilities Advanced Spatial and Operational Analytics Admin tool component 
installation.

Oracle Utilities Advanced Spatial and Operational Analytics also includes the demo database with 
pre-populated data that can be used for training or demonstration purposes. Refer to Demo 
Installation Procedure for the details. 

Installation Types
The first step in the installation procedure is to determine the installation type based on the 
customer installation scenario. The following are the possible installation types:

• Initial Installation, an installation from scratch

• Upgrade, an upgrade from an earlier version to Oracle Utilities Advanced Spatial and 
Operational Analytics v2.4.1

• Demo Installation, an installation with pre-populated demo data

The following sections describe each of these installations in detail: 

Initial Installation
This installation type is applicable when installing Oracle Utilities Advanced Spatial and 
Operational Analytics for the first time or from scratch. Each of the following components should 
be installed during an initial installation: 

• Oracle Utilities Advanced Spatial and Operational Analytics Database component.

• Oracle Utilities Advanced Spatial and Operational Analytics ETL component based on ODI  
(applicable only if customer is installing Oracle Utilities Operational Device Extractor and 
Schema).
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Installation Types
• Oracle Utilities Advanced Spatial and Operational Analytics ETL component based on OWB  
(applicable if the customer is installing extractor and schema for edge application products 
other than Oracle Utilities Operational Device Management.

Note: If the customer has installed edge applications, such as Oracle Utilities 
Customer Care and Billing, Oracle Utilities Network Management System, 
Oracle Utilities Work and Asset Management, Oracle Utilities Mobile 
Workforce Management, or Oracle Utilities Meter Data Management, then 
ETL component based on OWB must be installed.

• Oracle Utilities Advanced Spatial and Operational Analytics Dashboard component.

• Oracle Utilities Advanced Spatial and Operational Analytics Admin Tool Component 
(applicable only if customer is installing Oracle Utilities Operational Device Extractor and 
Schema (ODM).

See chapter Oracle Utilities Advanced Spatial and Operational Analytics Initial Installation 
for the steps involved in installing each of the above components.

Upgrade
This installation type is applicable when upgrading to Oracle Utilities Advanced Spatial and 
Operational Analytics v2.4.1 from an earlier version.

Refer to the section Supported Upgrade Paths to find out whether upgrade of your particular 
version is supported.

Each of the following components should be installed during an upgrade installation.

• Oracle Utilities Advanced Spatial and Operational Analytics Database component.

• Oracle Utilities Advanced Spatial and Operational Analytics ETL component based on ODI  
(applicable only if customer is installing Oracle Utilities Operational Device Extractor and 
Schema).

• Oracle Utilities Advanced Spatial and Operational Analytics ETL component based on OWB  
(applicable if customer is installing extractor and schema for products other than Oracle 
Utilities Operational Device Management).

• Oracle Utilities Advanced Spatial and Operational Analytics Dashboard component.

• Oracle Utilities Advanced Spatial and Operational Analytics Admin tool component 
(applicable only if customer is installing Oracle Utilities Operational Device Extractor and 
Schema).

Refer to chapter Upgrading Oracle Utilities Advanced Spatial and Operational Analytics for 
the steps involved in upgrading each of the required components.

Demo Installation
This installation type is applicable when installing the demo database component of Oracle 
Utilities Advanced Spatial and Operational Analytics for demonstration or training purposes. The 
following components should be installed for a demo installation:

• Oracle Utilities Advanced Spatial and Operational Analytics Demo database component

• Oracle Utilities Advanced Spatial and Operational Analytics Dashboard components

Refer to chapter Demo Installation Procedure for the steps involved in installing each of the 
required components.
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Supported Source Application Versions
Media Pack Components
Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.1 Media Pack consists of 
the following documentation and installation packages:

Documentation Packages
• Oracle Utilities Advanced Spatial and Operational Analytics v2.4.1 Release Notes

• Oracle Utilities Advanced Spatial and Operational Analytics v2.4.1 Quick Install Guide

• Oracle Utilities Advanced Spatial and Operational Analytics v2.4.1 Installation Guide and Configuration 
Guide

• Oracle Utilities Advanced Spatial and Operational Analytics v2.4.1 User's Guide

Installation Packages
• Oracle Utilities Advanced Spatial and Operational Analytics V2.4.1 Dashboard Component 

Multiplatform

• Oracle Utilities Advanced Spatial and Operational Analytics V2.4.1 ETL Component Based on OWB 
Multiplatform

• Oracle Utilities Advanced Spatial and Operational Analytics V2.4.1 ETL Component Based on ODI 
Multiplatform

• Oracle Utilities Advanced Spatial and Operational Analytics V2.4.1 Oracle Database Multiplatform

• Oracle Utilities Advanced Spatial and Operational Analytics V2.4.1 Demo Data

Supported Source Application Versions
The following are the supported source application versions: 

Source Application Version

Oracle Utilities Customer Care & Billing 2.2.0
2.3.1
2.4.0

Oracle Utilities Network Management 
System

1.9.0.3
1.10.0.3.1
1.11.0.1

Oracle Utilities Work & Asset Management 1.9.0.4

Oracle Utilities Meter Data Management Oracle Utilities Meter Data Management 
version 2.0.1, Service Pack 8 (2.0.1.8) + 
Single fix patch # 14741869 + Single fix 
patch # 15983267 + Framework patch 
14741833

Oracle Utilities Mobile Workforce 
Management

Oracle Utilities Mobile Workforce 
Management version 2.1.0, Service Pack 4 
(2.1.0.4) +Single Fix patch # 14791886 + 
Framework patch 14741833

Oracle Utilities Operational Device 
Management 

2.0.1.1
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Chapter 3
System Requirements and Supported Platforms

This section gives an overview of the tiers on which the product is implemented, and shows each 
of the operating system/server combinations that the product is certified for. It includes:

• Operating Systems and Application Servers

• Additional Notes on Supported Platforms

Operating Systems and Application Servers
Oracle Utilities Advanced Spatial and Operational Analytics (OUASA) v2.4.1 installation is 
certified to operate on many operating system, application server, and database server 
combinations.

The following table details the browser, operating system, and application server combinations on 
which Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.1 has been tested 
and certified

Browser
Operating 

System 
(Client)

Operating 
System
(Server)

Chipset
Applicati
on Server OBIEE

Oracle 
Data 

Integra
tor 

(ODI)

Golden 
Gate Database

IE 7.x 

IE 8.x
IE 9.x 

Firefox 10 (
ESR)

Windows 
XP SP3

Windows 7 
(64 bit)

AIX 7.1 (64-bit) Power  
64-bit

WebLogic 
10.3.6 11.1.1.6.6 11.1.1.6 11.2.1.0.5_2 Oracle 

11.2.0.3

Oracle Linux 6.2 (64-
bit) / Red Hat 
Enterprise Linux 6.2 
(64-bit)

x86_64 WebLogic 
10.3.6

11.1.1.6.6 11.1.1.6 11.2.1.0.5_2 Oracle 
11.2.0.3

Oracle Solaris 10 
Update 9 (64-bit)

SPARC WebLogic 
10.3.6

11.1.1.6.6 11.1.1.6 11.2.1.0.5_2 Oracle 
11.2.0.3

Windows 2008 
Server R2

x86_64 WebLogic 
10.3.6

11.1.1.6.6 11.1.1.6 11.2.1.0.5_2 Oracle 
11.2.0.3
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Additional Notes on Supported Platforms
You must have the following software listed out below: 

Note: Oracle Warehouse Builder is installed as part of the Oracle Database 
Enterprise Edition Server 11.2.0.3

• Oracle Business Intelligence Enterprise Edition (OBIEE) is required for Oracle Utilities 
Advanced Spatial and Operational Analytics dashboard component. 

• ODI is required for Oracle Utilities Advanced Spatial and Operational Analytics ETL 
component based on ODI. 

• Oracle Golden Gate is required for Oracle Utilities Advanced Spatial and Operational 
Analytics ETL component based on ODI.

• Oracle Weblogic is required for Oracle Utilities Advanced Spatial and Operational Analytics 
ETL component based on ODI.

Additional Notes on Supported Platforms
Following topics are discussed in this section: 

• Oracle's Unbreakable Enterprise Kernel

• Oracle Database Server

• Oracle VM Support

• Oracle Support Policy on VMWare

Oracle's Unbreakable Enterprise Kernel
Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.1 is supported on Oracle's 
Unbreakable Enterprise Kernel.

Oracle Database Server 
Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.1 is supported on Oracle 
Database Enterprise Edition Server 11.2.0.3 on any of the operating systems listed above.

Oracle VM Support
Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.1 is supported on Oracle 
VM 2.2.2 for supported releases of Oracle Linux and Microsoft Windows operating systems.

Oracle Support Policy on VMWare
Refer to My Oracle Support knowledge base article 249212.1 for Oracle's support policy on 
VMWare.

https://support.oracle.com
System Requirements and Supported Platforms 3-13 
Oracle Utilities Advanced Spatial and Operational Analytics Installation Guide



Chapter 4 
Planning the Oracle Utilities Advanced Spatial 

and Operational Analytics Installation

This chapter provides information about planning the Oracle Utilities Advanced Spatial and 
Operational Analytics (OUASA) installation version 2.4.1, including:

• Prerequisite Software

• Installation Checklist

Prerequisite Software
For installing the Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.1, few 
prerequisite software needs to be downloaded and installed. Download and install these software 
as per the instructions provided in respective installation documents.

Ensure that the same Operating System (OS) user is used to install all software components along 
with the corresponding Oracle Utilities Advanced Spatial and Operational Analytics Components.

The following sections describe the prerequisite software requirement for the below-listed product 
components of Oracle Utilities Advanced Spatial and Operational Analytics:

• Prerequisite Software for OUASA Database Component

• Prerequisite Software for OUASA ETL Component based on Oracle Data Integrator

• Prerequisite Software for OUASA ETL Component based on Oracle Warehouse 
Builder

• Prerequisite Software for OUASA Dashboard Component

• Prerequisite Software for OUASA Admin Tool Component

Prerequisite Software for OUASA Database Component
The prerequisite software for Oracle Utilities Advanced Spatial and Operational Analytics 
database component is as described below:

• Oracle Database Server Enterprise Edition 11.2.0.3: This is required for installing the 
database component of the Oracle Utilities Advanced Spatial and Operational Analytics 
product.
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Installation Checklist
Prerequisite Software for OUASA ETL Component based on Oracle Data 
Integrator

The prerequisite software for Oracle Utilities Advanced Spatial and Operational Analytics ETL 
component based on Oracle Data Integrator (ODI) are listed below:

•  JDK 1.6.0_20. or above

• Oracle Database Server Enterprise Edition 11.2.0.3

• Oracle Weblogic 10.3.6.

• Oracle Data Integrator 11.1.1.6 with Java EE.

• Oracle Golden Gate 11.2.1.0.5_2. On Source Application Database Server and Target 
Database Server  
This can be downloaded from My Oracle Support (https://support.oracle.com/)

Prerequisite Software for OUASA ETL Component based on Oracle Warehouse 
Builder

The prerequisite software for Oracle Utilities Advanced Spatial and Operational Analytics ETL 
based on Oracle Warehouse Builder (OWB) component are as follows:

• JDK 1.6.0_20 is required for running the File Processor Daemon.

• Oracle Database Server Enterprise Edition 11.2.0.3 with Oracle Warehouse Builder 11.2.0.3.

Prerequisite Software for OUASA Dashboard Component
The prerequisite software for Oracle Utilities Advanced Spatial and Operational Analytics 
dashboard component are as follows:

• Oracle Business Intelligence Enterprise Edition 11.1.1.6.6 with Enterprise Install Option

Prerequisite Software for OUASA Admin Tool Component
The prerequisite software for the Oracle Utilities Advanced Spatial and Operational Analytics 
Admin tool component are as follows:

• Oracle Database Server Enterprise Edition 11.2.0.3

• Oracle Apex 4.2

Installation Checklist
The following checklist will guide you through the installation process for the Oracle Utilities 
Advanced Spatial and Operational Analytics version 2.4.1:

The details are provided in subsequent chapters for each of the below-listed step: 

1. Determine the installation type. See Installation Types to determine the installation type for 
your scenario. Perform the installation steps as applicable to your installation type.

2. Install the prerequisite software.  
See Prerequisite Software for more details.

3. Ensure that you have downloaded the Oracle Utilities Advanced Spatial and Operational 
Analytics components.

Refer to chapter Oracle Utilities Advanced Spatial and Operational Analytics 
Initial Installation for instructions regarding initial installation.
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Installation Checklist
For upgrading from an earlier version of OUASA to OUASA v2.4.1, refer to the chapter 
Upgrading Oracle Utilities Advanced Spatial and Operational Analytics.

Refer to Demo Installation Procedure for instructions about demo installation. 

4. Perform the post-installation tasks and configure the application. 
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Chapter 5 
Oracle Utilities Advanced Spatial and 

Operational Analytics Initial Installation

This chapter provides instructions for installing the Oracle Utilities Advanced Spatial and 
Operational Analytics installation version 2.4.1. It includes the following topics: 

• Initial Installation Procedure

• After the Installation

Initial Installation Procedure
The following topics are discussed in this section: 

• OUASA Database Component Installation

• OUASA ETL Component Installation based on Oracle Data Integrator Installation 
(ODI)  
(applicable only if the customer has Oracle Utilities Operational Device Management (ODM) 
installed)

• OUASA ETL Component based on Oracle Warehouse Builder Installation (OWB)

• Note: If the customer has installed edge applications such as, Oracle Utilities Customer Care 
and Billing, Oracle Utilities Network Management System, Oracle Utilities Work and Asset 
Management, Oracle Utilities Mobile Workforce Management, or Oracle Utilities Meter Data 
Management, then, ETL component based on OWB must be installed.

• OUASA Dashboard Component Installation

• OUASA Admin Tool Component

(applicable only if the customer uses ODI based ETL)

OUASA Database Component Installation
This section describes how to install the database component of the Oracle Utilities Advanced 
Spatial and Operational Analytics version 2.4.1. It includes the following topics:

• Copying and Decompressing Install Media

• Database Creation

• DWADM Schema Installation

• Spatial Configuration

Copying and Decompressing Install Media
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To copy and decompress the install media, perform these steps:

1. Download the Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.1 
Oracle Database part (Oracle Utilities Advanced Spatial and Operational Analytics V2.4.1 
Oracle Database Multiplatform.zip)from My Oracle Support (https://support.oracle.com/).

2. Create a temporary directory, such as c:\ouasa\temp or /ouasa/temp. (Referred to below as 
<TEMPDIR>) This directory must be located outside any current working Oracle Utilities 
application environment. All files that are placed in this directory as a part of the installation 
can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Advanced Spatial and Operational Analytics V2.4.1 Oracle Database 
Multiplatform.zip to <TEMPDIR> using any zip utility.

4. Unzip the zip file <TEMPDIR>/OUASA-V2.4.1-Database-Multiplatform.zip using any zip 
utility.

Database Creation
Ensure that Oracle Database Server Enterprise Edition 11.2.0.3 is already installed on the machine 
in order to create the database.

• Use the Database Configuration Assistant (DBCA) utility to create the database.  
Refer to Database Creation Using DBCA

Database Creation Using DBCA
For an initial installation database creation, it is recommended that you use the Database 
Configuration Assistant (DBCA) to create a data warehouse database with below-mentioned 
specifications:

1. Create a database with the AL32UTF8 character set. Set the open cursor limit to 3000 and 
processes to 1000 at the time of database creation. 

2. After the database creation, set the query_rewrite_enabled parameter to FORCE and the 
query_rewrite_integrity parameter to TRUSTED.

3. Connect to sys user and execute the following commands:

alter system set query_rewrite_enabled=force;
alter system set query_rewrite_integrity=trusted;

4. Ensure to create CISTS_01,REPOS_01 and STAGE_01 tablespaces in the database if it is 
not already created. These tablespaces are required to run the users.sql

5. Ensure that TEMP temporary tablespace exists in databases. If it does not exist, create it. 
This tablespace is required to run the users.sql

6. Execute users.sql after connecting as sys user to database.

Note: Users.sql script is located in BI241/Scripts/users.sql. This sql creates 
DWADM (Warehouse user), MASTER_REPO (ODI master repository user), 
WORK_REPO (ODI work repository user) users with the same username as 
password. If you want to change the password for any user, then connect as sys 
user and change the password.

DWADM Schema Installation
This section describes the initial installation of DWADM schema. The process prompts you for 
the names of three database users:

• A user that owns the application schema. For example, DWADM.

• A user that has read-write (select/update/insert/delete) privileges to the objects in the 
application schema. The application will access the database as this user. For example, 
DWUSER.
5-18 Oracle Utilities Advanced Spatial and Operational Analytics Installation Guide



• A user with read-only privileges to the objects in the application schema. For example, 
DWREAD.

The process also prompts you for the following:

• A database role that has read-write (select/update/insert/delete) privileges to the objects in 
the application schema. For example: DW_USER. The application will access the database as 
DW_USER.

• A database role with read-only privileges to the objects in the application schema. For 
example, DW_READ.

• Location for jar files. (The Jar files are bundled with the database package.)

• Java Home. For example: C:\Java\jdk1.6.0_18

Review Storage.par
The storage.par file (that comes with the product) allocates all base tables and indexes to the 
default tablespace CISTS_01. If you decide to allocate some tables or indexes outside of the 
default tablespace, then this has to be reflected in the storage.par file by changing the tablespace 
name from the default value to a custom value, according to the format shown below:

Object Type:Object Name:Tablespace name:Parallel:Comments

Where Parallel defines the number of threads that the Oracle DB Server uses to access a table or 
create an index. Default value is 1.

Installing the DWADM Schema
Perform the following steps to install the DWADM schema:

Note: Ensure to run CDXDBI.exe from a Window desktop that has the 
Oracle 11.2.0.3 32 bit client and Java Development Kit Version 6.0 Update 20 
or later. Ensure to update tnsnames.ora file to connect to the database.

1. Run CDXDBI.exe from ..\BI241\DWADM\Install-Upgrade. Run the utility from command 
prompt. The utility prompts you to enter values for the following parameters:

• Name of the target database:<DB NAME>

• Password for the SYSTEM user account in the database (in silent mode)

• Name of the owner of the Database Schema:<DWADM>

• Location of Java Home: <..\jdk1.6.0_20>

• Location of TUGBU Jar files: <..\BI241\DWADM\Jarfiles>

• Password for the user (in silent mode)

• Oracle user with read-write privileges to the Database Schema:<DWUSER>

• Oracle user with read-only privileges to the Database Schema:<DWREAD>

• Oracle database role with read-write privileges to the Database Schema:<DW_USER>

• Oracle database role with read-only privileges to the Database Schema:<DW_READ>

2. If you choose to continue, CDXDBI first checks for the existence of each of the users 
specified and prompts for their password, default tablespace, and temporary tablespace if 
they do not exist.

3. After setting up roles and users, the utility continues upgrading schema and system data 
definitions.  
If an error occurs while executing an SQL or another utility, it logs and displays the error 
message and allows you to re-execute the current step.
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Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before 
using the database, generate the statistics for these new objects.

Spatial Configuration
Refer to section Spatial Configuration for details regarding configuring spatial data.

OUASA ETL Component Installation based on Oracle Data Integrator 
Installation

Ensure that the same Operating System (OS) user is used to install the OUASA ETL component 
that is used to install all the related software. Refer to section Prerequisites Software.

Customers must install the Oracle Utilities Advanced Spatial and Operational Analytics ETL 
component based on the Oracle Data Integrator (ODI) only if they have the ODM application 
installed. 

Note: Oracle Utilities Operational Device Management (ODM) application set up is a pre-
requisite in order to install ODI based ETL component. The source ODM application should be 
setup with the required configurations in order to successfully extract data from ODM to BI 
before proceeding with the ODI-based ETL component installation. Refer to Configuring Oracle 
Utilities Operational Device Management for Business Intelligence Chapter in the Data Mapping Guide for 
Oracle Utilities Operational Device Management Extractors and Schema. 

This section describes how to install the ETL component of Oracle Utilities Advanced Spatial and 
Operational Analytics. The section includes the following:

• Oracle Golden Gate Setup

• Copying and Decompressing Install Media

• Setting Permissions for cistab File in UNIX

• OUASA ETL Component Installation based on Oracle Data Integrator Installation

• Post-installation Tasks

Oracle Golden Gate Setup
Set up the Golden Gate on Source and Target database servers. Here, the Oracle Utilities 
Operational Device Management (ODM) database is the source database and the Oracle Utilities 
Advanced Spatial and Operational Analytics (OUASA) database is the target database.

Please ensure to download the Oracle Golden Gate 11.2.1.0.5_2 version from My Oracle Support 
(https://support.oracle.com/).

This section describes the following: 

• Source Database Server Golden Gate Setup

• Target Database Server Golden Gate Setup

Source Database Server Golden Gate Setup
Perform the following steps: 

1. Create a directory on source database server. e.g ../GoldenGateHome.  
This will be Golden Gate home (GG_Home) on source database Server.

2. Copy the Oracle Golden Gate software in the above created directory. 

3. Unzip it. It will extract into a tar file:

tar -xvof <tar file>

4. Set the source ORACLE_SID and ORACLE_HOME variable.
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5. Go to the Golden Gate home directory . ./ggsci.

6. Execute the create SUBDIRS command.

7. Execute the EDIT PARAMS mgr command. 
This command opens an editor.

8. Copy the below contents after confirming the mentioned ports are not in use. If they are in 
use, provide the available ports, and then save the content:

• PORT 7830

• DYNAMICPORTLIST 7830-7880

• PURGEOLDEXTRACTS  <GG_Home>/dirdat/ODM1AA/*, 
USECHECKPOINTS, MINKEEPDAYS 3

9. Execute start mgr to start the Oracle Golden Gate manager process.

10. Execute info all to view the manager process is running.

11. Ensure that the database is in archivelog mode.

12. Connect to the database as sys user and execute the alter database add supplemental log 
data (primary key) columns command.

13. Go to GG_Home directory.

14. Connect to database as sys user and create user ODM01SRC (this is the Golden Gate owner) 
and make sure to assign tablespace that is not assigned to any other user.

15. Execute Grant connect,resource,dba to ODM01SRC

16. Run the command:  
@marker_setup.sql

17. Run the Command:  
@ddl_setup.sql

18. Run the Command:  
@role_setup.sql

19. Exit the database login and create the diroby directory inside GG_Home directory.

Target Database Server Golden Gate Setup
Perform the following steps: 

1. Create a directory on target database server. e.g  ../GoldenGateHome.  
This will be Oracle Golden Gate home (GG_Home) on the target OUASA database Server.

2. Copy the Oracle Golden Gate (GG) software in the above created directory.

3. Unzip it. It will extract into a tar file.

tar -xvof <tar file>

4. Set the target ORACLE_SID and ORACLE_HOME variable.

5. Go to Oracle Golden Gate home directory ../ggsci.

6. Execute the create SUBDIRS command.

7. Execute the EDIT PARAMS mgr command. This opens an editor.

8. Copy the below contents after confirming the mentioned ports are not in use. If they are in 
use, provide the available ports:

• PORT 7830

• DYNAMICPORTLIST 7830-7880
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• PURGEOLDEXTRACTS  <GG Home>/dirdat/ODM1AA/*, 
USECHECKPOINTS, MINKEEPDAYS 3

9. Execute the start mgr to start the Oracle Golden Gate manager process.

10. Execute the info all to view the manager process is running.

11. Exit the Oracle Golden Gate login and create the diroby directory inside GG_Home 
directory.

Copying and Decompressing Install Media
The Oracle Utilities Advanced Spatial and Operational Analytics ETL component based on ODI 
installation file is delivered in zip format for both UNIX and Windows platforms. If you plan to 
install multiple Oracle Utilities Advanced Spatial and Operational Analytics environments 
operated by different Oracle Utilities Administrator user IDs, you must complete each of the 
following installation steps for each Administrator user ID.

1. Download the Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.1 ETL 
Component Based on ODI part (Oracle Utilities Advanced Spatial and Operational Analytics 
V2.4.1 ETL Component Based on ODI Multiplatform.zip) from My Oracle Support (https:/
/support.oracle.com/).

2. Log in to the Database server host as the Oracle Utilities Advanced Spatial and Operational 
Analytics administrator user ID.

3. Create a temporary directory, such as c:\OUASA\temp or /OUASA/temp (Referred to 
below as <TEMPDIR>). This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation. 

4. Unzip Oracle Utilities Advanced Spatial and Operational Analytics V2.4.1 ETL Component 
based on ODI Multiplatform.zip to <TEMPDIR>.

5. Decompress the file BI.ODI.V2.4.1-MultiPlatform.jar as follows:

• cd <TEMPDIR>

• jar -xvf BI.ODI.V2.4.1-MultiPlatform.jar 

Note: You should have Java JDK installed on the machine used to (un)jar the 
OUASA ETL component based on ODI installation package. Install the JDK 
that is supported for the install on your platform to be able to use the jar 
command.

The Java packages are located at: http://java.sun.com/products/archive/index.html. A sub-
directory named “BI.ODI.V2.4.1” is created. It contains the installation software for the Oracle 
Utilities Advanced Spatial and Operational Analytics ETL component based on ODI.

Setting Permissions for cistab File in UNIX
Every Oracle Utilities Advanced Spatial and Operational Analytics environment installed on a 
server must be registered in the /etc/cistab file located on that server. On UNIX servers, generally 
only the root user ID has write permissions to the /etc directory. Since the installation process is 
run by the Oracle administrator user ID, this user ID may not be able to write to /etc/cistab table.

The install utility checks permissions and if it identifies a lack of necessary permissions, it 
generates a script in the <TEMPDIR>/BI.ODI.V2.4.1 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Advanced Spatial and Operational Analytics application environment on the 
server) and registers a new environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Advanced 
Spatial and Operational Analytics administrator user ID, so that the next time a new environment 
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is created by the same Oracle Utilities Advanced Spatial and Operational Analytics administrator 
user ID, you do not need to run the generated script with the root user ID. Instead, the install 
utility itself proceeds with the registration.

If you are re-installing an existing environment, only the validation of /etc/cistab entry is done by 
the install utility, no new registration occurs. The install utility interactively instructs you about 
every step that needs to occur in each specific case.

If you plan to upgrade an existing environment, you must ensure to take a backup prior to the 
installation process. The installation utility does not create a backup of existing environment.

OUASA ETL Component based on ODI Package Installation Steps
Follow these steps to install the Oracle Utilities Advanced Spatial and Operational Analytics 
Package applications after performing the steps to deploy the ETL Component Objects as 
described in the section above:

Prerequisites Software
Before installing the below package, the following software must be already installed.

• JDK 1.6.0_20 (JAVA_HOME)

• Oracle Database Home (ORACLE _HOME)

• Weblogic 10.3.6 (WL_HOME)

• ODI 11.1.1.6 with Java EE Installation (ODI_HOME)

• Oracle Golden Gate 11.2.1.0.5_2 Software on Source Database Server and Target Database 
Server (GG_HOME)

Then follow the below instructions to install the OUASA ETL Component based on ODI: 

1. Change to the <TEMPDIR>/ BI.ODI.V2.4.1 directory.

2. Set the ORACLE_CLIENT_HOME and PATH variables as Oracle Client Perl is required to 
run the installer.

3. Oracle Database Enterprise Edition 11.2.0.3 installed user is used to install the Oracle 
Utilities Advanced Spatial and Operational Analytics (OUASA) Package.

4. Execute the following script for UNIX/Windows: 
For UNIX 
Perform the following steps: 

1. Run the following commands: 

export ORACLE_CLIENT_HOME=<ORACLE_HOME> 

export  PERL_HOME=$ORACLE_CLIENT_HOME/perl 

export  PATH=$PATH:$PERL_HOME/bin

ksh ./instal.sh

Note: On UNIX, ensure that you have the required execute permission on 
install.sh. 
For Windows:  
Perform the following steps: 

1. set ORACLE_CLIENT_HOME=<ORACLE_HOME> 

2. set  PERL_HOME=%ORACLE_CLIENT_HOME%\perl

3. set  PATH=%PERL_HOME%\bin;%PATH% 

4. Run install.cmd
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5. The Oracle Utilities Advanced Spatial and Operational Analytics specific menu appears.

6. Select each menu item to configure the values.  
For detailed description of the values, refer to the Configuration Worksheet for ETL 
Component based on ODI Installation.

Environment Installation Options: 

Perform the following steps: 

1. Oracle Client Home Directory:

2. Environment Mount Point: 
Log Files Mount Point: 
Environment Name: 
Web Java Home Directory: 
Each item in the above list should be configured for a successful install.  
Choose the following options from the menu item (1,2, <P> Process, <X> Exit):

Environment Configuration: 

1.  Environment Description

Environment Description:

2. ODI Environment Configuration 
WEBLOGIC HOME: 
ODI HOME: 
ODI SUPERVISOR USER: SUPERVISOR 
ODI SUPERVISOR Password: sunopsis123 
Target Database Name: 
Target Database Host::  
Target Database Port::  1521 
DWADM Schema Name: DWADM 
DWADM  Schema Password: <DWADM Password> 
ODI Master Schema Name: MASTER REPO 
ODI Master Schema Password:  
ODI Work Schema Name: 
ODI Work Schema Password: 
ODI Master Repository ID: 601 
ODI Work Repository ID: 602

3. ODI Agent Configuration 
ODI Weblogic Agent Host: 
ODI Weblogic Agent Port:

4. Source Golden Gate Configuration 
Source Instance Name: 
Source Golden Gate Manager Port: 
Source Golden Gate Dynamic Mininum Port: 
Source Golden Gate Dynamic Maximum Port: 
Source Golden Gate Algorithm: 
Source Golden Gate Encryptkey:    
Source Golden Gate Shared Secret: 
Source Database Name: 
Source Database Host: 
Source Database Port: 
Source Database Home: 
Source Golden Gate Home:

5. Target Golden Gate Configuration 
Target Golden Gate Manager Port 
Target Golden Gate Dynamic Mininum Port: 
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Target Golden Gate Dynamic Maximum Port: 
Target Golden Gate Algorithm: 
Target Golden Gate Encryptkey: 
Target Golden Gate Shared Secret: 
Target Database Home: 
Target Golden Gate Home: 
Each item in the above list should be configured for a successful install.  
Choose option (1,2,3,4,5 <P> Process, <X> Exit):

6. Once the parameter setup is completed, proceed with option P. Write to the configure file.

7. Once installation is finished successfully, execute the post-installation steps as described in 
Post-installation Tasks.

Post-installation Tasks
The following post-installation tasks are discussed in this section:

• Deploying ETL Component based on ODI

• Seeded data Import

• Add Instance

• InitiateSetup

• RunviewGenerator

• Weblogic Domain Creation for Oracle Data Integrator Agent

Deploying ETL Component based on ODI
Follow the sequence for the steps shown below for successful deployment: 

For the Oracle Data Integrator (ODI) deployment, the script creates the master and 
work repositories and imports Oracle Data Integrator metadata.

For UNIX:

Perform the following steps: 

1. Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd $SPLEBASE/bin

3. Run Ksh ./deployodi.sh

For Windows: 

Perform the following steps: 

1.  Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

2. cd %SPLEBASE%\bin

3. Run deployodi.cmd

Verify the log at the location:  $SPLEBASE/logs/system/deployodi.log file

Seeded data Import
This step imports pre-shipped data into the DWADM for Oracle Data Integrator (ODI) 
Processing.

For UNIX:

Perform the following steps: 
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1. Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2.  cd $SPLEBASE/bin

3. Run Ksh ./importseededdata.sh

For Windows:

1. Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd %SPLEBASE%\bin

3. Run importseededdata.cmd

Verify the log at the location:  $SPLEBASE/logs/system/deployodi.log file

Add Instance
The below command inserts each Source instance and instance Name into b1_prod_instance 
table.

For UNIX:

Perform the following steps: 

1. Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd $SPLEBASE/bin

3. Run Ksh ./addInstance.sh -u <Source_Schema User> -p <Source_Schema 
User_password> -s <Source Application Schema>  -r  <Source Application Drill Back 
URL>

For Windows: 

Perform the following steps: 

1. Initialize the environment with the ./splenviron.cmd -e <envname> command.

 Note: Navigate to the Install_Dir/bin to initialize. 

2. cd %SPLEBASE%\bin

3. Run addInstance.cmd -u <Source_Schema User> -p <Source_Schema User_password> 
-s <Source Application Schema>  -r  <Source Application Drill Back URL>

Where 

• Source_Schema User = Golden Gate Owner created in Source database> 
For example: ODM01SRC

• Source_Schema User_Password = Golden Gate Ownerpassword

• Source Application Schema = Source Application Schema (E.g: CISADM)

• Source Application Drill Back URL = Source Application URL (http://
<Host>:<Port>/ouaf/)

Verify the log at the location:  $SPLEBASE/logs/system/deployodi.log file

InitiateSetup
This step is run to reverse engineer Source tables, set up the Journalising Setup, and create the 
Golden Gate scripts. 

For Unix: 

Perform the following steps: 
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1. Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd $SPLEBASE/bin

3. Run Ksh ./initiateSetup.sh.

4. Go to $SPLEBASE/GGScriptsGen directory and locate the folder starting with the 
instance name. For example: ODM1AA.

5. Go to $SPLEBASE/GGScriptsGen/ODM1AA

6. Copy the src folder to Source Database Server 
Refer to the ReadMe.txt generated to run the GG Scripts. 

Note: Ensure that ORACLE_SID and ORACLE_HOME are set before 
running the Golden Gate Scripts on both Source and Target  Database Servers.

For Windows: 

Perform the following steps: 

1. Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd %SPLEBASE%\bin

3. Run initiateSetup.cmd

4. Go to %SPLEBASE%/GGScriptsGen directory, you will find the folder created starting 
with instance name E.g ODM1AA.

5. Go to %SPLEBASE%/GGScriptsGen/ODM1AA.

6. Copy the src folder to Source Database Server. 
Refer to the ReadMe.txt generated to run the GG Scripts.

Note: Ensure that ORACLE_SID and ORACLE_HOME are set before 
running the Golden Gate Scripts on both the Source and Target Database 
Servers.

Verify the log at the location:  $SPLEBASE/logs/system/deployodi.log file

RunviewGenerator
For Unix: 

Perform the following steps: 

1. Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd $SPLEBASE/bin

3. Run the Ksh ./runviewGenerator.sh

 
For Windows: 

Perform the following steps: 

1. Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd %SPLEBASE%\bin

3. Run the runviewGenerator.cmd

Verify the log at the location:  $SPLEBASE/logs/system/deployodi.log file
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Weblogic Domain Creation for Oracle Data Integrator Agent
Weblogic Domain should be created for bringing up the Weblogic Agent (ODI Agent) to 
complete the steps. 

Perform the following steps to bring up Weblogic ODI Agent which is created in step Deploying 
ETL Component based on ODI.

1. Navigate to the Oracle Data Integrator (ODI) installed location <MW_HOME>/
Oracle_ODI1\common\bin and run the below command and follow the screens to provide 
the masterschema and workschema provided in the configuration.

For Unix: 

• Run ./Config.sh

For Windows: 

• Run Config.cmd

2. Create a new Weblogic Domain.  

Click Next.

3. Generate a domain configured automatically to support the following products. Select the 
check boxes for the below mentioned plugins. When these plugins are selected, some 
automatic plugins also get selected.

• Oracle Enterprise Manager Plugin for ODI -11.1.1.0

• Oracle Data Integrator - Console - 11.1.1.0

• Oracle Data Integrator Agent - 11.1.1.0

• Oracle Data Integrator - SDK Web Services - 11.1.1.0
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Then, click Next to proceed. 

4. On the Specify Domain Name and Location page, complete the following: 

• Provide the Name:  odi_domain 

• Location will be default.

Click Next to proceed
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5. Configure the Admin UserName and password for Weblogic 
Provide the Weblogic password. 

Select Next. 

6. Configure the Server StartUp Mode and JDK

• Select Production Mode.

• Provide the JDK 1.6.0_20 

7. Configure JDBC Component Schema. 

Select only the ODI Master Schema Checkbox. Provide the below details:

• DBMS/Service : Target Database Name
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• Host Name  : Database Serverhost

• Port : Database Port

• Schema Owner : MASTER_REPO

• Schema Password: MASTER_REPO Password

8. Deselect the ODI Master Schema checkbox.

9. Now, select the ODI Work Schema checkbox. Provide the below details: 

• DBMS/Service: Target Database Name

• Host Name: Database Serverhost

• Port: Database Port

• Schema Owner: WORK_REPO

• Schema Password: WORK _REPO Password

Select Next to proceed. 

10. Test JDBC Component Schema by selecting Select All and Test Connections. 
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Select Next to proceed. 

11. Select Optional Configuration

• Select the checkboxes: 

• Adminstration Server

• Managed Server, Clusters and Machines.

• Select Next to proceed.

12. Configure the Administration Server

• Provide the listening port, which is not in use
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Select Next to proceed. 

13. Configure Managed Servers by providing the following: 

• Name: odi_server1

• Listen Address: All Local Addresses

• Port: <Provide the port, Which is configured in Menu configuration of installation step 3 
of ODI Agent Configuration > ODI Weblogic Agent Port.>

14. Configure Cluster.  
Click Next. 
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15. Configure Machines.  
Click Next. 

16. Assign Servers to Machines.  
Click Next.

17. On the Configuration Summary page, click Create to create the domain odi_domain. 

18.  After the domain is created, go to Domain Location, create boot.properties file for Weblogic 
login. Create the <MW_HOME>/user_projects/domains/odi_domain/servers/
AdminServer/security folder if not present. 

19. Go to <MW_HOME>/user_projects/domains/odi_domain/servers/AdminServer/
security, then create boot.properties with below Values:

• username=weblogic

• password=Weblogic password

Starting the WebLogic Admin server and Managed server odi_server1

Perform the following steps: 

1. In the command shell, change directory to the directory of the WLS Home -
<MW_HOME>/user_projects/domains/odi_domain/bin

2. Execute the startweblogic command for UNIX and Windows:

For Unix

nohup ./ startWebLogic.sh > startWebLogic.log &

 
For Windows: 

startWebLogic.cmd

Authenticating the Oracle Data Integrator Supervisor User in WebLogic: 

1. Go to <MW_HOME>/oracle_common/common/bin

2. Execute the following command:

For Unix

./wlst.sh

For Windows: 

wlst.cmd

3. To connect to the running Admin server, execute the following command:

connect('<Weblogic User>','<Weblogic password>','t3://
<WEBLOGICHOST>:<WEBLOGIC ADMIN PORT')

For example: connect('weblogic','weblogic123','t3://localhost:7001')

4. Execute the following command to add the correct credential store for ODI Supervisor:

createCred (map="oracle.odi.credmap", key="SUPERVISOR", user="SUPERVISOR", 
password="<SUPERVISOR Password>", desc="ODI SUPERVISOR Credential")

5. To exit WLST, execute the command exit (). 

6. To start managed server odi_server1, change directory to WLS Home: 

<MW_HOME>/user_projects/domains/odi_domain/bin

Execute the below commands: 
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For Unix: 

• nohup ./ StartManagedWeblogic.sh  odi_server1 > StartManagedWeblogic.log &

 
For Windows: 

• StartManagedWeblogic.cmd odi_server1

7. From the ODI Designer, click Test icon to test connectivity of the configured ODI Java EE 
agent. Click OK. 

8. Close the OracleDIAgent tab.

After the Installation
Perform the following steps: 

1. Log in to Oracle Data Integrator (ODI) studio and navigate to Designer > Projects > 
Oracle Utilities BI > Configuration > Scheduler > Packages.

2. Right click the BI_INITIAL_SETUP_PKG and execute. 

3. Select ODM1 as context and WLS_AGENT as logical agent and then click OK.

4. Go to Operator and view the logs for successful execution of package.

OUASA ETL Component based on Oracle Warehouse Builder Installation
This section describes how to install the ETL component of Oracle Utilities Advanced Spatial and 
Operational Analytics. 

Note that the OUASA ETL component should be installed on a database server.This is optional if 
you have installed Oracle Utilities Operational Device Management (ODM).

Note: If the customer has installed edge applications, say for example, CC&B, 
NMS, WAM, MWM, or MDM, then the ETL component based on OWB must 
be installed.

This section includes the following:

• Copying and Decompressing Install Media

• Setting Permissions for cistab File in UNIX

• Creating and Configuring Oracle Warehouse Builder Workspace

• OUASA ETL Component based on Oracle Warehouse Builder Package Installation 
Steps

• Post-Installation Tasks

Copying and Decompressing Install Media
The Oracle Utilities Advanced Spatial and Operational Analytics ETL component based on OWB 
installation file is delivered in a zip format for both UNIX and Windows platforms. If you plan to 
install multiple Oracle Utilities Advanced Spatial and Operational Analytics environments 
operated by different Oracle Utilities Administrator user IDs, you must complete each of the 
following installation steps for each Administrator user ID.

1. Download the Oracle Utilities Advanced Spatial and Operational Analytics V2.4.1 ETL 
Component Based on OWB part (Oracle Utilities Advanced Spatial and Operational 
Analytics V2.4.1 ETL Component Based on OWB Multiplatform.zip)from My Oracle 
Support (https://support.oracle.com/).

2. Log in to the Database server host as the Oracle Utilities Advanced Spatial and Operational 
Analytics administrator user ID (default cases).
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3. Create a temporary directory, such as c:\OUASA\temp or /OUASA/temp. (Referred to 
below as <TEMPDIR>.) This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation.

4. Unzip the zip file Oracle Utilities Advanced Spatial and Operational Analytics V2.4.1 
ETL Component Based on OWB Multiplatform.zip to <TEMPDIR>.

5. Decompress the file BI.OWB.V2.4.1-MultiPlatform.jar as follows:

• cd <TEMPDIR>

• jar -xvf BI.OWB.V2.4.1-MultiPlatform.jar

Note: You should have Java JDK installed on the machine used to (un)jar the 
OUASA ETL component based on OWB installation package. Install the JDK 
that is supported for the install on your platform to be able to use the jar 
command. 

The Java packages are located at: http://java.sun.com/products/archive/index.html. A sub-
directory named "BI.OWB.V2.4.1" is created. It contains the installation software for the Oracle 
Utilities Advanced Spatial and Operational Analytics ETL component based on OWB.

Setting Permissions for cistab File in Unix
Every Oracle Utilities Advanced Spatial and Operational Analytics environment installed on a 
server must be registered in the /etc/cistab file located on that server. On UNIX servers, generally 
only the root user ID has write permissions to the /etc directory. Since, the installation process is 
run by the Oracle administrator user ID, this user ID may not be able to write to /etc/ cistab file.

The install utility checks permissions and if it identifies a lack of necessary permissions, it 
generates a script in the <TEMPDIR>/BI.OWB.V2.4.1 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Advanced Spatial and Operational Analytics application environment on the 
server) and registers a new environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Advanced 
Spatial and Operational Analytics administrator user ID, so that the next time a new environment 
is created by the same Oracle Utilities Advanced Spatial and Operational Analytics administrator 
user ID, you do not need to run the generated script with the root user ID. Instead, the install 
utility itself proceeds with the registration.

If you are re-installing an existing environment, only the validation of /etc/cistab entry is done by 
the install utility, no new registration occurs. The install utility interactively instructs you about 
every step that needs to occur in each specific case.

If you plan to upgrade an existing environment, you must ensure to take a backup prior to the 
installation process. The installation utility does not create a backup of existing environment.

Creating and Configuring Oracle Warehouse Builder Workspace
This section describes how to create and configure the Oracle Warehouse Builder Workspace. It 
also includes details about the following:

• Pre-deployment Steps for Initial Installation

• Creating and Configuring Oracle Warehouse Builder Workspace for an Initial 
Installation

Pre-deployment Steps for Initial Installation
Before creating/configuring workspace, perform the following steps: 

1. Execute the following command to configure the workflow in database.
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For Unix:

$ORACLE_HOME/owb/wf/install/wfinstall.csh 

For Windows:

%ORACLE_HOME%/owb/wf/install/wfinstall.bat

2. This launches a configuration dialog in which you are asked to enter the user name and 
password. Enter OWFMGR as user and OWFMGR as password.

3. Specify the TNS connect string of the database, in the following format:

hostname:port:sid

Creating and Configuring Oracle Warehouse Builder Workspace for an Initial Installation
To configure the Oracle Warehouse Builder (OWB), perform the following steps: 

1. Run the $ORACLE_HOME/owb/bin/unix/reposinst.sh command for UNIX from the 
database server. 
 
OR 
 
Invoke the repository assistant from Warehouse Builder > Administrator for Windows 
from the database server or client.

2. Provide the following information:

• Database connection details and click Next.

• Select Manage Warehouse Builder Workspaces and click Next.

• Select Create a new Warehouse Builder Workspace and click Next.

• Select Workspace with a new user as the workspace owner.

• Provide the system user password.

3. Execute cat_owb.sql as sysdba from <OWBHOME>/owb/UnifiedRepos directory, when 
prompted.

4. Unlock the OWBSYS and OWBSYS _AUDIT accounts, if this has not already been done. 
Connect to Sys User and execute the following commands: 

ALTER USER OWBSYS IDENTIFIED BY OWBSYS ACCOUNT UNLOCK; 
ALTER USER OWBSYS _AUDIT IDENTIFIED BY OWBSYS _AUDIT

ACCOUNT UNLOCK;

5. Check only Data Integrator Enterprise Edition on Enable Optional Features, and then 
specify the following details:

• Workspace Owner's user Name: BIREPOWN 

• Workspace Owner's password: BIREPOWN 

• Workspace Name: SPLBIREP

• Provide OWBSYS Password:

6. Execute <OWBHOME>/owb/UnifiedRepos /remote_owb_install.sql after logging in to 
sys user, if promoted. When prompted for Oracle Home for Remote OWB software, provide 
the location of OWB Oracle Home.

7. Provide the tablespace info for the OWB workspace schema.

8. Select the Language. (American Language)
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9. Select the Target Schema (DWADM) and Workflow Schema (OWFMGR) from the available 
Repository Users List and move them to Selected. This will register the DWADM and 
OWFMGR schemas with the workspace.

10. On the same screen, click Create New User to create a new workspace user. Specify the 
following details:

• User Name: BIREPO 

• Password: BIREPO

11. Review the information and then click Finish to complete the workspace configuration.

12. Modify the contents of <owb-home>/owb/bin/admin/Runtime.properties file from the 
following to the contents mentioned later.

property.RuntimePlatform.0.NativeExecution.FTP.security_constraint = DISABLED 
property.RuntimePlatform.0.NativeExecution.Shell.security_constraint = DISABLED 
property.RuntimePlatform.0.NativeExecution.SQLPlus.security_constraint =

DISABLED

To

property.RuntimePlatform.0.NativeExecution.FTP.security_constraint = 
NATIVE_JAVA

property.RuntimePlatform.0.NativeExecution.Shell.security_constraint = 
NATIVE_JAVA

property.RuntimePlatform.0.NativeExecution.SQLPlus.security_constraint = 
NATIVE_JAVA

13. Connect to OWBSYS user and execute <owb-home>/owb/rtp/sql/stop_service.sql.

14. Connect to OWBSYS user and execute <owb-home>/owb/rtp/sql/start_service.sql.

15. Connect to database with sys user and execute the following procedures:

Note: : Before executing these procedures modify <SMTP SERVER> and

<SMTP PORT> to appropriate values. 
 
EXECUTE 
DBMS_NETWORK_ACL_ADMIN.CREATE_ACL('acl_for_owb_cc.xml','A
CL for Control Center','OWBSYS', TRUE, 'connect'); EXECUTE 
DBMS_NETWORK_ACL_ADMIN.ASSIGN_ACL('acl_for_owb_cc.xml',<S
MPT SERVER>, <SMPT PORT>); 
COMMIT;

16. Execute the following: 

SELECT  
acl,host, DECODE(DBMS_NETWORK_ACL_ADMIN.check_privilege_aclid(aclid,

OWBSYS', 'connect'),1, 'GRANTED', 0, 'DENIED', NULL) privilege

FROM dba_network_acls ;

You will see the following:

/sys/acls/acl_for_owb_cc.xml

<SMPT SERVER> GRANTED

17. Connect to BIREPOWN user and run spl_exec_wf_prc.sql.

Note: : spl_exec_wf_prc.sql is located in ../BI241/Scripts

18. Connect to DWADM schema and execute spl_oms_snapshot_pkg.sql.
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Note: spl_oms_snapshot_pkg.sql is located in ../BI241/Scripts

19. Connect to database with sys user and execute the following SQL statements:

DROP SYNONYM DWADM.WB_RT_AUDIT;

CREATE SYNONYM DWADM.WB_RT_AUDIT FOR OWBSYS.WB_RT_AUDIT; 
GRANT SELECT ON OWBSYS.WB_RT_AUDIT TO DWADM;

GRANT SELECT ON OWBSYS.ALL_RT_AUDIT_EXECUTIONS TO DWADM; 

GRANT ALL ON OWBSYS.WB_RT_AUDIT_PURGE TO DWADM;

GRANT ALL ON OWFMGR.WF_PURGE TO DWADM; GRANT 
SELECT_CATALOG_ROLE TO BIREPOWN;

GRANT ALL ON OWBSYS.WB_RT_AUDIT_EXECUTIONS TO DWADM;

GRANT ALL ON OWBSYS.WB_RT_DEF_EXECUTION_OPERATORS TO 
DWADM; DROP SYNONYM DWADM.WB_RT_AUDIT_EXECUTIONS;

DROP SYNONYM DWADM.WB_RT_DEF_EXECUTION_OPERATORS;

CREATE SYNONYM DWADM.WB_RT_AUDIT_EXECUTIONS FOR 
OWBSYS.WB_RT_AUDIT_EXECUTIONS;

CREATE SYNONYM DWADM.WB_RT_DEF_EXECUTION_OPERATORS FOR 
OWBSYS.WB_RT_DEF_EXECUTION_OPERATORS;

alter system set query_rewrite_enabled=force;

alter system set query_rewrite_integrity=trusted;

OUASA ETL Component based on Oracle Warehouse Builder Package Instal-
lation Steps

 After performing the above outlined steps, follow these steps to install the OUASA ETL 
Component based on the OWB Package:

1. Change to the <TEMPDIR>/BI.OWB.V2.4.1 directory.

2. Set the ORACLE_CLIENT_HOME and PATH variables as Oracle Client Perl is required to 
run the installer.

3. Oracle Database Enterprise Edition 11.2.0.3 Installed User should be the same user installing 
the OUASA ETL Component based on OWB Package

4. Execute the following script: 

For Unix: 

Perform the following steps: 

• export ORACLE_CLIENT_HOME=<ORACLE_HOME> 

• export  PERL_HOME=$ORACLE_CLIENT_HOME/perl

• export  PATH=$PATH:$PERL_HOME/bin

• Run ksh ./install.sh

Note: Ensure that you have the required execute permission on install.sh.

For Windows: 

Perform the following steps: 

• set ORACLE_CLIENT_HOME=<ORACLE_HOME> 

• set PERL_HOMEb=%ORACLE_CLIENT_HOME%\perl 

• set PATH=%PERL_HOME%\bin;%PATH% 
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• Run install.cmd

5. The Oracle Utilities Advanced Spatial and Operational Analytics specific menu appears.

6. Select each menu item to configure the values. For detailed description of the values, see 
Configuration Worksheet for ETL Component based on OWB Installation.

Environment Installation Options: 

1. Oracle Client Home Directory: 

2. Environment Mount Point: 

Log Files Mount Point:

 Environment Name:

Web Java Home Directory: 

For successful installation, each item in the above list should be configured. Choose the following 
menu options (1,2, <P> Process, <X> Exit):

Environment Configurations:

1. Environment Description

Environment Description:

2. Database Configuratoin

OWB WorkSpace Owner:

OWB WorkSpace Owner Password: Database Name:

Database Server: Database Port:

3. Design Repository Configuration

OWB WorkSpace User:

OWB Workspace user Password: OWB WorkSpace Name:

DWADM SCHEMA NAME:

DWADM SCHEMA Password: WORKFLOW 

MANAGER SCHEMA NAME: WORKFLOW 

MANAGER SCHEMA Password:

4. DATABASE CHARACTER SET CONFIGURATION

Database Character set: AL32UTF8

5. EDITING PROCESS FLOW CONFIGURATION 

Repository Operating System: 

Perl Compiler location:

Data and control files location: 

Separator to be used:

File Manager location:

6. EMAIL CONFIGURATION 

Email ID of Sender:

Email ID for Reply-To address:

Email ID of Receiver: 

SMTP server:
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SMTP server port:

7. CONTROL CENTRE CONFIGURATION 

Repository Control Center Name:

8. EXTERNAL DATA SOURCE CONFIGURATION 

Path of the External Datasource:

Path of the External Datasource LOG:

File Processor Daemon Execution Switch: 1

File Processor Extract Max Load: 5

File Processor Scheduler Poll Duration: 60

For successful installation, each item in the above list should be configured. Choose the following 
menu options (1,2,3,4,5,6,7,8 <P> Process, <X> Exit):

9. After completing the parameter setup, proceed with the option P. Write to the configure file.

10. Once installation is successful, execute the post-installation steps as described in Post-
Installation Tasks.

Post-Installation Tasks
The following post-installation tasks are discussed in this section:

• Deploying ETL Workflows on Oracle Warehouse Builder

• Deploying Materialized Views

• Generating Security

• Generating Database Statistics

Deploying ETL Workflows on Oracle Warehouse Builder
Deploy the ETL work flows to target BI database configured in OUASA package installation. In 
UNIX, you may get a Java heap space error while importing the MDL file. To resolve this error 
you are required to make changes in OMBPlus.sh file, located at: $ORACLE_HOME/owb/bin/ 
unix/OMBPlus.sh.

In the following code, change the value -Xmx768M to -Xmx1024M, and then the -Dlimit value 
768M to 1024M.

$JAVAPATH/bin/java $JAVA64FLAG -Xms64M -Xmx768M $OPTS -Dlimit=768M - 
DORACLE_HOME=$ORACLE_HOME -DOWBCC_HOME=$ORACLE_HOME - 
DTCLLIBPATH="$TCLLIBPATH" - 
DMARATHON_RETRY_COUNT="$MARATHON_RETRY_COUNT" - 
DMARATHON_RETRY_INTERVAL="$MARATHON_RETRY_INTERVAL"

$CLASSPATH_LAUNCHER oracle.owb.scripting.OMBShell $*

You may need to make this value larger than 1024MB (1GB) depending on the size of the import. 

Perform the following tasks:

Review the parallel-* .txt files located under the $SPLEBASE/etc folder to set the degree of 
parallelism. The files are in the parallel*.txt format to change the <Degree> of parallelism.

parallel-tables.txt file format: <Object_name>:<Degree> 
parallel-mvs.txt file format: : <MV_Name>:<Fact_Table>:<Degree> 

parallel-maps.txt file format:<Object_name>:<Table_Name>:<Degree> 

For UNIX:

Perform the following: 
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1. Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd $SPLEBASE/bin

3. Run Ksh ./Owbdeploy.sh

For Windows:

Perform the following:

1. Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd %SPLEBASE%\bin

3. Run Owbdeploy.cmd

Deploying Materialized Views
Perform the following: 

For UNIX: 

1. Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd $SPLEBASE\bin

3. Run Ksh ./ installViews.sh

4. Once the deployment is complete, remove the content inside this directory 
$SPLEBASE/tmp to ensure that all files are removed:

For Windows:

1. Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd %SPLEBASE%\bin

3. Run installViews.cmd

4. Once the deployment is complete, remove the content inside this directory 
%SPLEBASE%\tmp to ensure that all files are removed:

Generating Security
Edit the database name with the name of your database in OraGenSec.bat after completing the 
OWB deployment and run it from BI241/DWADM/Security folder.

Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before 
starting to use the database, generate the statistics for these new objects.

OUASA Dashboard Component Installation
This section describes how to install the database component of Oracle Utilities Advanced Spatial 
and Operational Analytics. The section includes the following:

• Copying and Decompressing Install Media

• Setting Permissions for cistab File in UNIX

• OUASA Dashboard Package Installation Steps

• Post-installation Tasks
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Copying and Decompressing Install Media
The Oracle Utilities Advanced Spatial and Operational Analytics Dashboard Component 
installation file is delivered in zip format for both UNIX and Windows platforms. If you plan to 
install multiple Oracle Utilities Advanced Spatial and Operational Analytics environments 
operated by different Oracle Utilities Administrator user IDs, you must complete each of the 
following installation steps for each Administrator user ID.

1. Log in to the application server host (where OBIEE 11.1.1.6.6 software is installed) as the 
Oracle Utilities Advanced Spatial and Operational Analytics administrator user ID (default 
cases).

2. Create a temporary directory, such as c:\OUASA\temp or /OUASA/temp.  (Referred in step 
3 below as <TEMPDIR>.) This directory must be located outside any current working 
Oracle Utilities application environment. All files placed in this directory as part of the 
installation procedure can be deleted after completing a successful installation.

3. Copy the file BI.OBIEE.V2.4.1-MultiPlatform.jar from the delivered package to the 
<TEMPDIR>. If you are using FTP to transfer this file, remember to use the BINARY 
option for the FTP transfer.

4. Decompress the file:

cd <TEMPDIR>

jar -xvf BI.OBIEE.V2.4.1-MultiPlatform.jar

Note: You should have Java JDK installed on the machine used to (un)jar the 
application server installation package. Install the JDK that is supported for the 
install on your platform to be able to use the jar command.

The Java packages are located at: http://java.sun.com/products/archive/index.html

A sub-directory named "BI.OBIEE.V2.4.1" is created. It contains the installation software for the 
Oracle Utilities Advanced Spatial and Operational Analytics Dashboard Component.

Setting Permissions for cistab File in UNIX
Every Oracle Utilities Advanced Spatial and Operational Analytics environment installed on a 
server must be registered in the /etc/cistab file located on that server. On UNIX servers, generally 
only the root user ID has write permissions to the /etc directory. Since the installation process is 
run by the Oracle administrator user ID, this user ID may not be able to write to /etc/cistab table.

The install utility checks permissions and if it identifies a lack of the necessary permissions, it 
generates a script in the <TEMPDIR>/BI.OBIEE.V2.4.1 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Advanced Spatial and Operational Analytics application environment on the 
server) and registers a new environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Advanced 
Spatial and Operational Analytics administrator user ID, so that the next time a new environment 
is created by the same Oracle Utilities Advanced Spatial and Operational Analytics administrator 
user ID, you do not need to run the generated script with the root user ID. Instead, the install 
utility itself proceeds with the registration.

If you are reinstalling an existing environment, only the validation of /etc/cistab entry is done by 
the install utility, no new registration occurs. The install utility interactively instructs you about 
every step that needs to occur in each specific case.

If you plan to upgrade an existing environment, it is recommended that you take a backup prior to 
the installation process. The installation utility does not create a backup of existing environment.

OUASA Dashboard Package Installation Steps
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Note: Before installing verify that the steps in Prerequisite Software for 
OUASA Dashboard Component are followed.

To install the OUASA Dashboard Package, follow these steps. 

1. Change to the <TEMPDIR>/BI.OBIEE.V2.4.1 directory.

2. Set the ORACLE_CLIENT_HOME and PATH variables as Oracle Client Perl is required to 
run the installer.

For UNIX:

Perform the following steps: 

• export ORACLE_CLIENT_HOME=<ORACLE_HOME>

• export PERL_HOME=$ORACLE_CLIENT_HOME/perl

• export PATH=$PATH:$PERL_HOME/bin

• Run ksh ./install.sh

Note: Ensure that you have the proper execute permission on install.sh.|

For Windows:

Perform the following: 

• set ORACLE_CLIENT_HOME=<oracle_client_home>

• set  PERL_HOME=%ORACLE_CLIENT_HOME%\perl

• set  PATH=%PERL_HOME%\bin;%PATH%Install.cmd

3. The Oracle Utilities Advanced Spatial and Operational Analytics specific menu appears.

4. Select each menu item to configure the values. For detailed description of the values, see 
Configuration Worksheet for Dashboard Component Installation.

Environment Installation Options 

1. Oracle Client Home Directory:                                                   

2. Environment Mount Point:      
Log Files Mount Point:            
Environment Name:                
Web Java Home Directory:                           

For successful installation, each item in the above list should be configured. Choose the following 
menu options (1,2, <P> Process, <X> Exit):

For detailed description of the values, see Configuration Worksheet for Dashboard 
Component Installation.

Environment Configuration 

1. Environment Description

       Environment Description:

2. OBIEE Environment Configuration

Oracle BI Instance Home

Oracle BI Home

Oracle BI Domain Home

Weblogic Domain Console User Name

 Weblogic Domain Console Host:

Weblogic Domain Console Port Number:
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Provide OBIEE Version Installed: 

3. Target Database Details

Target Database Name:  

Target Database Host:   

Target Database Port: 1521

DWADM Schema Name: DWADM

DWADM Schema Password:                   

For a successful installation, each item in the above list should be configured. Choose the 
following menu options (1,2,3 <P> Process, <X> Exit):

4. After completing the parameter setup, proceed with option P. Write the configuration file. 

5. Once installation is completed successfully, execute the post-installation steps outlined in 
Post-installation Tasks.

Post-installation Tasks
The following post-installation tasks are discussed in this section:

• Deploying Repository (RPD) File

• Deploying Web Catalog

• Configuring and Deploying MapViewer

• Modifying instanceconfig.xml

• Deploying Custom MapViewer

• Deploying Write Back

• Deploying Analytics

• Enabling Analytics Help

• Enabling Auto Complete Feature on OBIEE 11.1.1.6.6

Deploying Repository (RPD) File
The RPD file is located at: <install_dir>/Reports/rpd/UtilitiesBusinessAnalytics.rpd, where 
<install_dir> is the OUASA dashboard package installation directory.

Deploying the RPD file

To deploy the repository (RPD) file, follow these steps:

1. OBIEE 11.1.1.6.6 should have been installed on Windows machine before proceeding with 
the steps below.

2. Launch the Administration Tool from your Start menu from the Windows machine. This is 
only available in Windows.

Start > Programs > Oracle Business Intelligence > Administration

3. Open the RPD in offline mode by selecting File > Open > Offline...
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4. Provide the RPD password. For example, “oracle123”. 

5. Edit the connection pools shown below by double clicking on them.

6. In the Init Block Connection Pool group, enter the following:

Datasource name = BI Database name

User name = DWREAD

Password = DWREAD User password

7. In the Init Block Pool - MDM group, provide the following, only for MDM:

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

8. In the MDM Database Connection group, provide the following, only for MDM:

Data source name = MDM database name

User name = CISUSER

Password = CISUSER User password

9. In the ODIDEV Connection Pool group, provide the following:

Data source name = BI database name
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User name = DWUSER

Password = DWUSER User password

10. In the OUBI Database Connection group, provide the following:

Data source name = BI database name

User name = DWREAD

Password = DWREAD User password. 

11. Click Save.

12. Login into the OBIEE Enterprise Manager.

13. Navigate to BI Instance > Coreapplication > Deployment.

14. Lock and edit.

The repository text box is enabled.

15. Browse to the modified rpd file and submit. The file is in the following location, where 
<install_dir> is the OUASA dashboard package installation directory.

<Install_Dir>/Reports/rpd/UtilitiesBusinessAnalytics.rpd

16. Provide the RPD password “oracle123” click Apply.
Oracle Utilities Advanced Spatial and Operational Analytics Initial Installation 5-47



17. Activate the changes and then restart the BI Services.

Note: All the above databases set in the connection pool should be updated in 
tnsnames.ora file in <OBIEE_INSTALL_DIR>/Oracle_BI1/network/
admin.

Deploying Web Catalog
To deploy the Web catalog, follow these steps:

For UNIX:

Perform the following steps: 

1. Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Ensure to set the LD_BIND_NOW variable to 1 on OEL 6.2 before 
deploying the catalogs. Navigate to the Install_Dir/bin to initialize. 

2. Run this command to export LD_BIND_NOW=1

3. cd $SPLEBASE/bin

4. Run ksh ./deploycatalog.sh

5. Enter the location of the physical catalogs configured in Enterprise Manager.  
For example: <OBIEE_INSTALL_DIR>/instances/instance1/bifoundation/ 
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/SampleAppLite

For Windows:

Perform the following steps: 

1. Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

2. cd %SPLEBASE%\bin

3. Run deploycatalog.cmd

4. Enter the location of the physical catalogs configured in Enterprise Manager.  
For example:<OBIEE_INSTALL_DIR>/instances/instance1/bifoundation/ 
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/SampleAppLite

Configuring and Deploying MapViewer
To configure and deploy MapViewer, follow these steps:

• Configuring MapViewer

• Modifying instanceconfig.xml

• Deploying Custom MapViewer

Configuring MapViewer
To configure MapViewer, follow these steps:

1. Login to WebLogic console.

2. In the WebLogic console, create the 'MAP_DS' data source.

3. Lock and edit.

4. Navigate to Services > Data Sources.

5. Select New > Generic Data Source and provide the following details:

Name = MAP_DS

JNDI Name = MAP_DS
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Database Type = oracle

6. Click Next.

7. Enter the following:

Database Driver = XA thin database driver

8. Click Next.

9. Enter the following Connection properties:

Database Name: BI Database Name

Host Name: Database host

Port: Database port

Database User Name: dwadm

Password: dwadm password

10. Click Next and then click Finish.

11. Click Activate Changes.

12. Update the mapViewerConfig file with below mentioned tags:

File location : < OBIEE_INSTALL_DIR >/Oracle_BI1/bifoundation/jee/
mapviewer.ear/

web.war/WEB-INF/conf/

File: mapViewerConfig.xml

13. If there is proxy used, insert the list of host names for all the third party service providers in 
the security_config node.

<proxy_enabled_hosts>

elocation.oracle.com,maps.weatherbug.com,direct.weatherbug.com,api.wxbug.n

et,de.tiles.weatherbug.com

</proxy_enabled_hosts>

14. Update the following ns_data_provider node:

<ns_data_providerid="obieeNsdp"

class="com.oracle.utilities.birdseye.BirdseyeNSDP" />

15. Update the current map_tile_server with the following map_tile_server node.

<map_tile_server>

<tile_storage default_root_path="/mytilecache/"/>

</map_tile_server>

16. Update the instance config file location, for example: FileLocation:

For UNIX:

<OBIEE_INSTALL_DIR>/instances/instance1/config/
OracleBIPresentationServicesComponent/coreapplication_obips1

For Windows:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentationServicesCo
mponent\coreapplication_obips1

 
Modifying instanceconfig.xml
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Perform the following: 

1. Update the security node with the following values. If the security node is not present, add 
the following code before </Serverinstance>:

<Security>
<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
<HttpOnlyCookies>false</HttpOnlyCookies>
<CookieDomain />
<CookiePath>/</CookiePath>
</Security>

Deploying Custom MapViewer
To deploy the custom MapViewer, follow these steps:

For UNIX:

Perform the following steps: 

1. Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

2. cd $SPLEBASE/bin

3. Run ksh ./deploymapviewer.sh

4. Enter the WebLogic Domain Console password. For example, weblogic123.

For Windows:

Perform the following steps: 

1. Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

2. cd %SPLEBASE%\bin

3. Run deploymapviewer.cmd.

4. Enter the WebLogic Domain Console password. For example, weblogic123.

After Deploying Custom MapViewer

Perform the following steps after deploying the custom MapViewer:

1. Update MapViewer configuration by navigating to MapViewer > Administration >

Configuration.

2. Add the below content in the mapViewerConfig.xml with appropriate parameters.

<DB_HOST>,<DBNAME>,<DB_PORT>,<USER>,<PASSWORD>

<map_data_source name="MAPCONN"

jdbc_host="<DB_HOST>"

jdbc_sid="<BI Database Name>"

jdbc_port="<DB_PORT>"

jdbc_user="<DWADM>"

jdbc_password="<DWADM PASSWORD>"

jdbc_mode="thin"

number_of_mappers="32"

allow_jdbc_theme_based_foi="true"
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/>

3. Save and then restart.

Note: The above step has to be performed each time after running the 
deploymapviewer command.

Deploying Write Back
The purpose of the write back templates is to allow the user to configure Administrative 
dashboards. This is mandatory for the Admin dashboard functionality to work.

To deploy the write back feature, follow these steps:

1. Open the following file:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentationServicesCo
mponent\

coreapplication_obips\instanceconfig.xml

2. Update the following <ServerInstance> element:

<LightWriteback>true</LightWriteback>

3. Deploy write back as follows:

        For UNIX: 
        Perform the following steps: 

1. Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

2. cd $SPLEBASE/bin

3. Run ksh ./deploywriteback.sh

        For Windows: 
         Perform the following steps: 

1. Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

2. cd %SPLEBASE%/bin

3. Run deploywriteback.cmd

Deploying Analytics
To deploy analytics, perform these steps:

1. Edit the Presentation Services configuration file, "instanceconfig.xml", in the following 
directory:

<OBIEE_INSTALL_DIR>/instances/instance1/config/
OracleBIPresentationServicesComponent/

coreapplication_obips1

2. Add the following before the end tag </ServerInstance>:

<UI>

<DefaultStyle>oubi</DefaultStyle>

<DefaultSkin>oubi</DefaultSkin>

</UI>

Enabling Analytics Help
To enable the Analytics' help, follow these steps:
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1. Download the Oracle Utilities Advanced Spatial and Operational Analytics User Guide from My 
Oracle Support (https://support.oracle.com/).

2. After downloading the OUASA User Guide, change the name of the Help file to OUASA 
Help.pdf.  
Now, place the Help file in $SPLEBASE/Skin/OBIEE_11.1.1.6/res is the OUASA 
dashboard package installation directory.

3. Run the following commands:

        For UNIX: 
        Perform the following steps: 

1. Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

2. cd $SPLEBASE/bin

3. Run ksh ./deployanalyticsear.sh

4. Enter the WebLogic Domain Console Password. For example, weblogic123

       For Windows: 
       Perform the following steps: 

1. Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

2. cd %SPLEBASE%/bin

3. Run deployanalyticsear.cmd

4. Enter the WebLogic Domain Console Password. For example, weblogic123

5. Restart the BI Core services.

6. Restart WebLogic and all BI services after the OBIEE deployment is completed.

7. Log in to Analytics and navigate to Administration > Manage Privileges > Write Back > 
Write Back to Database. 

8. Click Denied:Authenticated User and select Granted.

Enabling Auto Complete Feature on OBIEE 11.1.1.6.6
Perform the following steps: 

1. Navigate to the path 
<Middleware_Home>\instances\instance1\config\OracleBIPresentationServicesCompone
nt\coreapplication_obips1 

2. Take a backup of instanceconfig.xml. 

3. Open the file instanceconfig.xml. 

4. Add the following lines in between the <ServerInstance> </ServerInstance> tags. 

<Prompts> 

<MaxDropDownValues>256</MaxDropDownValues> 

<AutoApplyDashboardPromptValues>true</AutoApplyDashboardPromptValues> 

<AutoSearchPromptDialogBox>true</AutoSearchPromptDialogBox> 

<AutoCompletePromptDropDowns> 

<SupportAutoComplete>true</SupportAutoComplete> 

<CaseInsensitive>true</CaseInsensitive> 
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<MatchingLevel>MatchAll</MatchingLevel> 

<ResultsLimit>50</ResultsLimit> 

</AutoCompletePromptDropDowns> 

</Prompts> 

5. Save the changes. 

6. Restart the OBIEE opmn Services.

7. Log in to analytics http://<Server>:<port>/analytics

8. Click on the weblogic User (top right of the page). 

9. From the drop down menu select My Account. 

10. Set Prompt Auto Complete to ON and click OK.

After the Installation
Ensure that the following tasks are performed after installing Oracle Utilities Advanced Spatial 
and Operational Analytics version 2.4.1:

1. For OUASA ETL related post-installation tasks, see OUASA ETL Component Installation 
based on Oracle Data Integrator Installation. Schedule the B1_run_ALL SCENARIO. 

2. For OUASA dashboard related post-installation tasks, see OUASA Dashboard Component 
Installation.

3. For configuring the mapping and other parameters, refer to the Oracle Utilities Advanced Spatial 
and Operational Analytics Administration Guide.

4. Start File Processor Daemon. 

5. Verify install and deploy logs:

<INSTALL_DIR>/OWB/MetadataFiles/SPL-BI-Project_imp.log 

<INSTALL_DIR>/OWB/MetadataFiles/SPL-BI-Location_imp.log

OWB deploy logs:

<INSTALL_DIR>/logs/system/log_OWBDeployment_YYYYMMDD_####.txt 

Custom Mapviewer deploy logs:

<INSTALL_DIR>/logs/system/mapviewerdeploy.sh.log

WriteBack logs:

<INSTALL_DIR>/logs/system/Writeback.log

FileProcessorDaemon logs:

<INSTALL_DIR>/bin/FileProcessorDaemon.log

6. Log into the OBIEE analytics link pointing to the demo database. The dashboard should 
display data with no errors.

OUASA Admin Tool Component
This is only applicable for customers installing the Oracle Utilities Operational Device Extractor 
and Schema. 

After the installation, customers must set up the Admin Tool for ETL configuration. Refer to 
Chapter Installing the OUASA Admin Tool for details.

Also, refer to Oracle Utilities Advanced Spatial and Operational Analytics Administrator’s Guide for details. 
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Chapter 6 
Upgrading Oracle Utilities Advanced Spatial and 

Operational Analytics

This chapter provides instructions for upgrading to Oracle Utilities Advanced Spatial and 
Operational Analytics (OUASA) installation version 2.4.1.

• Supported Upgrade Paths

• Upgrade

• After the Installation

Supported Upgrade Paths
Direct upgrade to Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.1 is 
supported from the following versions:

• Oracle Utilities Advanced Spatial and Operational Analytics version 2.3.2.1, 2.4.0, and 2.4.0.x

For upgrading from a version not supported by direct upgrade path, the product should first be 
upgraded to OUASA v2.3.2.1 and then upgraded to OUASA v2.4.1.

Upgrade
This section describes the procedure to upgrade Oracle Utilities Advanced Spatial and 
Operational Analytics version 2.4.1:

• OUASA Database Component Upgrade

• OUASA ETL Component based on Oracle Data Integrator Installation 
(applicable only if customer is installing Oracle Utilities Operational Device Extractor and 
Schema)

• OUASA ETL Component based on Oracle Warehouse Builder Upgrade 
(applicable if customer is installing extractor and schema for products other than ODM)

• OUASA Dashboard Component Upgrade

• OUASA Admin Tool Component 
(applicable only if customer is installing Oracle Utilities Operational Device Extractor and 
Schema) 
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OUASA Database Component Upgrade
This section describes the upgrade installation of the database. Upgrade the database to 
AL32UTF8 character set if database is not in AL32UTF8 character set. Following topics are 
discussed in this section:

• Copying and Decompressing Install Media

• DWADM Schema Upgrade

• Spatial Configuration

• Generating Database Statistics

Copying and Decompressing Install Media
To copy and then decompress the install media, follow these steps:

1. Download the Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.1 
Oracle Database part (Oracle Utilities Advanced Spatial and Operational Analytics V2.4.1 
Oracle Database Multiplatform.zip)from My Oracle Support (https://support.oracle.com/).

2. Create a temporary directory, such as c:\ouasa\temp or /ouasa/temp. (Referred to below as 
<TEMPDIR>) This directory must be located outside any current working Oracle Utilities 
application environment. All files that are placed in this directory as a part of the installation 
can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Advanced Spatial and Operational Analytics V2.4.1 Oracle Database 
Multiplatform.zip to <TEMPDIR> using any zip utility.

4. Unzip the zip file <TEMPDIR>/OUASA-V2.4.1-Database-Multiplatform.zip using any zip 
utility.

DWADM Schema Upgrade
This section describes how to upgrade an existing OUASA  target schema to OUASA v2.4.1. The 
upgrade process prompts you for the names of three database users:

• A user who owns the application schema. For example, DWADM

• A user with read-write (select/update/insert/delete) privileges to the objects in the 
application schema. The application will access the database as this user. For example, 
DWUSER

• A user with read-only privileges to the objects in the application schema. For example, 
DWREAD

The upgrade process also prompts you for the following:

• A database role that has read-write (select/update/insert/delete) privileges to the objects in 
the application schema. The application will access the database as, for example, the 
DW_USER

• A database role with read-only privileges to the objects in the application schema. For 
example, DW_READ

• Location for jar files. (The Jar files are bundled with the database package.)

• Java Home. For example, C:\Java\jdk1.6.0_18

Upgrading the Oracle Database

To upgrade the Oracle database, perform the following steps:

Note: Ensure to run CDXDBI.exe from a Window desktop that has Oracle 
11.2.0.2+ 32 bit  client and Java Development Kit Version 6.0 Update 20 or 
later. Upgrade your database to AL32UTF8 character set if not in AL32UTF8 
character set.
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1. Run CDXDBI.exe from ..\BI241\DWADM\Install-Upgrade. Please run this utility from 
command prompt. The utility prompts you to enter values for the following parameters:

• Name of the target database:<DB NAME>

• Password for the SYSTEM user account in the database (in silent mode) 

• Name of the owner of the Database Schema:<DWADM>

• Location of Java Home: <..\jdk1.6.0_20>

• Location of TUGBU Jar files: <..\BI241\DWADM\Jarfiles> 

• Password for the user (in silent mode)

• Oracle user with read-write privileges to the Database Schema:<DWUSER>

• Oracle user with read-only privileges to the Database Schema:<DWREAD>

• Oracle database role with read-write privileges to the Database 
Schema:<DW_USER> 

• Oracle database role with read-only privileges to the Database 
Schema:<DW_READ>

2. If you chose to continue, CDXDBI first checks for the existence of each of the users 
specified and prompts for their password, default tablespace, and temporary tablespace, if 
they do not exist.

3. After setting up roles and users, the utility continues upgrading schema and system data 
definitions. If an error occurs while executing an SQL or another utility, it logs and displays 
the error message and allows you to re-execute the current step.

4. Navigate to BI241/DWADM/Post-Upgrade folder and execute

5. FieldMetadata_FeatureConfigMigrationScript.sql if  upgrading from 2.3.2.1 version.

- sqlplus dwadm/dwadm@database-name

@FieldMetadata_FeatureConfigMigrationScript.sql

6. Enter OUAF Application Schema Owner Name  at the following prompt: 
Enter OUAF Application Schema Owner Name:(e.g SPLADM)

7. Connect to DWADM schema and execute the following sql script, if upgrading from 2.3.2.1 
version.:

update b1_configuration set override_value = ''

where feature_name = 'B1_MAPATTPRO' and option_code = 'B1DD'; 
Commit;

Upgrading from OUASA version 2.4.0, 2.4.0.1, 2.4.0.2, or 2.4.0.3 to v2.4.1
For customers who are upgrading from Oracle Utilities Advanced Spatial and Operational 
Analytics (OUASA) v2.4.0, v2.4.0.1, v2.4.0.2, or v2.4.0.3 to v2.4.1, these upgrade scripts are 
applicable.

In earlier release versions of OUASA, the Data Source Indicator (DSI) values coming from the 
source applications of Oracle Utilities Meter Data Management (MDM) and Oracle Utilities 
Mobile Workforce Management (MWM) could be manually configured. The 'General System 
Configuration' feature was used for this.

However, since Oracle Utilities Advanced Spatial and Operational Analytics Service Pack v2.4.0.4 
release onwards, the Data Source Indicator values coming from these source applications are 
based on the Environment ID available in the F1_INSTALLATION table.
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Note: Customers who have manually configured the DSI value in their source 
applications for MDM or MWM must run these upgrade scripts. These scripts 
rollbacks the DSI values on the data loaded into the BI data warehouse.

For these upgrade scripts, customers will have to input the new DSI value for each of the source 
application for MDM or MWM. The new DSI value must be the Environment ID available in the 
source application. This can be retrieved by running the below query in the respective source 
application database.

Upgrading from OUASA version 2.4.0, 2.4.0.1, 2.4.0.2, or 2.4.0.3 to v2.4.1

1. Select ENV_ID from F1_INSTALLATION table. 

2. Oracle Utilities Meter Data Management Customers need to run ...\BI241\DWADM\Post-
Upgrade\MDM_DSI_Upgrade_Script.sql after connecting to the OUASA database. 

For example:  

sqlplus <DWADM>/<DWADM>@DBNAME

SQL>@MDM_DSI_Upgrade_Script.sql

3. Enter the new Data Source Indicator value for Oracle Utilities Meter Data Management 
source application: <Result of query "select ENV_ID from F1_INSTALLATION" after 
connecting to the MDM database>.

4. MWM customers should run ...\BI241\DWADM\Post-
Upgrade\MWM_DSI_Upgrade_Script.sql after connecting to OUASA database 
For example:

sqlplus <DWADM>/<DWADM>@DBNAME

SQL>@MWM_DSI_Upgrade_Script.sql

5. Enter the new Data Source Indicator value for MWM source application:<Result of query 
"select ENV_ID from F1_INSTALLATION" after connecting to MWM database>.

Spatial Configuration
Note: See Spatial Configuration to configure spatial data if application is not 
already configured.

This section describes how to load spatial metadata in USER_SDO* tables for Oracle Utilities 
Advanced Spatial and Operational Analytics. If spatial data is already configured in application, 
follow the steps below. 

Use the following procedure to load spatial metadata in the target database:

Loading Spatial Metadata in the Target Database

1. Create the dump_dir directory in database and copy user_sdo.dmp file from ../B1241/ 
Spatial-Metadata folder to that location.

2. Import released spatial tables to the target database using following command: 

impdp directory=dump_dir dumpfile=user_sdo.dmp logfile= 

imp_user_sdo.log schemas=DWADM

Note: Run this command from database server.

3. Review the imp_user_sdo.log file to ensure the tables were imported successfully.

4. After importing the tables, run the following SQL scripts in the command prompt from ../
B1241/Spatial-Metadata folder:

• sqlplus dwadm/dwadm@database-name @copy_spatial_metadata.sql

• sqlplus dwadm/dwadm@database-name @clean_sdo_release_tbls.sql
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5. Review the log files. 

Generating Database Statistics
During an install process, new database objects may be added to the target database. Before 
starting to use the database, generate the statistics for these new objects.

OUASA ETL Component based on Oracle Data Integrator Installation
This section explains the following: 

Prerequisites for OUASA ETL Component based on Oracle Data Integrator 
Installation

Following are the prerequisites: 

• Ensure to create CISTS_01,REPOS_01 and STAGE_01 tablespaces in database, if it is not 
created already. These tablespaces are required to run the users.sql script. 

• Ensure that TEMP temporary tablespace exists in databases. If it does not exist, create it. 
This tablespace is required to run the users.sql

• Please execute users.sql after connecting as sys user to database.

Note: The users.sql script is located in BI241/Scripts/users.sql. This sql script 
creates the DWADM(Warehouse user), MASTER_REPO(ODI master 
repository user), WORK_REPO(ODI work repository user)  users if it does 
not exist in the database with same username as password. If you want to 
change the password for any user, connect as sys user and then, change the 
password.

• Ensure that the same Operating System (OS) user is used to install this component that was 
used to install all the related software.

Note: Customer needs to install OUASA ETL component based on Oracle 
Data Integrator (ODI) only if customer has the Oracle Utilities Operational 
Device Management (ODM) application installed. ODM application set up is a 
pre-requisite to install OUASA ETL component based on ODI.

Once you make the required configuration changes in the ODM application as mentioned above, 
proceed with the below steps. 

This section describes how to install the ETL component of Oracle Utilities Advanced Spatial and 
Operational Analytics. The section includes the following:

• Oracle Golden Gate Setup

• Copying and Decompressing Install Media

• Setting Permissions for Cistab File in UNIX

• OUASA ETL Component based on Oracle Data Integrator Package Installation Steps

• Post Installation Tasks

Oracle Golden Gate Setup
Set up the GoldenGate (GG) on Source and Target database servers. Here, Oracle Utilities 
Operational Device Management (ODM) database is the source and Oracle Utilities Advanced 
Spatial and Operational Analytics database is the target database. 

Ensure to download the Oracle Golden Gate 11.2.1.0.5_2 release version from My Oracle 
Support (https://support.oracle.com/).

• Source Database Server Golden Gate Setup

• Target Database Server Golden Gate Setup
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Source Database Server Golden Gate Setup
Perform the below steps for setting up the source database server: 

Setting up the Source Database Golden Gate Server

1. Create a directory on source database server.  
For example:  ../GoldenGateHome. This will be the Golden Gate home (GG_Home) on the 
source database Server.

2. Copy the Golden Gate software in the above created directory. 

3. Unzip the Golden Gate Software. It extracts into a tar file:  
tar -xvof <tar file>

4. Set the source ORACLE_SID and ORACLE_HOME variable.

5. Go to Golden Gate home directory:  
. ./ggsci

6. Execute the create SUBDIRS command.

7. Execute the EDIT PARAMS mgr command. This command opens the editor.

8. Copy the below contents after confirming that the below-mentioned ports are not in use. If 
these ports are in use, provide the next available ports, and then, save the content.

• PORT 7830

• DYNAMICPORTLIST 7830-7880

• PURGEOLDEXTRACTS  <GG_Home>/dirdat/ODM1AA/*, 
USECHECKPOINTS, MINKEEPDAYS 3

9. Execute start mgr to start the Golden Gate manager process.

10. Execute info all - to view the manager process is running.              

11. Ensure that database is in the archivelog mode.

12. Connect to the database as sys user and execute alter database add supplemental log data 
(primary key) columns command.

13. Go to the GG_Home directory

14. Connect to the database as sys user and create a user ODM01SRC ( It is the Golden Gate 
owner) and make sure to assign tablespace that is not assigned to any other user.

15. Execute the following commands: 

"Grant connect,resource,dba to ODM01SRC"\

 @marker_setup.sql

@ddl_setup.sql

 @role_setup.sql

16. Exit the database login and create the diroby directory inside GG_Home directory

Target Database Server Golden Gate Setup
Perform the following steps to setup the Target Database Server for Golden Gate: 

Setting Up the Target Database Server for Golden Gate

1. Create a directory on the target database server.  
For example: ../GoldenGateHome. This will be the Golden Gate home (GG_Home) on 
target OUASA database Server.

2. Copy the Golden Gate software in the above created directory
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3. Unzip the Golden Gate Software. It will extract into a tar file 
tar -xvof <tar file>

4. Set the target ORACLE_SID and ORACLE_HOME variable

5. Go to GG home directory 
. ./ggsci

6. Execute create SUBDIRS command

7. Execute EDIT PARAMS mgr. It opens an editor.

8. Copy the below contents after confirming the mentioned ports are not in use. If  these ports 
are in use, provide the available ports: 

• PORT 7830

• DYNAMICPORTLIST 7830-7880

• PURGEOLDEXTRACTS  <GG Home>/dirdat/ODM1AA/*, 
USECHECKPOINTS, MINKEEPDAYS 3

9. Execute start mgr to start the Golden Gate manager process.

10. Execute info all - to view the manager process is running

11. Exit the Golden Gate login and create the diroby directory inside the GG_Home directory.

Copying and Decompressing Install Media
The Oracle Utilities Advanced Spatial and Operational Analytics ETL component based on ODI 
installation file is delivered in a zip format for both UNIX and Windows platforms. If you plan to 
install multiple Oracle Utilities Advanced Spatial and Operational Analytics environments 
operated by different Oracle Utilities Administrator user IDs, you must complete each of the 
following installation steps for each Administrator user ID.

1. Download the Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.1 ETL 
Component Based on ODI part (Oracle Utilities Advanced Spatial and Operational Analytics 
V2.4.1 ETL Component Based on ODI Multiplatform.zip)from My Oracle Support (https:/
/support.oracle.com/).

2. Log in to the Database server host as the Oracle Utilities Advanced Spatial and Operational 
Analytics administrator user ID.

3. Create a temporary directory, such as c:\OUASA\temp or /OUASA/temp. (Referred to 
below as <TEMPDIR>.) This directory must be located outside any current working Oracle 
Utilities application environment. All files placed in this directory can be deleted after 
completing a successful installation. 

4. Unzip the zip file Oracle Utilities Advanced Spatial and Operational Analytics V2.4.1 
ETL Component Based on ODI Multiplatform.zip to <TEMPDIR>.

5. Decompress the file BI.ODI.V2.4.1-MultiPlatform.jar as follows:

• cd <TEMPDIR>

• jar -xvf BI.ODI.V2.4.1-MultiPlatform.jar 

Note: Ensure that you have Java JDK installed on the machine used to (un)jar 
the OUASA ETL component based on ODI installation package. Install the 
JDK that is supported for the install on your platform to be able to use the jar 
command. 
 
The Java packages are located at: http://java.sun.com/products/archive/
index.html. A sub-directory named "BI.ODI.V2.4.1" is created. It contains the 
installation software for the Oracle Utilities Advanced Spatial and Operational 
Analytics ETL component based on ODI.
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Setting Permissions for Cistab File in UNIX
Every Oracle Utilities Advanced Spatial and Operational Analytics environment installed on a 
server must be registered in the /etc/cistab file located on that server. On the UNIX servers, 
generally only the root user ID has write permissions to the /etc directory. Since, the installation 
process is run by the Oracle administrator User ID , this user ID may not be able to write to /etc/ 
cistab table.

The install utility checks permissions, and if it identifies a lack of necessary permissions, it 
generates a script in the <TEMPDIR>/ BI.ODI.V2.4.1 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Advanced Spatial and Operational Analytics application environment on the 
server) and registers a new environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Advanced 
Spatial and Operational Analytics administrator user ID, so that the next time a new environment 
is created by the same Oracle Utilities Advanced Spatial and Operational Analytics administrator 
user ID, you do not need to run the generated script with the root user ID. Instead, the install 
utility itself proceeds with the registration.

If you are re-installing an existing environment, only the validation of /etc/cistab entry is done by 
the install utility, no new registration occurs. The install utility interactively instructs you about 
every step that needs to occur in each specific case. If you plan to upgrade an existing 
environment, you must ensure to take a backup prior to the installation process. The installation 
utility does not create a backup of existing environment

OUASA ETL Component based on Oracle Data Integrator Package Installation 
Steps

Follow these steps to install the OUASA ETL component based on ODI after performing the 
steps to deploy the ETL Component Objects as described in the section above:

Prerequisites for OUASA ETL Component based on Oracle Data Integrator Package Instal-
lation

Before installing the Oracle Data Integrator package, ensure that you have already installed the 
below-mentioned softwares: 

Also, note the locations of these software:

• JDK 1.6.0_20 (JAVA_HOME)

• Oracle Database Home (ORACLE_HOME).

• Weblogic 10.3.6 (WL_HOME)

• ODI 11.1.1.6 with Java EE Installation (ODI_HOME)

• Golden Gate 11.2.1.0.5_2 Software on Source Database Server and Target Database Server 
(GG_HOME) 
Download the Golden Gate 11.2.10.5_2 software from My Oracle Support (https://
support.oracle.com/)

Now, follow the below instructions to install the OUASA ETL Component based on Oracle Data 
Integrator: 

Installing OUASA ETL Component on the Oracle Data Integrator

1. Change to the <TEMPDIR>/ BI.ODI.V2.4.1 directory.

2. Set the ORACLE_CLIENT_HOME and PATH variables as Oracle Client Perl is required to 
run the installer.
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3. Oracle Database Enterprise Edition 11.2.0.3. Installed User should be having privileges to 
install the OUASA Package.

4. Execute the following script for both UNIX and Windows:

For UNIX:

• export ORACLE_CLIENT_HOME=<ORACLE_HOME> 

• export  PERL_HOME=$ORACLE_CLIENT_HOME/perl 

• export  PATH=$PATH:$PERL_HOME/bin

• Run ksh ./instal.sh 
Note: Ensure that you have the required execute permission on install.sh.

For Windows: 

• set ORACLE_CLIENT_HOME=<ORACLE_HOME> 

• set  PERL_HOME=%ORACLE_CLIENT_HOME%\perl

• set  PATH=%PERL_HOME%\bin;%PATH% 

• Run Install.cmd

5. The Oracle Utilities Advanced Spatial and Operational Analytics specific menu is displayed.

6. Select each menu item to configure the values.  
For detailed description of the values, see Configuration Worksheet for ETL Component 
based on ODI Installation.

Environment Installation Options
Perform the following steps: 

1. Oracle Client Home Directory:

2. Environment Mount Point: 
Log Files Mount Point:        
Environment Name:        
Web Java Home Directory:

Configure all the following items to guarantee a successful installation.  
Choose the following options from the menu (1,2, <P> Process, <X> Exit):

Environment Configurations
Perform the following steps: 

1.  Environment Description

Environment Description:

2. ODI Environment Configuration:

WEBLOGIC HOME:

ODI HOME:

ODI SUPERVISOR USER: SUPERVISOR

ODI SUPERVISOR Password: sunopsis123

Target Database Name:

 Target Database Host: 

 Target Database Port: 1521

 DWADM Schema Name: DWADM

 DWADM Schema Password: <DWADM Password>
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 ODI Master Schema Name: MASTER_REPO

 ODI Master Schema Password: < MASTER_REPO Password>

 ODI Work Schema Name:  

 ODI Work Schema Password:

 ODI Master Repository ID: 601

 ODI Work Repository ID: 602

3.  ODI Agent Configuration

ODI Weblogic Agent Host:

ODI Weblogic Agent Port:

4. Source Golden Gate Configuration

Source Instance Name:

Source Golden Gate Manager Port:

Source Golden Gate Dynamic Mininum Port:

Source Golden Gate Dynamic Maximum  Port:

Source Golden Gate Algorithm:

Source Golden Gate Encryptkey:   

Source Golden Gate Shared Secret:

Source Database Name:

Source Database Host:

Source Database Port:

Source Database Home:

Source Golden Gate Home:

5. Target Golden Gate Configuration

 Target Golden Gate Manager Port:

 Target Golden Gate Dynamic Minimum Port:

 Target Golden Gate Dynamic Maximum Port:

 Target Golden Gate Algorithm:

 Target Golden Gate Encryptkey:

 Target Golden Gate Shared Secret:

 Target Database Home:

 Target Golden Gate Home:

6. Configure the items in the above list to guarantee a successful installation. Choose the 
following options from the menu item: (1,2,3,4,5 <P> Process, <X> Exit):

7. After finishing the parameter setup, proceed with the option P. Write to the configure file.

8. Once the installation is completed successfully, execute the post-installation steps outlined in 
Post Installation Tasks.

Post Installation Tasks
The following post-installation tasks are discussed in this section:
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Deploying ETL Component based on the Oracle Data Integrator
The following are the sequential deployment steps to setup the successful deployment.

1. Oracle Data Integrator Deployment

2. Seeded Data Import

3. Add Instance

4. InitiateSetup

5. Runview Generator

6. Weblogic Domain Creation for Oracle Data Integrator Agent

7. Starting the WebLogic Admin Server and Managed Server odi_server1

8. Authenticating ODI Supervisor User in Weblogic

9. After the Installation

Oracle Data Integrator Deployment 
In the Oracle Data Integrator (ODI) Deployment step ,the script creates the master and work 
repositories and import of ODI metadata: 

Run the following script 

For UNIX:

Perform the following steps: 

1. Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd $SPLEBASE/bin

3. Run Ksh ./deployodi.sh

4. Verify the log at the location: $SPLEBASE/logs/system/deployodi.log 

For Windows:

Perform the following steps: 

1. Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd %SPLEBASE%\bin

3. Run deployodi.cmd

4. Verify the log at the location: $SPLEBASE/logs/system/deployodi.log 

Seeded Data Import
This step imports pre-shipped data into DWADM for ODI Processing.

For UNIX:

Perform the following steps:

1. Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd $SPLEBASE/bin

3. Run Ksh ./importseededdata.sh

4. Verify the log at the location: $SPLEBASE/logs/system/deployodi.log 
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For Windows:

Perform the following steps:

1. Initialize the environment with the ./splenviron.cmd -e <envname> command.

 Note: Navigate to the Install_Dir/bin to initialize. 

2. cd %SPLEBASE%\bin

3. Run importseededdata.cmd

4. Verify the log at the location: $SPLEBASE/logs/system/deployodi.log 

Add Instance
The below command will insert the each Source instance and instance Name into 
b1_prod_instance table.

For UNIX:

Perform the following steps:

1. Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd $SPLEBASE/bin

3. Run Ksh ./addInstance.sh -u <Source_Schema User> -p <Source_Schema 
User_password> -s <Source Application Schema>  -r  <Source Application Drill Back 
URL>

For Windows:

Perform the following steps:

1. Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd %SPLEBASE%\bin

3. Run addInstance.cmd -u <Source_Schema User> -p <Source_Schema User_password> 
-s <Source Application Schema>  -r  <Source Application Drill Back URL>

where,

Source_Schema User  = Golden Gate Owner created in Source database

For example: ODM01SRC

• Source_Schema User_Password = Golden Gate Owner password

• Source Application Schema = Source Application Schema (E.g: CISADM)

• Source Application Drill Back URL = Source Application URL (http://<Host>:<Port>/
ouaf/)

InitiateSetup
This step is run to reverse engineer source tables, set up journalising setup, and create Golden 
Gate scripts. 

For UNIX:

Perform the following steps:

1. Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd $SPLEBASE/bin

3. Run Ksh ./initiateSetup.sh
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4. Go to $SPLEBASE/GGScriptsGen directory and locate the folder created starting with 
instance name E.g ODM1AA

5. Goto $SPLEBASE/GGScriptsGen/ODM1AA

6. Copy the src folder to Source Database Server 
Refer to the ReadMe.txt generated to run the GG Scripts .

7. Please make sure to set ORACLE_SID and ORACLE_HOME before running the 
Golden Gate Scripts on both the Source and Target  Database Servers.

For Windows:

Perform the following steps: 

1. Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd %SPLEBASE%\bin

3. Run initiateSetup.cmd

4. Go to %SPLEBASE%/GGScriptsGen directory and locate the Folder which is created 
starting with instance name E.g ODM1AA

5. Go to %SPLEBASE%/GGScriptsGen/ODM1AA

6. Copy the src folder to Source Database Server 
Refer to the ReadMe.txt generated to run the Golden Gate Scripts .

7. Ensure that ORACLE_SID and ORACLE_HOME are set before running the Golden 
Gate Scripts on both the Source and Target  Database Servers.

Runview Generator
This step generates the database views based on the configuration Setup on the Source tables and 
extract table.

For UNIX:

Perform the following steps:

1. Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd $SPLEBASE/bin

3. Run runviewGenerator.sh

For Windows:

Perform the following steps: 

1.  Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd %SPLEBASE%\bin

3. Run ruvviewGenerator.cmd

Weblogic Domain Creation for Oracle Data Integrator Agent
Weblogic Domain should be created for the Weblogic Agent (ODI Agent).

Follow the below steps to bring up Weblogic ODI Agent which is created in step 1 Oracle Data 
Integrator Deployment. 

1. Go to the installed location for ODI: <MW_HOME>/Oracle_ODI1\common\bin and 
then, run the below commands for Unix and Windows. Provide the masterschema and 
workschema provided in the configuration.
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For  UNIX:

• Run /Config.sh

For Windows:

• Run config.cmd

2. Create a new Weblogic Domain.

 

Select Next. 

3. Generate a domain configured automatically to support the following products, check boxes 
the below plugins mentioned.When you select these plugin, there are some automatic plugins 
that get selected.

• Oracle EnterpriseManager Plugin for ODI -11.1.1.0

• Oracle Data Integrtor - Console - 11.1.1.0

• Orcle Data Integrator Agent - 11.1.1.0

• Oracle Data Integrator - SDK Web Services - 11.1.1.0
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Then Select Next to proceed.

4. Specify the Domain Name and Location.

Provide the Name : odi_domain 

Location will be default.

Select Next to proceed

5. Configure Admin UserName and password for Weblogic. 
Provide the Weblogic password.

Select Next. 

6. Configure Server StartUp Mode and JDK.

Select Production Mode.
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Provide the JDK 1.6.0_20.

7. Configure JDBC Component Schema.  
Select the checkbox ODI Master Schema and provide the below details:

• DBMS/Service : Target Database Name

• Host Name  : Database Serverhost

• Port : Database Port

• Schema Owner : MASTER_REPO

• Schema Password: MASTER_REPO Password

8. Deselect the checkbox ODI Master Schema. 

9. Select checkbox ODI Work Schema Provide the below details:

DBMS/Service: Target Database Name

Host Name: Database Serverhost

Port: Database Port

Schema Owner: WORK_REPO

Schema Password: WORK _REPO Password
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Then select Next to proceed.

10. Test JDBC Component Schema by selecting Select All and Test Connections.

 

Then, select Next to proceed. 

11. On the Select Optional Configuration page, select the following check boxes: 

• Administration Server 

• Managed Server, Clusters and Machines.|
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Select Next to proceed.

12. Configure the Administration Server: 

Provide the listening port, which is not in use.

 

Then select Next to proceed.

13. Configure the Managed Servers by providing the following details: 

Name: odi_server1

Listen Address: All Local Addresses

Port: <Provide the port>, which is configured in Menu configuration of installation> 
ODI Agent Configuration>ODI Weblogic Agent Port:>
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Configure Cluster.  
Select Next to proceed.

14. Configure Machines.  
Select Next to proceed

15. Assign Servers to Machines. 
Select Next to proceed.

16. Configuration Summary. 
Click Create to create the Domain ODI_DOMAIN.

17. After the domain is created, go to Domain Location, Create boot.properties file for Weblogic 
login.

18. Create the <MW_HOME>/user_projects/domains/odi_domain/servers/AdminServer/
security folder if it was not created earlier.

19. Go to <MW_HOME>/user_projects/domains/odi_domain/servers/AdminServer/
security, then create boot.properties with below Values:

username=weblogic

password=Weblogic password

20. Create the <MW_HOME>/user_projects/domains/odi_domain/servers/odi_server1/
security folder if not present.

21. Go to <MW_HOME>/user_projects/domains/odi_domain/servers/odi_server1/security 
,then create boot.properties with below Values:

username=weblogic

password=Weblogic password

Starting the WebLogic Admin Server and Managed Server odi_server1
Perform the following steps: 

1. In the command shell, change directory to the directory of the WLS Home -
<MW_HOME>/user_projects/domains/odi_domain/bin

2. Execute the startweblogic command.
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For Unix:

• nohup ./ startWebLogic.sh > startWebLogic.log &

For Windows:

• Run startWebLogic.cmd

Authenticating ODI Supervisor User in Weblogic
Perform the following steps: 

1. Go to <MW_HOME>/oracle_common/common/bin

2. Execute the following command:

For Unix:

./wlst.sh
For Windows:

wlst.cmd
3. To connect to the running Admin server, execute the following command: 

connect('<Weblogic User>','<Weblogic password>','t3://
<WEBLOGICHOST>:<WEBLOGIC ADMIN PORT')   
For example:  connect('weblogic','weblogic123','t3://localhost:7001')

4. Execute the following command to add the correct credential store for ODI Supervisor: 

createCred (map="oracle.odi.credmap", key="SUPERVISOR", user="SUPERVISOR", 
password="<SUPERVISOR Password>", desc="ODI SUPERVISOR Credential").

5. To exit WLST, execute the command exit().

To start managed server odi_server1

Perform the following steps: 

1. Change directory to WLS Home -<MW_HOME>/user_projects/domains/odi_domain/bin 
and use the execute the below commands:

For Unix:

nohup ./ StartManagedWeblogic.sh  odi_server1 > StartManagedWeblogic.log &

For Windows:

Run StartManagedWeblogic.cmd odi_server1

2. From the Oracle Data Integrator (ODI) Designer, click Test icon to test connectivity of your 
configured ODI Java EE agent. Click OK. 

3. Close the OracleDIAgent tab.

After the Installation
Perform the following steps: 

1. Log in to the ODI studio and navigate to Designer > Projects > Oracle Utilities BI > 
Configuration > Scheduler'Packages.

2. Right click BI_INITIAL_SETUP_PKG and execute 

3. Select ODM1 as context and WLS_AGENT as logical agent and then click ok.

4. Go to Operator and view the logs for successful execution of package.

OUASA ETL Component based on Oracle Warehouse Builder Upgrade
This section describes the ETL component installation: 

• Copying and Decompressing Install Media
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• Setting Permissions for cistab File in UNIX

• Configuring and Upgrading the Oracle Warehouse Builder Workspace

• Upgrading the OUASA ETL Component based on Oracle Warehouse Builder  
Package

• Post Installation Tasks

Copying and Decompressing Install Media
The Oracle Utilities Advanced Spatial and Operational Analytics ETL component based on OWB 
installation file is delivered in zip format for both UNIX and Windows platforms. If you plan to 
install multiple Oracle Utilities Advanced Spatial and Operational Analytics environments 
operated by different Oracle Utilities Administrator user IDs, you must complete each of the 
following installation steps for each Administrator user ID.

Perform the following Steps: 

1. Download the Oracle Utilities Advanced Spatial and Operational Analytics V2.4.1 ETL 
Component Based on OWB part (Oracle Utilities Advanced Spatial and Operational 
Analytics V2.4.1 ETL Component Based on OWB Multiplatform.zip)from My Oracle 
Support (https://support.oracle.com/).

2. Log in to the Database server host as the Oracle Utilities Advanced Spatial and Operational 
Analytics administrator user ID (default cases).

3. Create a temporary directory, such as c:\OUASA\temp or /OUASA/temp. (Referred to 
below as <TEMPDIR>.) This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory can be deleted after 
successful installation.

4.  Unzip Oracle Utilities Advanced Spatial and Operational Analytics V2.4.1 ETL 
Component Based on OWB Multiplatform.zip to <TEMPDIR>

5. Decompress the file BI.OWB.V2.4.1-MultiPlatform.jar as follows:

• cd <TEMPDIR>

• jar -xvf BI.OWB.V2.4.1-MultiPlatform.jar 

Note: You should have Java JDK installed on the machine used to (un)jar the 
OUASA ETL component based on OWB installation package. Install the JDK 
that is supported for the install on your platform to be able to use the jar 
command. 
 
The Java packages are located at: http://java.sun.com/products/archive/
index.html. A sub-directory named "BI.OWB.V2.4.1" is created. It contains the 
installation software for the Oracle Utilities Advanced Spatial and Operational 
Analytics ETL component based on OWB.

Setting Permissions for cistab File in UNIX
Every Oracle Utilities Advanced Spatial and Operational Analytics environment installed on a 
server must be registered in the /etc/cistab file located on that server. On UNIX servers, generally 
only the root user ID has write permissions to the /etc directory. Since the installation process is 
run by the Oracle administrator user ID, this user ID may not be able to write to /etc/ cistab 
table.

The install utility checks permissions and if it identifies a lack of the necessary permissions, it 
generates a script in the <TEMPDIR>/BI.OWB.V2.4.1 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
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Oracle Utilities Advanced Spatial and Operational Analytics application environment on the 
server) and registers a new environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Advanced 
Spatial and Operational Analytics administrator user ID, so that the next time a new environment 
is created by the same Oracle Utilities Advanced Spatial and Operational Analytics administrator 
user ID, there is no need to run the generated script with the root user ID. Instead, the install 
utility itself proceeds with the registration.

If you are reinstalling an existing environment, only the validation of /etc/cistab entry is done by 
the install utility. No new registration occurs. The install utility interactively gives instructions 
about every step in each specific case.

If you are planning to upgrade an existing environment, ensure that you have taken a backup prior 
to the initiating the installation process. The installation utility by itself does not create a backup of 
existing environment.

Configuring and Upgrading the Oracle Warehouse Builder Workspace
This section describes how to configure the Oracle Warehouse Builder workspace. To upgrade to 
Oracle Utilities Advanced Spatial and Operational Analytics version v2.4.1, follow these steps: 

Upgrading to OUASA v2.4.1

1. Back up the database using the backup strategy employed at your site.

2. Apply 12874883 and 13533924 OWB patches on 11.2.0.2 database server and OWB client if 
already not applied.

3. Connect to BIREPOWN user and run spl_exec_wf_prc.sql. spl_exec_wf_prc.sql is located at 
../BI241/Scripts.

4. Connect to the DWADM schema and execute spl_oms_snapshot_pkg.sql. 
spl_oms_snapshot_pkg.sql is located at ../BI241/Scripts.

5. Connect to the database with sys user and execute the following SQL statements: 

DROP SYNONYM DWADM.WB_RT_AUDIT;

CREATE SYNONYM DWADM.WB_RT_AUDIT FOR OWBSYS.WB_RT_AUDIT; 
GRANT SELECT ON OWBSYS.WB_RT_AUDIT TO DWADM;

GRANT SELECT ON OWBSYS.ALL_RT_AUDIT_EXECUTIONS TO DWADM;

GRANT ALL ON OWBSYS.WB_RT_AUDIT_PURGE TO DWADM; 

GRANT ALL ON OWFMGR.WF_PURGE TO DWADM; 

GRANT SELECT_CATALOG_ROLE TO BIREPOWN;

GRANT ALL ON OWBSYS.WB_RT_AUDIT_EXECUTIONS TO DWADM;

GRANT ALL ON OWBSYS.WB_RT_DEF_EXECUTION_OPERATORS TO 
DWADM;

DROP SYNONYM DWADM.WB_RT_AUDIT_EXECUTIONS;

DROP SYNONYM DWADM.WB_RT_DEF_EXECUTION_OPERATORS; 
CREATE SYNONYM DWADM.WB_RT_AUDIT_EXECUTIONS FOR 
OWBSYS.WB_RT_AUDIT_EXECUTIONS;

CREATE SYNONYM DWADM.WB_RT_DEF_EXECUTION_OPERATORS FOR 
OWBSYS.WB_RT_DEF_EXECUTION_OPERATORS;

alter system set query_rewrite_enabled=force;

alter system set query_rewrite_integrity=trusted;
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Upgrading the OUASA ETL Component based on Oracle Warehouse Builder  
Package

After performing the above steps,  proceed with upgrading OUASA ETL Component based on 
OWB Package steps.

Perform the following: 

1. Change to <TEMPDIR>/BI.OWB.V2.4.1 directory.

2. Set the ORACLE_CLIENT_HOME and PATH variables as Oracle Client Perl is required to 
run the installer.

3. If the customer is upgrading from OUASA version 2.4.0 or 2.4.0.x to version 2.4.1, then 
follow the below steps:

• Log in to the server host where OUASA ETL Component based on OWB package is 
installed

• Connect to OUASA database as sys user and restart the database

• Go to  $ORACLE_HOME/owb/rtp/sql and execute stop_service.sql and 
start_service.sql after logging as OWBSYS user

4. Take a back up of the previously installed Oracle Warehouse Builder package environment

5. Log in to the previously installed Oracle Warehouse Builder package environment. Perform 
the following: 

• Go to the installed environment location e.g cd /bi_oradata_01/QABlds/
BI240_CANDIDATE_BLD

• cd etc

• Open ENVIRON.INI file and get the value of SPLENVIRON variable. It will look like 
SPLENVIRON=BI240_CANDIDATE_BLD . Here BI240_CANDIDATE_BLD is 
environment name.

• cd ../bin

• . ./splenviron.sh -e <ENVIRONMENT NAME>  e.g ./splenviron.sh -e 
BI240_CANDIDATE_BLD

• cd bin

6. Run ksh ./stopFileprocessordaemon.sh to stop the running file processor.

Note: For Unix and WIndows, go to $SPLEBASE/tmp and then remove all 
contents inside this directory. 

7. Now, proceed with OUASA 2.4.1 install 

• Go to Change to the <TEMPDIR>/BI.OWB.V2.4.1

• Run ksh ./install.sh for Unix 

• Run install.cmd for Windows

12/07/24:14:05:02 <info>  Product BI is already installed in the environment 
BI240_CANDIDATE_BLD.  12/07/24:14:05:02 <info>  Do you want to reinstall it? 
(Y/N):Y

If customer is upgrading OUASA from v2.3.2.1 to v2.4.1, then perform the below steps.

After the configuration items are displayed on the console, press P to continue the 
installation.\

8. Execute the following script on both UNIX and Windows: 

For UNIX:
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• export ORACLE_CLIENT_HOME=<ORACLE_HOME> 

• export PERL_HOME=$ORACLE_CLIENT_HOME/perl 

• export PATH=$PATH:$PERL_HOME/bin

• Run ksh ./install.sh

For Windows:

• set ORACLE_CLIENT_HOME=<ORACLE_HOME> 

• set PERL_HOME=%ORACLE_CLIENT_HOME%\perl

• set PATH=%PERL_HOME%\bin;%PATH% Install_O.cmd

Note: On UNIX, ensure that you have the proper execute permission on 
install.sh.

9. The Oracle Utilities Advanced Spatial and Operational Analytics specific menu is displayed.

10. Select Each Menu Item to configure the values.  
For detailed description of the values seeConfiguration Worksheet for ETL Component 
based on OWB Installation.

Environment Installation Options
1. Oracle Client Home Directory: 

2. Environment Mount Point:  
Log Files Mount Point:  
Environment Name: 
Web Java Home Directory: 

Configure each item in the above list for successful installation. Choose the following options 
from the menu items:  (1,2, <P> Process, <X> Exit):

Environment Configuration
Perform the following steps: 

1. Environment Description 
Environment Description:

2. Database Configuration 
OWB WorkSpace Owner: 
OWB WorkSpace Owner Password:  
Database Name: 
Database Server: 
Database Port:

3. DESIGN REPOSITORY CONFIGURATION 

OWB WorkSpace User: 
OWB Workspace user Password:  
OWB WorkSpace Name:  
DWADM SCHEMA NAME: 
DWADM SCHEMA Password: 
WORKFLOW MANAGER SCHEMA NAME:  
WORKFLOW MANAGER SCHEMA Password:

4. DATABASE CHARACTER SET CONFIGURATION  
Database Character set: AL32UTF8

5. EDITING PROCESS FLOW CONFIGURATION 

Repository Operating System:

Perl Compiler location:
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Data and control files location: 

Separator to be used:

File Manager location:

6. EMAIL CONFIGURATION 

Email ID of Sender:

Email ID for Reply-To address: 

Email ID of Receiver:

SMTP server: 

SMTP server port:

7. CONTROL CENTRE CONFIGURATION 

Repository Control Center Name:

8. EXTERNAL DATA SOURCE CONFIGURATION 

Path of the External Datasource:

Path of the External Datasource LOG:

File Processor Daemon Execution Switch:

File Processor Extract Max Load:

File Processor Scheduler Poll Duration:60

9. Configure each item in the above list for successful installation. Choose the following options 
from the menu items (1,2,3,4,5,6,7,8 <P> Process, <X> Exit):

10. After completing the parameter setup steps, proceed with the option P. Write Configure file.

11. Once the install is completed successfully, you need to execute the post-upgrade steps as 
described in the section Post Installation Tasks.

Post Installation Tasks
Post-upgrade tasks involve the following:

• Deploying ETL Workflows on Oracle Warehouse Builder

Deploying ETL Workflows on Oracle Warehouse Builder
In UNIX, you may get a Java heap space error while importing the MDL file. To resolve this error 
you need to make changes in the OMBPlus.sh file, located at: $ORACLE_HOME/owb/bin/ 
unix/OMBPlus.sh.

In the following code, change the value -Xmx768M to -Xmx1024M, and then the -Dlimit value 
768M to 1024M.

$JAVAPATH/bin/java $JAVA64FLAG -Xms64M -Xmx768M $OPTS -Dlimit=768M - 
DORACLE_HOME=$ORACLE_HOME -DOWBCC_HOME=$ORACLE_HOME - 
DTCLLIBPATH="$TCLLIBPATH" - 
DMARATHON_RETRY_COUNT="$MARATHON_RETRY_COUNT" - 
DMARATHON_RETRY_INTERVAL="$MARATHON_RETRY_INTERVAL"

You need to make this value larger than 1024MB (1GB) depending on the size of the import. 
$CLASSPATH_LAUNCHER oracle.owb.scripting.OMBShell $*

Perform the following tasks:

• Deploying Oracle Warehouse Builder Workflows

• Deploying Materialized Views
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• Generating Security

• Generating Database Statistics

Deploying Oracle Warehouse Builder Workflows
This procedure needs to be performed if changes are made to the parallel settings on external 
tables, materialized views, or mappings on an existing installation and needs to be retained during 
the upgrade process.

Run the following command to generate a report on the parallel settings that is currently set in the 
customer repository on external tables, materialized views and mappings.

For UNIX:

1. Initialize the environment by executing the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd $SPLEBASE/bin

3. Run ksh ./parallelSetup.sh analyze

For Windows:

1. Initialize the environment by executing the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd %SPLEBASE%\bin 

3. Run parallelSetup.cmd analyze

4. This generates the following files under <SPLEBASE>/etc folder: 

5. Review the above files for existing settings and make modifications if necessary. Once 
the files are reviewed, perform the following step to merge the existing settings with the 
default settings.

For UNIX:

1. Initialize the environment by executing the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd $SPLEBASE/bin

3. Run ksh ./parallelSetup.sh merge

For Windows:

1. Initialize the environment by executing the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd %SPLEBASE%\bin

3. Run parallelSetup.cmd merge

4. Review the following files under <SPLEBASE>/etc and verify that the existing values 
have been merged correctly before proceeding:

 cm-parallel-tables.txt  
cm-parallel-mvs.txt 

cm-parallel-maps.txt

5. Below is the format of parallel*.txt to change the <Degree> of parallelism in above listed 
files. 

parallel-tables.txt file format: <Object_name>:<Degree>
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parallel-mvs.txt file format: <MV_Name>:<Fact_Table>:<Degree>

parallel-maps.txt file format: <Object_name>:<Table_Name>:<Degree> For UNIX:

For UNIX: 

1. Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd $SPLEBASE/bin

3. Run ksh ./Owbdeploy.sh

For Windows:

1. Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd %SPLEBASE%\bin

3. Run owbdeploy.cmd

Deploying Materialized Views
Run the following commands for deploying Materialized Views. 

For UNIX:

1. Initialize the environment by executing the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. Run the below script if upgrading from OUASA v2.3.2.1 to v2.4.1 for upgrading the 
Materialized views

• cd $PLEBASE\bin

• Run ksh ./upgradeViews.sh

3. Run the below script if upgrading from OUASA v2.4.0 or 2.4.0.1  to OUASA v2.4.1 for 
upgrading the Materialized views

• cd %SPLEBASE%\bin

• Run upgradeViews240-2403.sh

4. Run the below script, if upgrading from OUASA v2.4.0.2 to v2.4.1, for upgrading the 
Materialized views

• cd %SPLEBASE%\bin

• Run ksh ./ upgradeViews2402-241.sh

For Windows:

1. Initialize the environment by executing the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. Run the below script if upgrading from OUASA v2.3.2.1 to v2.4.1 for upgrading the 
Materialized views

• cd %SPLEBASE%\bin

• Run upgradeViews.cmd

3. Run the below script if upgrading from 2.4.0 or 2.4.0.1  to V2.4.1 for upgrading the 
Materialized views:

• cd %SPLEBASE%\bin

• Run upgradeViews240-2403.cmd
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4. Run the below script if Upgrading from OUASA v 2.4.0.2 to v2.4.1 for upgrading the 
Materialized views

• cd %SPLEBASE%\bin

• Run upgradeViews2402-241.cmd

5. Once deployment is complete, remove the <SPLEBASE>/tmp content to ensure all the 
complete files are removed:

Generating Security
Edit database-name with the name of your database in OraGenSec.bat after completing the OWB 
deployment and run it from BI241/DWADM/Security folder.

Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before 
starting to use the database, generate the statistics for these new objects.

OUASA Dashboard Component Upgrade
This section describes the dashboard component installation and includes the following:

• Copying and Decompressing Install Media

• Setting Permissions for cistab File in UNIX

• OUASA Dashboard Package Upgrade Steps

• Post-Upgrade Tasks

Copying and Decompressing Install Media
The Oracle Utilities Advanced Spatial and Operational Analytics Dashboard Component 
installation file is delivered in a zip format for both UNIX and Windows platforms. If you plan to 
install multiple Oracle Utilities Advanced Spatial and Operational Analytics environments 
operated by different Oracle Utilities Administrator user IDs, you must complete each of the 
following installation steps for each Administrator user ID.

1. Download the Oracle Utilities Advanced Spatial and Operational Analytics V2.4.1 Dashboard 
Component part (Oracle Utilities Advanced Spatial and Operational Analytics V2.4.1 
Dashboard Component Multiplatform.zip)from My Oracle Support (https://
support.oracle.com/).

2. Log in to the application server host (where OBIEE 11.1.1.6.6 software is installed) as the 
Oracle Utilities Advanced Spatial and Operational Analytics administrator user ID (default 
ceases).

3. Create a temporary directory, such as c:\OUASA\temp or /OUASA/temp. (Referred as 
<TEMPDIR> in step 3 below) This directory must be located outside any current working 
Oracle Utilities application environment. All files that are placed in this directory can be 
deleted after successful installation.

4. Unzip the Oracle Utilities Advanced Spatial and Operational Analytics V2.4.1 
Dashboard Component Multiplatform.zip to <TEMPDIR>

5. Decompress the file BI.OBIEE.V2.4.1-MultiPlatform.jar:

• cd <TEMPDIR>

• jar -xvf BI.OBIEE.V2.4.1-MultiPlatform.jar

Note: You should have Java JDK installed on the machine used to (un)jar the 
OUASA dashboard component installation package. Install the JDK that is 
supported for the install on your platform to be able to use the jar command. 
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The Java packages are located at: http://java.sun.com/products/archive/
index.html

A sub-directory named "BI.OBIEE.V2.4.1" is created. It contains the 
installation software for the Oracle Utilities Advanced Spatial and Operational 
Analytics Dashboard Component.

Setting Permissions for cistab File in UNIX
Note that every Oracle Utilities Advanced Spatial and Operational Analytics environment installed 
on a server must be registered in the /etc/cistab file located on that server.

On UNIX servers, generally only the root user ID has write permissions to the /etc directory. 
Since the installation process is run by the Oracle administrator user ID, this user ID may not be 
able to write to /etc/cistab table.

The install utility checks permissions and if it identifies a lack of the necessary permissions, it 
generates a script in the <TEMPDIR>/BI.OBIEE.V2.4.1 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Advanced Spatial and Operational Analytics application environment on the 
server) and registers a new environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Advanced 
Spatial and Operational Analytics administrator user ID, so that the next time a new environment 
is created by the same Oracle Utilities Advanced Spatial and Operational Analytics administrator 
user ID, you do not need to run the generated script with the root user ID. Instead, the install 
utility itself proceeds with the registration.

If you are reinstalling an existing environment, only the validation of /etc/cistab entry is done by 
the install utility. No new registration occurs. The install utility interactively gives instructions 
about every stepin each specific case.

To upgrade an existing environment, it is recommended that a backup be taken before initiating 
the installation process. The installation utility by itself does not create a backup of the existing 
environment.

OUASA Dashboard Package Upgrade Steps
Before upgrading, verify that the steps in section Prerequisite Software for OUASA Dashboard 
Component are followed.

To upgrade the OUASA dashboard package, follow these steps.

1. Change to the <TEMPDIR>/BI.OBIEE.V2.4.1 directory.

Perform the following steps: 

For UNIX:

• export ORACLE_CLIENT_HOME=<ORACLE_HOME> 

• export PERL_HOME=$ORACLE_CLIENT_HOME/perl 

• export PATH=$PATH:$PERL_HOME/bin

• Run install.sh

Note: Ensure that you have the required execute permission on install.sh.

For Windows

• set ORACLE_CLIENT_HOME=<ORACLE_HOME>

• set PERL_HOME=%ORACLE_CLIENT_HOME%\perl

• set PATH=%PERL_HOME%\bin;%PATH%
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• Run install.cmd

2. The Oracle Utilities Advanced Spatial and Operational Analytics specific menu appears. 

3. Select the Each Menu Item to configure the values.

For detailed description of the values, see Configuration Worksheet for Dashboard 
Component Installation.

Environment Installation Options
1. Oracle Client Home Directory: 

2. Environment Mount Point:  
Log Files Mount Point:  
Environment Name: 
Web Java Home Directory:  
 
Configure each item in the above list for a successful installation. Choose the following 
options from the menu item: (1,2, <P> Process, <X> Exit):

3.  For detailed description of the values see Configuration Worksheet for Dashboard 
Component Installation.

Environment Configuration
1. Environment Description 

Environment Description:

2. OBIEE Environment Configuration 
Oracle BI Instance Home:  
Oracle BI Home: 
Oracle BI Domain Home: 
Weblogic Domain Console User Name:  
Weblogic Domain Console Host:  
Weblogic Domain Console Port Number: 
Provide OBIEE Version Installed:

3. Target Database Details 
Target Database Name:  
Target Database Host: 
Target Database Port:  1521 
DWADM Schema Name: DWADM 
DWADM  Schema Password:      
 
Configure each item in the above list for a successful installation. Choose the following 
options from the menu item (1,2,3,  <P> Process, <X> Exit):

4. After completing the parameter setup, proceed with the option P. Write the Configure file.

5. Once installation finishes successfully, execute the post-installation steps as described in 
section Upgrading RPD and Catalog Files.

Upgrading RPD and Catalog Files
If you have made custom changes to deployed RPD and catalog files, follow the procedures in this 
section to make the custom files compatible with 11g  if required. This section includes the 
following topics:

• Converting RPD Files

• Converting Catalogs

• Merging the RPD Files

Converting RPD Files
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Perform these steps to convert the 10g RPD files to 11g:

Note: These steps are not required for 11g RPD.

1. Create a folder on the server where 11g OBIEE is installed. 
Copy the 10g RPD file that is deployed in your environment to this folder.

2. Go to $ORACLE_BI_HOME/bin and run ua.bat or ua.

3. Click Next to continue.

4. Select Upgrade Oracle BI RPD and Presentation Catalog.

5. Click Next to continue.

6. Select Upgrade repository.

7. Select the 10g RPD file contained in the folder that you created in step 1.

8. Enter the administrator User ID and password for the 10g RPD file.

9. Enter the new administrator password for 11g RPD, for example, oracle123.

10. Specify the WebLogic port and login details.

11. An 11g compatible rpd file will be created in the following location: 
$ORACLE_INSTANCE /bifoundation/OracleBIServerComponent/ 
coreapplication_obis1/repository location.

12.  Upgrade

13.  Back up the converted rpd file from the $ORACLE_INSTANCE /bifoundation/
OracleBIServerComponent/coreapplication_obis1/repository location.

This is your changed rpd file.

Converting Catalogs
Perform the following steps: 

1. Take a backup of SampleAppLite  folder as  SampleAppLite.bkp present inside 
$ORACLE_INSTANCE/bifoundation/OracleBIPresentationServicesComponent 
coreapplication_obips1/catalog directory. Create a folder on the server where 11g OBIEE is 
installed. For example, obiee/ SampleAppLite.

2. Copy the contents of 10g ../../web/catalog/samplesales folder to the obiee/ 
SampleAppLitefolder. The samplesales folder is included in the 10g application.

3. Create a folder named "deliveries" inside the obiee folder.

4. Navigate to $ORACLE_BI_HOME/bin and run ua.bat or ua.

5. Select Upgrade Oracle BI RPD and Web Catalog.

6. Click Next to continue.

7. Select Upgrade catalog.

8. Select the obiee/SampleAppLite folder as the catalog directory.

9. Select obiee/deliveries as the catalog deliveries directory.

10. Click Next.

11. Specify the WebLogic port and login details.

12. Click Next.

13. Click Upgrade. 
The 10g catalogs will be deployed at the following location: 
$ORACLE_INSTANCE/bifoundation/OracleBIPresentationServicesComponent/
coreapplication_obips1/catalog/SampleAppLite/root/shared location
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14. Now move custom catalogs from $ORACLE_INSTANCE/bifoundation/
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/SampleAppLite/
root/shared location to $ORACLE_INSTANCE/bifoundation/
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/
SampleAppLite.bkp/root/shared location.

15. Rename SampleAppLite directory to SampleAppLite.bkp1 and SampleAppLite.bkp to 
SampleAppLite.

Merging the RPD Files
Convert your original RPD(Shipped with product)  file to 11g if required as described in the 
section Converting RPD Files and then, take the converted RPD and shipped RPD from 
<install_dir>/Reports/rpd/UtilitiesBusinessAnalytics.rpd and merge them. Deploy the merged 
RPD after making the required database connection. \

To merge the rpds, please follow the OBIEE documentation for merging.

http://www.oracle.com/webfolder/technetwork/tutorials/obe/fmw/bi/bi11115/
import_merge/merging_importing_11g.htm

Post-Upgrade Tasks
Post-upgrade tasks involve the following:

• Deploying the Repository (RPD) File

• Deploying the Web Catalog

• Configuring and Deploying Map Viewer

• Deploying Write Back

• Deploying Analytics

Deploying the Repository (RPD) File
If customer has not made any changes to the deployed RPD, then please take the RPD file from 
following location: <install_dir>/Reports/rpd/ UtilitiesBusinessAnalytics.rpd, where 
<install_dir> is the OUASA dashboard package installation directory.

If customer has done merging, then take the merged rpd and make the required database chnages.

Follow these steps to deploy the RPD file:

1. OBIEE 11.1.1.6.6 should be installed on Windows  machine before proceeding with the 
below steps.

2. Launch the Administration Tool from your Start menu. 
 
Start > Programs > Oracle Business Intelligence > Administration

3. Open the RPD in offline mode by selecting File > Open > Offline...

4. Provide the RPD password. For example, "oracle123".
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5. Edit the connection pools shown below by double clicking on them.

6. In the Init Block Connection Pool group, enter the following: 

Datasource name = BI Database name

User name = DWREAD

Password = DWREAD User password

7. In the Init Block Pool - MDM group, provide the following (only for MDM): 

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

8. In the MDM Database Connection group, provide the following (only for MDM): 

Data source name = MDM database name

User name = CISUSER

Password = CISUSER User password

9. In the ODIDEV Connection Pool group, provide the following: 

Data source name = BI database name

User name = DWUSER

Password = DWUSER User password

10. In the OUBI Database Connection group, provide the following: 

Data source name = BI database name

User name = DWREAD
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Password = DWREAD User password

11. Click Save. 

12. Log in to the OBIEE Enterprise Manager console.

13. Navigate to BI Instance > Coreapplication > Deployment.

14. Lock and edit. 
The repository text box will be enabled.

15. Browse to the modified rpd file and submit. 

16. Provide the RPD password "oracle123", and then click Apply.

17. Activate the changes and then restart BI Services.

Note: All the above databases set in the connection pool should be updated in 
tnsnames.ora file in <OBIEE_INSTALL_DIR>/Oracle_BI1/network/
admin.

Deploying the Web Catalog
Note: You must delete all old OUASA catalogs from the catalog deployed 
location (if present) before deploying the catalogs. 

Delete the OUASA catalogs from $ORACLE_INSTANCE/bifoundation/
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/SampleAppLite/
root/shared directory: 

rm -rf "distribution+analytics.atr"

rm -rf "distribution+analytics"

rm -rf "mobile+workforce+analytics.atr"

rm -rf "mobile+workforce+analytics"

rm -rf "outage+analytics.atr"
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rm -rf "outage+analytics"

rm -rf "co%6dmon.atr"

rm -rf "co%6dmon"

rm -rf "customer+analytics.atr"

rm -rf "customer+analytics"

rm -rf "about.atr"

rm -rf "about"

rm -rf "administration.atr"

rm -rf "administration"

rm -rf "meter+data+analytics.atr"

rm -rf "meter+data+analytics"

rm -rf "revenue+analytics.atr"

rm -rf "revenue+analytics"

rm -rf "shared+objects.atr"

rm -rf "shared+objects"

Delete OUASA catalogs from $ORACLE_INSTANCE/bifoundation/
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/SampleAppLite/
root/system directory.

Rm -rf "spatialmetadata.atr"

Rm -rf "spatialmetadata"

Deploying the Catalogs

To deploy the catalogs, follow these steps: 

For UNIX:

1. Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd $SPLEBASE/bin

3. ksh ./deploycatalog.sh

4. Enter the physical catalogs location configured in Enterprise Manager.  
For example:  
<OBIEE_INSTALL_DIR>/instances/instance1/bifoundation/ 
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/ SampleAppLite

For Windows:

1. Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd  %SPLEBASE%\bin

3. deploycatalog.cmd

4. Enter the Physical Catalogs location configured in EM  
For example:<OBIEE_INSTALL_DIR>/instances/instance1/bifoundation/ 
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/ SampleAppLite

Configuring and Deploying Map Viewer
Configuring and deploying the MapViewer involves the following:
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Configuring MapViewer - 

To configure Mapviewer, follow these steps: 

1. Log in to the WebLogic console.

2. In the WebLogic console, create the 'MAP_DS' data source.

3. Lock and edit.

4. Navigate to Services > Data Sources.

5. Select New > Generic Data Source and provide the following: 

Name = MAP_DS

JNDI Name = MAP_DS 

Database Type = oracle

6. Click Next.

7. Enter the following: 
Database Driver = XA thin database driver

8. Click Next.

9. Enter the following Connection properties: 

Database Name: BI Database Name 

Host Name: Database host 

Port: Database port

Database User Name: dwadm

Password: dwadm password

10. Click Next and then, click Finish.

11. Click Activate Changes.

12. Update the mapViewerConfig file with below mentioned tags:

File location : <OBIEE_INSTALL_DIR>/Oracle_BI1/bifoundation/jee/

mapviewer.ear/web.war/WEB-INF/conf/ 

File: mapViewerConfig.xml

13. If there is a proxy used, insert the list of host names for all the third party service providers in 
the security_config node.

<proxy_enabled_hosts>elocation.oracle.com,maps.weatherbug.com,direct.weatherbug.com,a
pi.wxbug.net,de.tiles.wea therbug.com

</proxy_enabled_hosts>

14. Update the following ns_data_provider node:

<ns_data_providerid="obieeNsdp" 

class="com.oracle.utilities.birdseye.BirdseyeNSDP" />

15. Update the current map_tile_server with the following map_tile_server node.

<map_tile_server>

<tile_storage default_root_path="/mytilecache/"/>

</map_tile_server>

16.  Update the instance config file location, for example: FileLocation:
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For Unix:

<OBIEE_INSTALL_DIR>/instances/instance1/config/ 
OracleBIPresentationServicesComponent/coreapplication_obips1

For Windows:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentationServicesCo
mponent\coreapplication_obips1

Modifying instanceconfig.xml - 

Update the security Node with the following values. If the security Node is not present, add 
following code before </Serverinstance>:

<Security>
<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
<HttpOnlyCookies>false</HttpOnlyCookies>
<CookieDomain />
<CookiePath>/</CookiePath>
</Security>

Deploying Custom MapViewer - 
To deploy the custom MapViewer, follow these steps: 

For UNIX: 

1. Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

2. cd $SPLEBASE/bin

3. Run ksh ./deploymapviewer.sh

4. Enter the WebLogic Domain Console Password. For example, weblogic123

For Windows: 

1. Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

2. cd %SPLEBASE%\bin

3. Run deploymapviewer.cmd

4. Enter WebLogic Domain Console Password. For example, weblogic123

Perform the following steps after deploying the custom MapViewer:

1. Update the MapViewer configuration by navigating to MapViewer > Administration > 
Configuration. Login to Mapviewer at this location: http://
<HOST>:<MANAGERPORT>/mapviewer

2. Add the below content in the mapViewerConfig.xml with appropriate values:

<DB_HOST>,<DBNAME>,<DB_PORT>,<USER>,<PASSWORD>

<map_data_source name="MAPCONN" 

jdbc_host="<DB_HOST>" jdbc_sid="<BI Database Name>" 
jdbc_port="<DB_PORT>" jdbc_user="<DWADM>"

jdbc_password="<!DWADM PASSWORD>" 

jdbc_mode="thin"

number_of_mappers="32" allow_jdbc_theme_based_foi="true"

/>
Upgrading Oracle Utilities Advanced Spatial and Operational Analytics 6-91



3. Save and then restart.

Note: The above step has to be performed each time after running the 
deploymapviewer command.

Deploying Write Back
Follow these steps to deploy the write back feature.

1. Open the following file: 
<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentationServicesCo 
mponent\coreapplication_obips\instanceconfig.xml

2. Update the following <ServerInstance> element according to the following code: 
<LightWriteback>true</LightWriteback>

3. Deploy write back as follows: 

For UNIX:

1. Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. cd $SPLEBASE/bin

2. cd $SPLEBASE/bin

3. Run ksh ./deploywriteback.sh

For Windows:

1. Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. cd %SPLEBASE%/bin

deploywriteback.cmd

2. cd %SPLEBASE%/bin

3. Run deploywriteback.cmd

Deploying Analytics
To deploy analytics, follow these steps:

1. Edit the Presentation Services configuration file, "instanceconfig.xml", in the following 
directory: 
<OBIEE_INSTALL_DIR>/instances/instance1/config/ 
OracleBIPresentationServicesComponent/coreapplication_obips1

2. Add the following before the end tag </ServerInstance>

<UI>

<DefaultStyle>oubi</DefaultStyle>

<DefaultSkin>oubi</DefaultSkin>

</UI>

Enabling Analytics Help
To enable the Analytics Help, perform these steps: 

1. Download Oracle Utilities Advanced Spatial and Operational Analytics User Guide from 
Oracle Software Delivery Cloud.

2. After downloading the OUASA User Guide, change the name of the Help file to OUASA 
Help.pdf.

3. Now, place the Help file in <install_dir>/Skin/res, where <install_dir> is the OUASA 
dashboard package installation directory.
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4. Run the following commands: 

For UNIX: 
Perform the following steps: 

1. Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd $SPLEBASE/bin8

3. Run ksh ./deployanalyticsear.sh

4. Enter the WebLogic Domain Console Password. For example, weblogic123

For Windows:

Perform the following steps: 

1. Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize. 

2. cd %SPLEBASE%/bin

3. deployanalyticsear.cmd

4. Enter the WebLogic Domain Console Password. For example, weblogic123

5. Restart the BI Core services.

6. Restart WebLogic and all BI services after the OBIEE deployment is completed.

7. Log in to Analytics and navigate to Administration>Manage 
Privileges>WriteBack>Write Back to Database.

8. Click Denied:Authenticated User and select the permission Granted.

Enabling Auto Complete Feature on OBIEE 11.1.1.6.6
To enable auto complete feature on OBIEE, perform the following steps: 

1.  Navigate to the  path 
<Middleware_Home>\instances\instance1\config\OracleBIPresentationServicesCo 
mponent\coreapplication_obips1.

2. Take a backup of instanceconfig.xml. 

3. Open the file instanceconfig.xml.

4. Add the following lines in between the <ServerInstance> </ServerInstance>  tags. 

<Prompts> 

<MaxDropDownValues>256</MaxDropDownValues> 

<AutoApplyDashboardPromptValues>true</AutoApplyDashboardPromptValues> 

<AutoSearchPromptDialogBox>true</AutoSearchPromptDialogBox> 

<AutoCompletePromptDropDowns> 

<SupportAutoComplete>true</SupportAutoComplete> 

<CaseInsensitive>true</CaseInsensitive> 

<MatchingLevel>MatchAll</MatchingLevel> 

<ResultsLimit>50</ResultsLimit> 

</AutoCompletePromptDropDowns> 

</Prompts> 

5.  Save the changes. 
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6.  Restart the OBIEE opmn Services. 

7. Login to analytics http://<Server>:<port>/analytics

8. Click on the weblogic User (top most right section of the page). 

9. From the drop down menu select My Account. 

10. Set Prompt Auto Complete to ON and click OK.

OUASA Admin Tool Component
This is applicable only if the customer is installing Oracle Utilities Operational Device Extractor 
and Schema. 

After the installation, customer must set up the Admin Tool for ETL configuration. Refer to 
Chapter Installing the OUASA Admin Tool for complete details.

Also, refer to Oracle Utilities Advanced Spatial and Operational Analytics Administrator’s Guide for details. 

After the Installation
After the installation, perform the following steps: 

1. Verify the Install and Deploy Logs.

• MDL Import Logs

• <INSTALL_DIR>/OWB/MetadataFiles/SPL-BI-Project_imp.log

• <INSTALL_DIR>/OWB/MetadataFiles/SPL-BI-Location_imp.log

• OWB Deploy Logs

• <INSTALL_DIR>/logs/system/log_OWBDeployment_YYYYMMDD_####.txt

• Custom Mapviewer deploy Logs

• INSTALL_DIR>/logs/system/mapviewerdeploy.sh.log

• WriteBack Logs 
<INSTALL_DIR>/logs/system/Writeback.log

• FileProcessorDaemon Logs 
<INSTALL_DIR>/bin/FileProcessorDaemon.log

2. Log in to the OBIEE analytics link. Dashboard should display data with no errors.
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Chapter 7 
Demo Installation Procedure 

This chapter provides instructions for installing the demo database. 

Note: Demo installation does not support ETL functionality. ETL Job control 
dashboard accesses the OWB tables and demo dump does not have OWB 
objects; hence, ETL dashboard is not supported in demo installation. 

The chapter includes the following topics: 

• OUASA Database Component Installation

• OUASA Dashboard Component Installation

• After the Installation

OUASA Database Component Installation
This section describes how to install demo component of Oracle Utilities Advanced Spatial and 
Operational Analytics. The section includes the following:

• Copying and Decompressing Install Media

• Database Creation and Dump File Import

• Security Configuration

• Spatial Configuration

Copying and Decompressing Install Media
To copy and decompress the install media, follow these steps:

1. Download the Oracle Utilities Advanced Spatial and Operational Analytics V2.4.1 Demo 
Data part (Oracle Utilities Advanced Spatial and Operational Analytics V2.4.1 Demo 
Data.zip)from My Oracle Support (https://support.oracle.com/).

2. Create a temporary directory, such as c:\OUASA\temp or /OUASA/temp. (Referred to 
below as <TEMPDIR>) This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Advanced Spatial and Operational Analytics V2.4.1 Demo 
Data.zip to <TEMPDIR>. 

Database Creation and Dump File Import
Ensure that Oracle Database Server Enterprise Edition 11.2.0.3 is already installed on the machine 
in order to create database.
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• Use the Database Configuration Assistant (DBCA )utility to create the database as shown in 
section Database Creation Using DBCA.

Database Creation Using DBCA
For an initial installation database creation, it is recommended that you use the Database 
Configuration Assistant (DBCA) to create a data warehouse database with below-mentioned 
specifications:

1. Create a database with the AL32UTF8 character set. Set the open cursor limit to 3000 and 
processes to 1000 at the time of database creation.

2. After database creation, set the query_rewrite_enabled parameter to FORCE and the 
query_rewrite_integrity parameter to TRUSTED.

3. Connect to sys user and execute the following commands: 

alter system set query_rewrite_enabled=force;

alter system set query_rewrite_integrity=trusted;

4. Ensure to create the CISTS_01,REPOS_01 and STAGE_01 tablespaces in database if these 
are already not existing. These tablespaces are required to run the users.sql script. 

5. Ensure that the TEMP temporary tablespace exists in databases. If it does not exist, then 
create it. This tablespace is required to run the users.sql

6. Execute users.sql after connecting as sys user to database. 

Note: The users.sql script is located in BI241/Scripts/users.sql. This sql will 
create DWADM (Warehouse user), MASTER_REPO (ODI master repository 
user),WORK_REPO (ODI work repository user)  users with same username 
as password. If you want to change password for any user connect as sys user 
and change the password.

Import the Demo dump
Peform the following steps to import the demo dump: 

1. Create the dump_dir  directory in database.

2. You should also copy the exp_demo.dmp file to the dump_dir. Uncompress the 
exp_demo.dmp.gz file first to extract the exp_demo.dmp file. This file is in 
<TEMPDIR>\Demo directory.

3. Set the correct ORACLE_SID and ORACLE_HOME first and then run below command to 
import demo dump: 

impdp directory= dump_dir dumpfile= exp_demo.dmp logfile=    exp_demo.log 
schemas=DWADM

4. Provide the system as the user and system user's password when prompted.

Security Configuration
For Security Configuration, perform the following steps: 

1. Navigate to the ..\BI241\DWADM\Security folder.

2. Edit the file OraGenSec.bat, which is in the same location, and replace the parameter 
database-name with the name of your database. This file is provided for your convenience 
and executes the Oragensec.exe utility based on the parameters passed into it.
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Note: Ensure to run OraGenSec.bat from a Window 32-bit desktop that has 
the Oracle 11.2.0.2+32 bit client installed. Your database should already be 
listed in the local file tnsnames.ora.

The script executes as following:

oragensec -d DWADM,DWADM,database_name -r DW_READ,DW_USER -
a A -u

DWUSER,DWREAD

3. Execute the edited OraGenSec.bat file from command prompt.

Spatial Configuration
This section describes how to load spatial metadata in USER_SDO* tables for Oracle Utilities 
Advanced Spatial and Operational Analytics. 

Use the following procedure to load spatial metadata in the target database.

1. Create the dump_dir directory in database and copy user_sdo.dmp file from ../B1241/
Spatial-Metadata folder to that location.

2. Import released spatial tables to the target database using following command:

impdp directory=dump_dir dumpfile=user_sdo.dmp logfile=

imp_user_sdo.log schemas=DWADM

Note: Run this command from database server.

3. Review the imp_user_sdo.log file to ensure the tables were imported successfully.

4. After importing the tables, run following SQL scripts from the ../B1241/Spatial-Metadata 
folder:

- sqlplus dwadm/dwadm@database-name @copy_spatial_metadata.sql

- sqlplus dwadm/dwadm@database-name @clean_sdo_release_tbls.sql

5. Review the log files.

OUASA Dashboard Component Installation
This section describes how to install the dashboard component of Oracle Utilities Advanced 
Spatial and Operational Analytics. The section includes the following:

• Copying and Decompressing Install Media

• Setting Permissions for cistab File in UNIX

• OUASA Dashboard Package Installation Steps

• Post-installation Tasks

Copying and Decompressing Install Media
The Oracle Utilities Advanced Spatial and Operational Analytics Dashboard Component 
installation file is delivered in zip format for both UNIX and Windows platforms. If you plan to 
install multiple Oracle Utilities Advanced Spatial and Operational Analytics environments 
operated by different Oracle Utilities Administrator user IDs, you must complete each of the 
following installation steps for each Administrator user ID.

1. Download the Oracle Utilities Advanced Spatial and Operational Analytics V2.4.1 Dashboard 
Component part (Oracle Utilities Advanced Spatial and Operational Analytics V2.4.1 
Dashboard Component Multiplatform.zip)from My Oracle Support (https://
support.oracle.com/).
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2. Log in to the application server host (where OBIEE 11.1.1.6.6 software is installed) as the 
Oracle Utilities Advanced Spatial and Operational Analytics administrator user ID (default 
ceases).

3. Create a temporary directory, such as c:\OUASA\temp or /OUASA/temp. (Referred as 
<TEMPDIR> in step 4 below. This directory must be located outside any current working 
Oracle Utilities application environment. All files that are placed in this directory can be 
deleted after successful installation.

4. Unzip the Oracle Utilities Advanced Spatial and Operational Analytics V2.4.1 
Dashboard Component Multiplatform.zip to <TEMPDIR>

5. Decompress the file BI.OBIEE.V2.4.1-MultiPlatform.jar:

• cd <TEMPDIR>

• jar -xvf BI.OBIEE.V2.4.1-MultiPlatform.jar

You should have Java JDK installed on the machine used to (un)jar the OUASA dashboard 
component installation package. Install the JDK that is supported for the install on your platform 
to be able to use the jar command. 

The Java packages are located at: http://java.sun.com/products/archive/index.html

A sub-directory named "BI.OBIEE.V2.4.1" is created. It contains the installation software for the 
Oracle Utilities Advanced Spatial and Operational Analytics Dashboard Component.

Setting Permissions for cistab File in UNIX
Every Oracle Utilities Advanced Spatial and Operational Analytics environment installed on a 
server must be registered in the /etc/cistab file located on that server. On UNIX servers, generally 
only the root user ID has write permissions to the /etc directory. Since the installation process is 
run by the Oracle administrator user ID, this user ID may not be able to write to /etc/cistab table.

The install utility checks permissions and if it identifies a lack of the necessary permissions, it 
generates a script in the <TEMPDIR>/BI.OBIEE.V2.4.1 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Advanced Spatial and Operational Analytics application environment on the 
server) and registers a new environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Advanced 
Spatial and Operational Analytics administrator user ID, so that the next time a new environment 
is created by the same Oracle Utilities Advanced Spatial and Operational Analytics administrator 
user ID, you do not need to run the generated script with the root user ID. Instead, the install 
utility itself proceeds with the registration.

If you are reinstalling an existing environment, only the validation of /etc/cistab entry is done by 
the install utility, no new registration occurs. The install utility interactively instructs you about 
every step that needs to occur in each specific case.

If you plan to upgrade an existing environment it is your responsibility to take a backup prior to 
the installation process. The installation utility does not create a backup of existing environment.

OUASA Dashboard Package Installation Steps
Before you install verify that the steps mentioned in Prerequisite Software for OUASA 
Dashboard Component are followed. 

To install the OUASA dashboard package, perform these steps. 

1. Change to the <TEMPDIR>/BI.OBIEE.V2.4.1 directory.
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2. Set the ORACLE_CLIENT_HOME and PATH variables as Oracle Client Perl is required to 
run the installer.

3. Execute the following script: 
For UNIX: 
Perform the following steps: 

• export ORACLE_CLIENT_HOME=<oracle_client_home>

• export PERL_HOME=$ORACLE_CLIENT_HOME/perl

• export PATH=$PATH:$PERL_HOME/bin

• Run ksh ./install_OUBI.sh

       For Windows: 
       Perform the following steps; 

• set ORACLE_CLIENT_HOME=<ORACLE_HOME>

• set PERL_HOME=%ORACLE_CLIENT_HOME%\perl

• set PATH=%PERL_HOME%\bin;%PATH%

• Run Install_OUBI.cmd

Note: On UNIX, ensure that you have the proper execute permission on 
install.sh.

4. The Oracle Utilities Advanced Spatial and Operational Analytics specific menu appears.

5. Select the Each Menu Item to configure the values. For detailed description of the values 
see Configuration Worksheet for ETL Component based on OWB Installation.

Environment Installation Options 
1. Oracle Client Home Directory: 

2. Environment Mount Point: 

       Log Files Mount Point:  

       Environment Name: 

       Web Java Home Directory:  

Configure each item in the above list for successful installation. Choose the following options 
from the menu item (1,2, <P> Process, <X> Exit):

For detailed description of these values, see Configuration Worksheet for ETL Component 
based on OWB Installation.

Environment Configuration 
Perform the following: 

1. Environment Description

Environment Description:

2. OBIEE Environment Configuration

Oracle BI Instance Home:

Oracle BI Home:

Oracle BI Domain Home:

Weblogic Domain Console User Name:

Weblogic Domain Console Host:

Weblogic Domain Console Port Number
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Provide OBIEE Version Installed

3. Target Database Details

Target Database Name:                              

Target Database Host:                              

Target Database Port: 1521

DWADM Schema Name: DWADM

DWADM Schema Password:                            

Configure each item in the above list for a successful installation. Choose the following options 
from the menu item (1,2,3 <P> Process, <X> Exit):

4. When you are finished with the parameter setup, proceed with option P. Write to the 
Configure file.

5. Once installation is successful, execute the post-installation steps as described in the section 
Post-installation Tasks.

Post-installation Tasks
Following topics are discussed in this section: 

• Deploying Repository (RPD) File

• Configuring and Deploying MapViewer

• Deploying Write Back

• Deploying Analytics

Deploying Repository (RPD) File
The RPD file is located at: <install_dir>/Reports/rpd/UtilitiesBusinessAnalytics.rpd, where 
<install_dir> is the OUASA dashboard package installation directory.

To deploy the RPD file, perform these steps:

1. OBIEE 11.1.1.6.6 should have been installed on Windows 32-bit machine before proceeding 
with the steps below.

2. Launch the Administration Tool from your Start menu from the Windows machine. This is 
only available in Windows.

Start > Programs > Oracle Business Intelligence > Administration.

3. Open the RPD in offline mode by selecting File > Open > Offline...

4. Provide the RPD password. For example, “oracle123”.
Demo Installation Procedure 7-100 
Oracle Utilities Advanced Spatial and Operational Analytics Installation Guide



OUASA Dashboard Component Installation
5. Edit the connection pools shown below by double clicking on them.

6. In the Init Block Connection Pool group, enter the following:

Datasource name = BI Database name

User name = DWREAD

Password = DWREAD User password

7. In the Init Block Pool - MDM group, provide the following, only for MDM:

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

8. In the MDM Database Connection group, provide the following, only for MDM:

Data source name = MDM database name

User name = CISUSER

Password = CISUSER User password

9. In the ODIDEV Connection Pool group, provide the following:

Data source name = BI database name

User name = DWUSER

Password = DWUSER User password

10. In the OUBI Database Connection group, provide the following:

Data source name = BI database name

User name = DWREAD
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Password = DWREAD User password

11. Click Save.

12. Log in to the OBIEE Enterprise Manager console.

13. Navigate to BI Instance >Coreapplication>Deployment.

14. Lock and edit.

The repository text box is enabled.

15. Browse to the modified rpd file and submit. 

16. Provide the RPD password “oracle123” click Apply.

17. Activate the changes and then restart the BI Services.

Note: All the above databases set in the connection pool should be updated in 
tnsnames.ora file in <OBIEE_INSTALL_DIR>/Oracle_BI1/network/
admin.

Deploying the Web Catalog
To deploy the catalogs, follow these steps:

For UNIX:

Perform the following steps: 

1. Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

2. cd $SPLEBASE/bin

3. ksh ./deploycatalog.sh
Demo Installation Procedure 7-102 
Oracle Utilities Advanced Spatial and Operational Analytics Installation Guide



OUASA Dashboard Component Installation
4. Enter the physical catalogs location configured in Enterprise Manager. For 
example:<OBIEE_INSTALL_DIR>/instances/instance1/bifoundation/
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/SampleAppLite

For Windows:

Perform the following steps: 

1. Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

2. cd  %SPLEBASE%\bin

3. deploycatalog.cmd

4. Enter the Physical Catalogs location configured in EM. 
For example:<OBIEE_INSTALL_DIR>/instances/instance1/bifoundation/
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/SampleAppLite

Configuring and Deploying MapViewer
To configure and deploy the MapViewer, perform the following steps: 

1. Login to WebLogic console.

2. In the WebLogic console, create the 'MAP_DS' data source.

3. Lock and edit.

4. Navigate to Services < Data Sources.

5. Select New > Generic Data Source and provide the following:

Name = MAP_DS

JNDI Name = MAP_DS

Database Type = oracle

6. Click Next.

7. Enter the following:

Database Driver = XA thin database driver

8. Click Next.

9. Enter the following Connection properties:

Database Name:BI Database Name

Host Name:Database host

Port:Database port

Database User Name:dwadm

Password:dwadm password

10. Click Next and then click Finish.

11. Click Activate Changes.

12. Update the mapViewerConfig file with below mentioned tags:

File location : <OBIEE_INSTALL_DIR>/Oracle_BI1/bifoundation/jee/
mapviewer.ear/web.war/WEB-INF/conf/

File: mapViewerConfig.xml

13. If there is proxy used, insert the list of host names for all the third party service providers in 
the security_config node.
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<proxy_enabled_hosts>

elocation.oracle.com,maps.weatherbug.com,direct.weatherbug.com,api.wxbug.net,de.tiles.wea
therbug.com

</proxy_enabled_hosts>

14. Update the following ns_data_provider node:

<ns_data_providerid="obieeNsdp"

class="com.oracle.utilities.birdseye.BirdseyeNSDP" />

15. Update the current map_tile_server with the following map_tile_server node.

<map_tile_server>

<tile_storage default_root_path="/mytilecache/"/>

</map_tile_server>

16. Update the instance config file location, for example:

FileLocation:

For UNIX :

<OBIEE_INSTALL_DIR>/instances/instance1/config/
OracleBIPresentationServicesComponent/coreapplication_obips1

For Windows:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentationServicesCo
mponent\coreapplication_obips1

Modify instanceconfig.xml
Update the security Node with the following values. If the security Node is not present, add 
following code before </Serverinstance>:

<Security>
<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
<HttpOnlyCookies>false</HttpOnlyCookies>
<CookieDomain />
<CookiePath>/</CookiePath>
</Security>

Deploying Custom MapViewer
To deploy the custom MapViewer, follow these steps:

For Unix:

cd $SPLEBASE/bin

ksh ./deploymapviewer.sh

Enter the WebLogic Domain Console Password. For example, weblogic123

For Windows:

cd %SPLEBASE%\bin

deploymapviewer.cmd

Enter WebLogic Domain Console Password. For example, weblogic123
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Perform the following steps after deploying the custom MapViewer:

1. Update the MapViewer configuration by navigating to MapViewer > Administration > 
Configuration.

2. Add the below content in the mapViewerConfig.xml with appropriate values:

<DB_HOST>,<DBNAME>,<DB_PORT>,<USER>,<PASSWORD>

<map_data_source name="MAPCONN"

jdbc_host="<DB_HOST>"

jdbc_sid="<BI Database Name>"

jdbc_port="<DB_PORT>"

jdbc_user="<DWADM>"

jdbc_password="<!DWADM PASSWORD>"

jdbc_mode="thin"

number_of_mappers="32"

allow_jdbc_theme_based_foi="true"

/>

3. Save and then restart.

Note: The above step has to be performed every time you run the 
deploymapviewer command.

Deploying Write Back
Follow these steps to deploy the write back feature.

1. Open the following file:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentationServicesCo
mponent\coreapplication_obips\instanceconfig.xml

2. Update the following <ServerInstance> element according to the following code:

<LightWriteback>true</LightWriteback>

3. Deploy write back as follows:

For UNIX:

Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin

ksh ./deploywriteback.sh

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%/bin

deploywriteback.cmd

Deploying Analytics
To deploy analytics, follow these steps:
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OUASA Dashboard Component Installation
1. Edit the Presentation Services configuration file, "instanceconfig.xml", in the following 
directory:

<OBIEE_INSTALL_DIR>/instances/instance1/config/
OracleBIPresentationServicesComponent/coreapplication_obips1

2. Add the following before the end tag </ServerInstance>

<UI>

<DefaultStyle>oubi</DefaultStyle>

<DefaultSkin>oubi</DefaultSkin>

</UI>

Enabling Analytics Help
To enable the analytics' help, follow these steps:

1. Download Oracle Utilities Advanced Spatial and Operational Analytics User Guide from Oracle 
Software Delivery Cloud.

2. After downloading the OUASA User Guide, change the name of the Help file to OUASA 
Help.pdf.  
Now, place the Help file in <install_dir>/Skin/res, where <install_dir> is the OUASA 
dashboard package installation directory.

3. Run the following commands:

For UNIX:

• cd $SPLEBASE/bin

• ksh ./deployanalyticsear.sh

• Enter the WebLogic Domain Console Password. For example, weblogic123

For Windows:

• cd %SPLEBASE%/bin

• deployanalyticsear.cmd

• Enter the WebLogic Domain Console Password. For example, weblogic123

4. Restart the BI Core services.

5. Restart WebLogic and all BI services after the OBIEE deployment is completed.

6. Login to Analytics and navigate to Administration > Manage Privileges > Write Back > 
Write Back to Database.

7. Click Denied:Authenticated User and select the permission Granted.

Enabling auto complete feature on OBIEE 11.1.1.6  
Perform the following steps: 

1. Navigate to the path 
<Middleware_Home>\instances\instance1\config\OracleBIPresentationServicesCompone
nt\coreapplication_obips1 

2. Take a backup of instanceconfig.xml. 

3. Open the file instanceconfig.xml. 

4. Add the following lines in between the <ServerInstance> </ServerInstance> tags 

<Prompts> 
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<MaxDropDownValues>256</MaxDropDownValues> 

<AutoApplyDashboardPromptValues>true</AutoApplyDashboardPromptValues> 

<AutoSearchPromptDialogBox>true</AutoSearchPromptDialogBox> 

<AutoCompletePromptDropDowns> 

<SupportAutoComplete>true</SupportAutoComplete> 

<CaseInsensitive>true</CaseInsensitive> 

<MatchingLevel>MatchAll</MatchingLevel> 

<ResultsLimit>50</ResultsLimit> 

</AutoCompletePromptDropDowns> 

</Prompts> 

5. Save the changes. 

6. Restart the OBIEE opmn Services. 

7. Log in to the Analytics: http://<Server>:<port>/analytics

8. Click on the weblogic User (top right pane of page). 

9. From the drop down menu, select My Account. 

10. Set Prompt Auto Complete to ON and click OK.

After the Installation 
After the installation, perform the following: 

1. Verify Install and Deploy Logs.

Custom Mapviewer deploy logs

<INSTALL_DIR>/logs/system/mapviewerdeploy.sh.log

WriteBack logs

<INSTALL_DIR>/logs/system/Writeback.log

2. Log in to the OBIEE analytics link that is pointing to the demo database. Dashboard should 
display the data with no errors.
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Chapter 8 
Configuring Your Applications

This chapter provides instructions for configuring additional applications for use with Oracle 
Utilities Advanced Spatial and Operational Analytics. It contains the following topics:

• Spatial Configuration

• OBIEE Configuration

Spatial Configuration
This section contains information related to configuring Oracle Utilities Advanced Spatial Outage 
Analytics and how to set up the spatial data and its corresponding metadata. The mapping 
between the spatial columns and the dimensional columns like State from Address dimension 
would be defined in map meta data that is available as a part of the WebCatalog. Using the spatial 
data and the map meta data, users can view the transactional data on the map view.

As an example, steps to setup the data for United States (US) are mentioned below: 

• Installing US State Spatial Data

• Installing US City Spatial Data

• Installing US Zip Code Spatial Data

• Installing US County Spatial Data

• Configuring NMS Device Spatial Data

• Loading Spatial Metadata

• Improving Performance by Prefetching Map Tiles

Installing US State Spatial Data
Spatial data can be loaded from various sources. One of the approaches is to use the world sample 
data given by Navteq. There is a pointer to the data set from the Oracle Spatial OTN page for 
downloading Partner data:

http://www.oracle.com/technetwork/database-options/spatialandgraph/downloads/index.html

There are various versions of the world sample dataset. These instructions assume that you are 
using the version with a world_sample2010.dmp file. If you have a different version, then these 
instructions may not work and you should refer to the README included in the downloaded 
world_sample.zip file.

These instructions also assume that the sample data will be loaded into the DWADM account, 
used for the Data Warehouse. If you want to follow the instructions in the world sample 
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README file instead, then the data will be loaded into a WORLD_SAMPLE account, and steps 
will need to be changed to use that account instead of DWADM.

Use the following procedure to install the world sample data.

1. Create a work directory on your machine for the data, and change directory to the new 
directory. For example: 

mkdir NAVTEQ 
cd NAVTEQ

2. Unzip the world_sample.zip file you downloaded to the new directory. For example: 

unzip world_sample.zip 

3. Connect to SQLPLUS using DWADM, and remove the old tables (if present). For example: 

sqlplus dwadm/dwadm@database @cln_sample_data.sql 

4. Import the world sample dump file into the DWADM account. For example: 

imp dwadm/dwadm@database file=world_sample2010.dmp 
 log=world_sample.log full=y

5. After importing the world sample dump file, create the MapViewer Spatial metadata using the 
following insert statements: 

sqlplus  dwadm/dwadm@database
INSERT INTO user_sdo_maps SELECT * FROM sdo_maps;
INSERT INTO user_sdo_themes SELECT * FROM sdo_themes;
INSERT INTO user_sdo_styles SELECT * FROM sdo_styles;
INSERT INTO user_sdo_cached_maps SELECT * FROM sdo_cached_maps;

6. Create the State spatial table and metadata are used by the default themes present in the 
OUASA metadata. This assumes that the eLocation web site is being used as the base map. If 
some other base map is used, then the transform parameter will need to specify the SRID of 
the base map being used.

sqlplus  dwadm/dwadm@database
create table q1_states54004 (

      feature_id number,
      feature_name varchar2(255),
      area_id number,
      name_langcode varchar2(35),
      feature_type varchar2(30),
      country_code_3 varchar2(5),
      geometry SDO_GEOMETRY,
      carto_id number(10,0));

insert into q1_states54004
select null, name, null, lang_code, feature_type,

       ISO_COUNTRY_CODE, sdo_cs.transform(geometry, 54004), 
       carto_id

FROM wom_area
WHERE feature_type = 909996

  and iso_country_code = 'USA';

INSERT INTO user_sdo_geom_metadata
VALUES ( 'Q1_STATES54004','GEOMETRY',
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)), 54004);
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create index q1_STATES54004_sdx 
    on q1_STATES54004(geometry) 
    indextype is mdsys.spatial_index;

Installing US City Spatial Data
US City shape data is available in the world sample data set, however, only the three hundred 
largest cities are available there. To find additional sample data for each US State from the US 
Census Bureau, visit and search within the Census site:

http://www.census.gov/

The following steps can be used to load the sample data for the state of Ohio, and similar steps 
can be followed to load city data for other US states.

1. Click the Ohio Zip Code in Shapefile format and download the zt39_d00_shp.zip file to the 
NAVTEQ directory created in the previous procedure. 

2. Unzip or decompress the pl39_d00_shp.zip file to the NAVTEQ directory. 

3. Download standalone MapBuilder from this location:  
http://www.oracle.com/technetwork/middleware/mapviewer/downloads/index-
100641.html 

4. Start MapBuilder. This is installed when MapViewer is installed. On windows it can be started 
by running:  
java -jar mapbuilder.jar 
Refer to the MapViewer documentation for instructions on installing and running 
MapBuilder from this location: 
   http://www.oracle.com/technetwork/middleware/mapviewer/documentation/index.html  

5. If a connection is not created, then select File -> New Connection, and create a connection 
to the DWADM account in the OUBI Data Warehouse Database. 

6. Select Tools -> Import Shapefile, and click Next. 

7. Click Shapefile. 

8. Browse to the C:\NAVTEQ directory, select the pl39_d00_shp.shp file, and click Open. 

9. Click Next. 

Note: Ensure that the name of the geometry table is set to pl39_d00. If this is 
not the desired name for the spatial table, then the select statement below will 
need to be changed to use the entered name. 

10. Ensure the Create Predefined Theme box is unchecked, and click Next. 

11. Review the Summary information and click Finish. 
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12. Create the Q1_CITY54004 table using the following SQL statement. This assumes that the 
eLocation web site is being used as the base map. If some other base map is used, then the 
transform parameter will need to specify the SRID of the base map being used.

sqlplus  dwadm/dwadm@database
create table Q1_CITY54004 as
select upper(name) FEATURE_NAME,

       sdo_cs.transform(geometry, 54004) geometry,
       'OHIO' state

From pl39_d00
Where lsad_trans in ( 'city', 'village' );

INSERT INTO user_sdo_geom_metadata
VALUES ( 'Q1_CITY54004','GEOMETRY',
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)), 54004);

create index Q1_CITY54004_sdx 
    on Q1_CITY54004 (geometry) 
    indextype is mdsys.spatial_index;

UPDATE q1_city54004
  SET geometry = SDO_UTIL.RECTIFY_GEOMETRY(geometry, .05);

Installing US Zip Code Spatial Data
Sample shape files for US Zip Code Areas can be found at the following location:

http://www.census.gov/

The following steps can be used to load the sample data for the state of Ohio, and similar steps 
can be followed to load zip code data for other US states.

1. Click on the Ohio Zip Code in Shapefile format and download the zt39_d00_shp.zip file to 
the NAVTEQ directory created in the previous procedure. 

2. Unzip the zt39_d00_shp.zip file to the NAVTEQ directory. 

3. Start MapBuilder. This is installed when MapViewer is installed. Refer to the MapViewer 
documentation for instructions on installing and running MapBuilder.
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4. If a connection is not created, then select File > New Connection, and create a connection 
to the DWADM account in the OUBI Data Warehouse Database. 

5. Select Tools > Import Shapefile and click Next. 

6. Click Shapefile. 

7. Navigate to the C:\NAVTEQ directory, select the zt39_d00.shp file, and click Open. 

8. Click Next. 

Note: Ensure the name of the geometry table is set to ZT39_D00. If this is not 
the desired name for the spatial table, then the select statement below will need 
to be changed to use the entered name.  

9. Ensure the Create Predefined Theme box is unchecked, and click Next. 

10. Review the Summary information and click Finish. 

11. Create the Q1_USZIP54004 table using the following SQL statement. This assumes that the 
eLocation web site is being used as the base map.  If some other base map is used, then the 
transform parameter will need to specify the SRID of the base map being used.

sqlplus  dwadm/dwadm@database

create table q1_USZIP54004 as

select zcta ZCTA5CE,
       sdo_cs.transform(geometry, 54004) geom

From ZT39_D00;

INSERT INTO user_sdo_geom_metadata
VALUES ( 'Q1_USZIP54004','GEOM',
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)), 54004);

create index q1_USZIP54004_sdx 
    on q1_USZIP54004 (geom) 
    indextype is mdsys.spatial_index;

UPDATE q1_uszip54004
  SET geom = SDO_UTIL.RECTIFY_GEOMETRY(geom, .05);

Installing US County Spatial Data
Sample shape files for US Counties can be found at the following location:

 http://www.census.gov/

The following steps can be used to load the sample data for the state of Ohio, and similar steps 
can be followed to load county data for other US states.

1. Click on the Ohio County in Shapefile format and download the co39_d00_shp.zip file to the 
NAVTEQ directory created in the previous procedure. 

2. Unzip the co39_d00_shp.zip file to the NAVTEQ directory. 

3. Start MapBuilder. This is installed when MapViewer is installed. Refer to MapViewer 
documentation for instructions on installing and running MapBuilder.

4. If a connection is not created, then select File > New Connection, and create a connection 
to the DWADM account in the OUBI Data Warehouse Database. 

5. Select Tools > Import Shapefile, and click Next. 

6. Click Shapefile. 
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7. Browse to the C:\NAVTEQ directory, select the co39_d00_shp.shp file, and click Open. 

8. Click Next. 

Note: Ensure the name of the geometry table is set to CO39_D00. If this is 
not the desired name for the spatial table, then the select statement below will 
need to be changed to use the entered name.

9. Ensure the Create Predefined Theme box is unchecked, and click Next. 

10. Review the Summary information and click Finish. 

11. Create the Q1_COUNTY54004 table using the following SQL statement. This assumes that 
the eLocation web site is being used as the base map. If some other base map is used, then the 
transform parameter will need to specify the SRID of the base map being used.

sqlplus  dwadm/dwadm@database

create table q1_COUNTY54004 as
select name FEATURE_NAME,

       sdo_cs.transform(geometry, 54004) geometry,
       'OHIO' state

From CO39_D00;

INSERT INTO user_sdo_geom_metadata
VALUES ( 'Q1_COUNTY54004','GEOMETRY',
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)), 54004);

create index q1_COUNTY54004_sdx 
    on q1_county54004 (geometry) 
    indextype is mdsys.spatial_index;
10-113 Oracle Utilities Advanced Spatial and Operational Analytics Installation Guide



UPDATE q1_county54004
  SET geometry = SDO_UTIL.RECTIFY_GEOMETRY(geometry, .05);

Note: No predefined reports make use of the County data, so if county spatial 
reports are desired, the Q1_COUNTY_54004 theme will need to be used in 
new requests and maps.

Configuring NMS Device Spatial Data
To implement the NMS Network Model on the spatial analytics, OUASA reports need NMS 
geometry data. The steps from this section are required to view data in spatial reports of Outage 
Analytics. There are several ways that the geometry data in the DIAGRAM_OBJECTS NMS 
device table can be accessed by the OUASA Mapping reports. 

This section describes the following methods:

• Replicating the DIAGRAM_OBJECTS Table

• Accessing the NMS Spatial Data Using a Database Link

Replicating the DIAGRAM_OBJECTS Table
The easiest option is to replicate the DIAGRAM_OBJECTS table into the OUASA database. If 
this is done, then after replicating the DIAGRAM_OBJECTS table, the following steps will setup 
the OUASA dashboards to use the data in this replicated table.

1. Create the required Spatial Metadata:

INSERT INTO user_sdo_geom_metadata 
VALUES ( 'DIAGRAM_OBJECTS','LL_GEOMETRY',

MDSYS.SDO_DIM_ARRAY(
        SDO_DIM_ELEMENT('X', -20037508, 20037508, .05),
        SDO_DIM_ELEMENT('Y', -45884542, 45884542, .05)
), 54004);

2. Ensure that the spatial index is created on the LL_GEOMETRY column. The 
LL_GEOMETRY column by default stores spatial data using SRID 54004, so this will work 
without changes with the eLocation base map:

create index q1_DIAGRAM_OBJECTS_sdx 
    on diagram_objects (ll_geometry) 
    indextype is mdsys.spatial_index;

3. In MapBuilder, use duplicate to create a copy of the B1_THEME_DIAGRAMOBJ_54004 
Geometry Theme, with the following settings:

• New Name: Q1_THEME_DIAGRAMOBJ_54004

• Target Database: OUASA Database

• Base Table: DIAGRAM_OBJECTS

• Spatial Column: LL_GEOMETRY

Once DIAGRAM_OBJECTS table is replicated to the OUASA database, follow the below steps 
to create Q1_DIAGRAM_OBJECTS_54004 table:

1. Connect to DWADM schema of OUASA database and execute "create table 
Q1_DIAGRAM_OBJECTS_54004 as select * from DIAGRAM_OBJECTS;"

2. INSERT INTO user_sdo_geom_metadata 
VALUES ( 'Q1_DIAGRAM_OBJECTS_54004','LL_GEOMETRY', 
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MDSYS.SDO_DIM_ARRAY(SDO_DIM_ELEMENT('X', -20037508, 20037508, 
.05),SDO_DIM_ELEMENT('Y', -45884542, 45884542, .05)), 54004);

3. Create index q1_DIAGRAM_OBJECTS_sdx_54004 on Q1_DIAGRAM_OBJECTS_54004 
(ll_geometry) indextype is mdsys.spatial_index;

Accessing the NMS Spatial Data Using a Database Link
If it is not possible to replicate the DIAGRAM_OBJECTS table, and no existing NMS Geometry 
theme can be used, then it is possible to access the DIAGRAM_OBJECTS table in the OUASA 
database using a database link. 

To access the DIAGRAM_OBJECTS table in the OUASA database using a database link:

1. Create a database link in the OUASA database pointing to the NMS database.

2. Create a synonym DIAGRAM_OBJECTS for the DIAGRAM_OBJECTS table in the NMS 
database.

3. Update the mapViewerConfig.xml to add another datasource, pointing to the NMS database, 
just like the OUASA datasource was added earlier in the install documentation

4. Restart WebLogic to make the NMS database available.

5. Create the required Spatial Metadata in the OUASA database:

INSERT INTO user_sdo_geom_metadata 
VALUES ( 'DIAGRAM_OBJECTS','LL_GEOMETRY',

MDSYS.SDO_DIM_ARRAY(
   MDSYS.SDO_DIM_ELEMENT('LONGITUDE',-180,180,0.05),
   MDSYS.SDO_DIM_ELEMENT('LATITUDE',-90,90,0.05)
), 54004);

6. In MapBuilder, use duplicate to create a copy of the B1_THEME_DIAGRAMOBJ_54004 
Geometry Theme, with the following settings:

• New Name: Q1_THEME_DIAGRAMOBJ_54004

• Target Database: OUASA Database

• Base Table: DIAGRAM_OBJECTS

• Spatial Column: LL_GEOMETRY

Loading Spatial Metadata
This section describes how to load spatial metadata in USER_SDO* tables for Oracle Utilities 
Oracle Utilities Advanced Spatial Operational Analytics. 

Use the following procedure to load spatial metadata in the target database.

1. Create the dump_dir directory in database and copy user_sdo.dmp file from ../B1241/
Spatial-Metadata folder to that location. 

2. Import released spatial tables to the target database using following command:

impdp directory=dump_dir dumpfile=user_sdo.dmp logfile=  
    imp_user_sdo.log  schemas=DWADM

Note: Run this command from database server.

3. Review the imp_user_sdo.log file to ensure the tables were imported successfully.

4. After importing the tables, run following SQL scripts from the ../B1240/Spatial-Metadata 
folder:

- sqlplus dwadm/dwadm@database-name @copy_spatial_metadata.sql

- sqlplus dwadm/dwadm@database-name @clean_sdo_release_tbls.sql
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5. Review the log files.

Flushing Map Cache
Before you can begin using the modified base map, you must flush the map cache as follows:

1. In the MapViewer Console, click Admin in the top-right corner of the page and log in to the 
Admin Console page.

2. Click Management, select Manage MapViewer, and then select Datasources.

3. Click Purge cached metadata.

4. To verify the map changes, go to the Map zone that references the modified base map.

5.  Delete the 'cacheduserinfo' files in the following path to remove any cache:

<OBIEE_INSTALL_DIR>\instances\instance2\bifoundation\OracleBIPresentationServi
cesComponent\coreapplication_obips1\catalog\SampleAppLite\root\users\weblogic2
\_prefs

Improving Performance by Prefetching Map Tiles 
Rendering map tiles dynamically can affect system performance. To avoid this you should 
consider prefetching tiles by issuing an admin request to MapViewer on a non-production 
server or when the server is not under load. When MapViewer receives a prefetching request, 
it issues many concurrent map tile requests to itself, which are basically XML map requests, 
and stores them in the cache. This improves the system’s performance as the images are 
readily available.

Follow the following procedure to prefetch map tiles.

1. In the MapViewer Console, click Admin in the top-right corner of the page and log in to the 
Admin Console page.

2. In the Admin Console page, click Manage Map Tile Layers.

3. Click Manage to display the list of existing map tiles.

4. Select the required map tile and click View map/Manage Tiles.

The Prefetching wizard opens:
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5. Enter the X, Y coordinates of the center of the map, and the SRID and Zoom Level, and 
click Show Map. 

To prefetch map images, you need to enter the latitude and longitude values. A client needs to 
know the latitude and longitude values of the center of the location in interest. SRID is a 
unique value used to identify the coordinate system used in a GIS application. The SRID used 
is 8307. 

The X and Y axis used in the following example is for Canton, Ohio:

6. When you see the map, turn on the Area Selection Tool and select the area on the map for 
which you want to prefetch the tiles.

7. Select one or more zoom-levels for which you want to prefetch the tiles.

8. Under Tile Operations, click on Prefetch Tiles.

This process will take some time, depending upon the hardware configuration of the system and 
the amount of data to be prefetched. To check the current status of the operation, click Refresh 
under Operation Status. The status will change to “Finished” when the operation is done.

OBIEE Configuration
This section contains information about configuring Oracle Business Intelligence Enterprise 
Edition (OBIEE) for use with Oracle Utilities Advance Spatial and Operational Analytics. 
Following topics are discussed: 
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• Setting Up and Configuring User Security

• Managing Content in the Presentation Catalog

Setting Up and Configuring User Security
Refer to the Configuring User Security section in the Oracle Utilities Advanced Spatial and Operational 
Analytics Administrator's Guide for details on configuring user security.
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Managing Content in the Presentation Catalog
Oracle Utilities Advanced Spatial and Operational Analytics v2.4.1 Presentation Catalog has a 
different folder for each of the analytics.

The following folders are available on the Shared Folders:

• About

• Administration

• Common

• Credit & Collections Analytics

• Customer analytics

• Distribution Analytics

• Meter Data Analytics

• Mobile Workforce Analytics

• Outage Analytics

• Revenue Analytics

• Shared Objects

• Work & Asset Analytics

• Operational Device Analytics

For more information on User Security and Managing Catalog objects, refer to the Oracle Business 
Intelligence Presentation Services Administration Guide.

Managing Folders and Content 
New folders can be created by the customer if new Answers or modifications to existing ones are 
needed.

To create new folders (or Development Folders), log on to the Presentation Services as an 
Administrator and access:

Catalog -> New Folder

Once a new folder is created, the following values can be set:

• Properties

• Name 

• Delete

• Permissions

• Copy/Move

The customer can save new Answers onto the development folders, thereby leaving the out-ofbox 
folders as is. Once the Answer is created, the report is written and unit testing is complete, the 
request can be moved to the common folder.

Default folders are loaded during the install of OBIEE. These folder, such as 00 Overview, 01 
Ranks & Toppers, or 02 History & Benching, can be removed from view by navigating to Catalog, 
and then deleting the dashboards that you do not want displayed from the list.

Editing Names and Descriptions of Objects 
To edit names and descriptions of objects, log on to the Presentation Services as an Administrator 
and access:
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Catalog > Shared Folders
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Chapter 9 
Installing the OUASA Admin Tool

This chapter describes how to install the Admin Tool for the Oracle Data Integrator (ODI) 
configuration.

Perform the steps below to install apex run time and deploy the admin tool for ODI 
configuration: 

Installing Admin Tool

1. Download apex_4.2.1.zip file from : 
http://www.oracle.com/technology/products/database/application_express/
download.html

2. Unzip apex_4.2.1.zip to directory <APEX_UNZIPPEDPATH>

3. Change directory to <APEX_UNZIPPEDPATH>/apex after unzipping apex_4.2.1.zip file.

4. Logon using sqlplus as sys user and run the sql file apxrtins.sql with parameters as shown 
below: 

@apxrtins CISTS_01 CISTS_01 TEMP /i/

5. Change password of admin account by running the following sql command : 

@apxchpwd

6. Restart database

7. Configure the embedded PL/SQL gateway - logon as sys user and run : 

@apex_epg_config  <APEX_UNZIPPEDPATH>

8. Unlock the anonymous account: 

ALTER USER ANONYMOUS ACCOUNT UNLOCK;

9. Start the XML DB run:

EXEC DBMS_XDB.SETHTTPPORT(<not in use port>);

e.g EXEC DBMS_XDB.SETHTTPPORT(8080);

10. Verify using: 

SELECT DBMS_XDB.GETHTTPPORT FROM DUAL;

11. Import the admin tool for ODI configuration:

• Oracle Utilities Advanced Spatial and Operational Analytics V2.4.1 ETL Component 
Based on ODI Multiplatform.zip file has a folder called AdminTool

• Unzip this file and copy the AdminTool directory contents.
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• Create the ../AdminTool directory on the database server and copy the contents of 
AdminTool directory (from the zip file) to this directory.

• Go to the ../AdminTool directory, i.e., cd ../AdminTool

• Please connect as system user and execute the following scripts:

• Create workspace and Configure users: 

• @CreateAppWorkspace.sql

• Import application: 

• @DeployAdminApp.sql

• Import Images: 

@DeployAdminAppImages.sql

12. Admin tool for ODI configuration can be accessed using the URL 
http://<hostname>:8080/apex/f?p=104

Note: Refer to the Oracle Utilities Advanced Spatial and Operational Analytics 
Administration Guide for a complete description of Admin Tool for the Oracle 
Data Integrator (ODI) configuration.
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Appendix A
Data Warehouse Implementation Guidelines

This chapter provides guidelines for implementing the data warehouse setup for Oracle Utilities 
Advanced Spatial and Operational Analytics. 

The following sections are discussed in detail:

• Init.ora Settings

• Oracle Partitioning

Init.ora Settings
Internal performance testing for a large Business Intelligence (BI) database installation has 
identified the following parameter settings that resulted in a fast load and materialized view refresh 
for a fact table with over 100,000,000 records.

Note that the settings mentioned in the below table were noticed for an Oracle 10.2 database 
running on an IBM AIX 5.2 machine with 8 CPUs and 15 GB of memory; hence, some of these 
values may not apply for different hardware or software settings.

Parameter Value

db_file_multiblock_read_count 32

db_cache_size 0M

shared_pool_size 0M

large_pool_size 0M

Java_pool_size 0M

parallel_max_servers 8

parallel_execution_message_size 65535

log_buffer 64554432

Pga_aggregate_target 2000M

query_rewrite_enabled FORCE

query_rewrite_integrity TRUSTED

session_cached_cursors 60

optimizer_index_caching 80
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Oracle Partitioning
Oracle Partitioning
As the primary keys for all tables are sequential, it is possible to partition any table based on the 
primary key field. However, the Fact tables should be partitioned based on one of the Date Keys 
present in the table. Some of the date keys are optional; hence, it is important to pick a date key 
field that will always have a non-zero value.

Note that as the RECENT fact table needs to be purged daily, it does not require to be 
partitioned. Also, partitioning should be done only when materialized views do not prove 
sufficient enough to achieve the desired performance. 

For details on partitioning, refer to the Oracle Utilities Advanced Spatial and Operational Analytics 
Admininstrator’s Guide. 

optimizer_index_cost_adj 30

Sga_max_size 4000M

Sga_target 2000M

shared_pool_reserved_size 64M

workarea_size_policy AUTO

db_writer_processes 8

timed_statistics False

cursor_space_for_time True

Disk_asynch_io True

Parameter Value
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Appendix B
Installation Menu Functionality

This chapter provides functionality details regarding installation menu for installing the Oracle 
Utilities Advanced Spatial and Operational Analytics application. 

The following sections are discussed here:

• Installation Menu Functionality Overview

• Installation Menu Functionality Details
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Installation Menu Functionality Details
Installation Menu Functionality Overview
The main configuration menu is structured so that related variables and/or options are grouped 
together and are associated by a menu item number. To access a particular group of variables and 
options, enter the menu item number associated with that group. Each option within a group is 
displayed in turn on the screen along with a prompt so that you can type the desired value for the 
option, if it is not the same as the default or current value.

When performing the initial installation, you need to go through all menu options. The menu 
options may have a default value, a list of valid values, and a validation check.

On each option prompt, you can keep the current value by simply leaving the input line empty. In 
order to erase a variable value, you need to enter a single dot ("."). The leading spaces are trimmed 
out on each values that are entered.

Note: While working with the menu, you will notice the following:

• Valid Values: [ALFANUM]. This indicates you will need to enter an alphanumeric value 
in the prompt.

• Valid Values: [NUM]. This indicates you will need to enter an numeric value in the 
prompt.

When all the menu options are set, type <P> at the main menu prompt option. The option values 
selected throughout the configuration are saved. 

During this processing, the global variables are validated and the configuration file 
<SPLEBASE>/etc/ENVIRON.INI is created or updated. This file contains all the variables 
inputted and calculated. These are required by the next part of the installation process.

To exit the configuration utility without saving any of the values entered, type <X> and click 
Enter. 

Installation Menu Functionality Details
The Environment Installation Utility requires that Oracle Client Home is set in the path for the 
user performing the installation. Prior to running the installation utility, you must review the 
supported platforms document to ensure that you have all  the required Third-Party software 
installed at your end. In the Installation menu if the variables are set prior to execution, then these 
variable values will be defaulted by the installation utility during installation.

When installation completes successfully, the values will be written to an ENVIRON.INI file. 
When splenviron.sh / cmd is executed, it reads from the ENVIRON.INI file to set the 
environment variables.

In the worksheets, there are three different types of values given:

• Default Values: Values, which can be defaulted while running the installation utility.

• Security Values: Values, which should be changed when in production.

• Example Values: Values, which can be used for a default installation.

Note: The production environment should not be run with default values.

Refer to the Server Administration Guide for additional information about configuring these values.

When you enter passwords, you cannot see password characters on the screen as they are entered 
in silent mode. Passwords are encrypted when the values are entered by a user.

Install the Oracle Client software specified in chapter System Requirements and Supported 
Platforms prior to running any installation utilities. 

The following prompt appears when executing the installation utility:

Enter Oracle Client Home Directory (<ENTER> quit):
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Installation Menu Functionality Details
Note: If the environmental variable ORACLE_CLIENT_HOME is set, then 
the install script validates the variable. If it passes the validation, you will not be 
prompted for it. This is needed in order to run Perl installation utilities.
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Appendix C
Installation and Configuration Worksheets

This chapter provides the installation and configuration worksheets for Oracle Utilities Advanced 
Spatial and Operational Analytics. 

Following topics are discussed: 

• Configuration Worksheet for ETL Component based on OWB Installation

• Configuration Worksheet for ETL Component based on ODI Installation

• Configuration Worksheet for Dashboard Component Installation
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Configuration Worksheet for ETL Component based on OWB Installation
Configuration Worksheet for ETL Component based on OWB 
Installation

Environment installation options are as shown in the section  below:

• Environment Installation Options

• Environment Configuration Options
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Configuration Worksheet for ETL Component based on OWB Installation
Environment Installation Options

Menu Option Name Used In 
Documentation Usage

Customer 
Install 
Value

Oracle Client 
Home Directory

ORACLE_CLIENT_H OME The home directory 
of the Oracle Client. 
The application will 
use the Perl included 
under this Oracle 
Client.
Example Location:
/oracle/client/
product/11.2.0.3

Environment 
Mount Point

<SPLDIR> The mount point 
into which the 
application is 
installed. 
Local directory 
Where components 
to be installed.
For example:
/OUASA for UNIX 
and C:\OUASA for 
Windows 

This mount point 
must exist and the 
administrator user ID 
must be able to write 
to this directory. 
(This is the user ID 
that is created 
specifically to 
administer the  
environments; the 
installation sets 
permissions on all 
subdirectories 
installed under this 
directory.
See 
<SPLENVIRON> 
below for more 
information on how 
this mount point is 
used.
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Configuration Worksheet for ETL Component based on OWB Installation
Environment Configuration Options
Following topics are discussed in this section: 

• Environment Description

• Database Configuration

• Design Repository Configuration

•  EMAIL Configuration

• Control Center Configuration

• External Data Source Configuration

Log File Mount 
Point

<SPLDIROUT> A mount point that 
will contain any 
application output or 
application logs. 
Example value is /
OUASA/sploutput 
for UNIX installation 
or 
C:\OUASA\sploutp
ut for Windows

Environment 
Name

<SPLENVIRON> A descriptive name 
to be used as both a 
directory name under 
the mount point
<SPLDIR> and an 
environment 
descriptor. This value 
typically identifies the 
purpose of the 
environment. For 
example, DEV01 or 
CONV

Web Java Home 
Directory

JAVA_HOME The location on the 
disk where Java 1.6 is 
installed. 
For example:
$ORACLE_BI_HO
ME/jdk

Menu Option Name Used In 
Documentation Usage

Customer 
Install 
Value
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Configuration Worksheet for ETL Component based on OWB Installation
Environment Description
Environment description details are as shown in the table below: 

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Environment 
Description

DESC This is a free form 
text field to describe 
the purpose of the 
environment.
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Configuration Worksheet for ETL Component based on OWB Installation
Database Configuration

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

OWB WorkSpace 
Owner

OWB_WS_OWNER OWB workspace Owner 
that is created in section 
Creating and 
Configuring Oracle 
Warehouse Builder 
Workspace for an 
Initial Installation.

BIREPOWN

OWB WorkSpace 
Owner Password

OWB_WS_OWNER_
PASS

OWB workspace Owner 
Password that is created 
in Creating and 
Configuring Oracle 
Warehouse Builder 
Workspace for an 
Initial Installation.

The password to login 
to Oracle warehouse 
Builder design center.

This is a Security Value.

BIREPOWN

Database Name OBIEE_DBNAME The name of the 
database instance that 
the application will be 
connecting to.

BI Database Name

Database Server OBIEE_DBSERVER Host name of the server 
where database resides.

BI Database Server

Database Port OBIEE_DBPORT Database port number 
on the database server 
used for connecting to 
the database

BI Database PORT
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Configuration Worksheet for ETL Component based on OWB Installation
Design Repository Configuration

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

OWB WorkSpace 
User

OWB_WS_USER OWB workspace 
User that is created 
in Creating and 
Configuring 
Oracle 
Warehouse 
Builder 
Workspace for an 
Initial 
Installation.
The User to login 
to Oracle 
warehouse Builder 
design Control 
center.

BIREPO

OWB Workspace 
user Password

OWB_WS_PASS OWB workspace 
User Password that 
is created in 
Creating and 
Configuring 
Oracle 
Warehouse 
Builder 
Workspace for an 
Initial 
Installation.

The password to 
login to Oracle 
warehouse Builder 
design Control 
center.

This is a Security 
Value.

BIREPO

OWB WorkSpace 
Name

OWB_WS_NAM
E

The name of the 
Workspace created 
using Repository 
Assistant

SPLBIREP

DWADM 
SCHEMA NAME

DWADM_SCHE
MA

The user ID to 
Register OWB 
locations

DWADM

DWADM 
SCHEMA 
Password

DWADM_PASS The password to 
Register OWB 
locations

DWADM

WORKFLOW 
MANAGER 
SCHEMA NAME

OWFMGR_SCHE
MA

The user ID to 
Register OWB 
locations

OWFMGR
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Configuration Worksheet for ETL Component based on OWB Installation
WORKFLOW 
MANAGER 
SCHEMA 
Password

OWFMGR_PASS The password to 
Register OWB 
locations

OWFMGR

Menu Option Name Used In 
Documentation Usage Customer Install 

Value
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Configuration Worksheet for ETL Component based on OWB Installation
Database Character Set Configuration

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Database Character set DBCS Database character Set 
to used to create the 
database

AL32UTF8

Editing Process Flow Configuration

Menu Option Name Used In 
Documentation Usage

Customer 
Install 
Value

Repository Operating 
System

REPOPSYS Database operating 
system, for example, 
Win or Linux (any other 
platform)

Valid Values are as listed: 
• Win: windows

• Linux: for any non 
windows platforms

Perl Compiler location PERLCMD Perl compiler set in 
database. For example:
/usr/bin/perl

<ORACLE
_CLIENT
>/perl/
bin/perl

Data and control files 
location

CTLFOLDER Data and control file 
extracts location, where 
flat files placed to 
pickup by the file 
processor.
For example: user 
location

Separator to be used FILESEP Separator to be used for 
OWB deployment, 
where database resides.

For example: Win '\\' 
and for Linux '/

For Unix: 
Use ‘ /’

For 
Windows: 
Use ‘\\’

File Manager location FILEMGR File Manager location on 
the database server. 
Copy the 
splfilemanager.plx file 
from BI241/Scripts 
directory to this 
location.
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Configuration Worksheet for ETL Component based on OWB Installation
EMAIL Configuration

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Email ID of Sender EMAILIDSEN Email ID of sender 
to be configured in 
OWB while in 
deployment

For example: 
OWB@oracle.com

Email ID for Reply-
To address

EMAILIDRPL Email ID of Reply 
TO to be configured 
in OWB while in 
deployment

Email ID of 
Receiver

EMAILIDREC Email ID of 
Receiver to be 
configured in OWB 
while in deployment

SMTP server SMTPSRV Host name of the 
server where SMTP 
Service Configured

SMTP server port SMTPPORT Port number on the 
server where SMTP 
Service Configured

Control Center Configuration

Menu Option Name Used In 
Documentation Usage Customer 

Install Value

Repository 
Control Center 
Name

CCNAME OWB Repository 
Control center to 
created or used to 
deploy the OWB 
objects

External Data Source Configuration

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Path of the External 
Datasource

EXTERNAMEDS Path of the extracts 
location

Path of the External 
Datasource LOG

EXTERNAMEDS_
LOG

Path of the extracts 
log location

File Processor 
Daemon Execution 
Switch

FPDEXECUTION
_SWITH

File processor 
execution switch

1
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Configuration Worksheet for ETL Component based on ODI Installation
Configuration Worksheet for ETL Component based on ODI Instal-
lation

Environment installation options are as shown in the section below:

• Environment Installation Options

• Environment Configuration Options

Environment Installation Options

File Processor 
Extract Max Load

FPDEXTRACT_M
AXLOAD

File processor to 
pick up the 
Extractor to load

5

File Processor 
Scheduler Poll 
Duration

SCHEDULER_PO
LL_DURATION

File Processor 
Scheduler Poll 
Duration

60

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Menu Option Name Used in 
Documentation 

Usage Customer 
Install 
Value

Oracle Client 
Home

Directory

ORACLE_CLIEN
T_HOME

The home directory of the 
Oracle Client. The application 
will use the Perl included 
under this Oracle Client.  The 
user used to install the oracle 
client should be used to install 
ETL Component based on 
ODI

Example Location: 
/oracle/client/product/
11.2.0.3
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Configuration Worksheet for ETL Component based on ODI Installation
Environment 
Mount

Point

<SPLDIR> The mount point into which 
the application is installed.

Local directory Where 
components to be installed.

For example:/OUASA for 
UNIX and C:\OUASA for 
Windows

This mount point MUST exist 
and the administrator user ID 
MUST be able to write to this 
directory. (This is the user ID 
that is created specifically to 
administer the environments; 
the installation sets 
permissions on all 
subdirectories installed under 
this directory.

See <SPLENVIRON> below 
for more information on how 
this mount point is used.

Log Files Mount 
Point

<SPLDIROUT> A mount point that will 
contain any application output 
or application logs.

Example value is / OUASA/
sploutput for UNIX 
installation or 
C:\OUASA\sploutput for 
Windows

Environment 
Name

<SPLENVIRON> A descriptive name to be used 
as both a directory name 
under the mount point

<SPLDIR> and an 
environment descriptor. This 
value typically identifies the 
purpose of the environment. 
For example, DEV01 or 
CONV

Web Java Home

Directory

JAVA_HOME The location on the disk 
where Java 1.6 is installed.

For example: 
$ORACLE_BI_HOME/jdk

Menu Option Name Used in 
Documentation 

Usage Customer 
Install 
Value
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Configuration Worksheet for ETL Component based on ODI Installation
Environment Configuration Options
Following options are discussed in this section: 

• Environment Description

• ODI Environment Configuration

• ODI Agent Configuration

• Source Golden Gate Configuration

• Target Golden Gate Configuration

Environment Description
Environment description details are as shown in the table below:

Menu 
Option 

Name Used in 
Documentation

Usage  Customer 
Install Value

Environment

Description

DESC This is a free form text 
field to describe the 
purpose of the 
environment

ODI Environment Configuration
ODI environment configuration description details are as shown in the table below:

Menu Option Name Used in 
Documentation

Usage  Customer 
Install Value

WEBLOGIC 
HOME

WLS_HOME Directory where 
weblogic to be used for 
ODI has been installed.

For example: 
/WLS_HOME/ 
wlserver_10.3

ODI HOME ODI_HOME Directory where Oracle 
Data Integrator (ODI) 
has been installed.

ODI 
SUPERVISOR  
USER

ODI_SUP_USER For example:  
/WLS_HOME/
Oracle_DI1

     ODI 
SUPERVISOR 
Password

                 
ODI_SUP_PASSWORD

ODI Supervisor 
password

Enter 
Sunopsis123

Target Database 
Name

OBIEE_DBNAME The name of the 
database instance which 
the application connects 
to. 
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Configuration Worksheet for ETL Component based on ODI Installation
ODI Agent Configuration

Target Database 
Host

OBIEE_DBSERVER Host name of the server 
where database resides.

Target Database 
Port

OBIEE_DBPORT Database port number 
on the database server 
used for connecting to 
the database.

DWADM Schema 
Name

DWADM_SCHEMA The Target Schema User 
for Facts and dimentions 
present.

Enter DWADM

DWADM Schema 
Password

DWADM_PASS The password  for 
DWADM.

Enter DWADM

ODI Master 
Schema Name

ODI_MASTER _SCHEMA   ODI Master Schema 
user where ODI master 
repository is created 

Enter 
MASTER_REPO

ODI Master 
Schema Password

ODI_MASTER_ 
SCHEMA_PASS

ODI Master Schema 
user password 

Enter 
MASTER_REPO

ODI Work Schema 
Name

ODI_WORK _SCHEMA ODI Work Schema User 
where ODI Work 
Repository is get created.

Default WORK REPO 
is OBIU

Enter 
WORK_REPO

ODI Work Schema 
Password

ODI_WORK_ 
SCHEMA_PASS

ODI Work Schema  
User Password 

Enter 
WORK_REPO

ODI Master 
Repository ID

ODI_MASTER_REPO_ID ODI Master Repository 
ID.

Default Value is 601

ODI Work 
Repository ID

ODI_WORK_REPO_ID  ODI Work Repository 
ID 

Default Value is 602

Menu Option Name Used in 
Documentation

Usage  Customer 
Install Value

Menu 
Option 

Name Used in 
Documentation

Usage  Customer 
Install Value

ODI 
Weblogic   
Agent Host

ODI_AGENT_HOST Host on which ODI 
Weblogic Domain is 
created.
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Configuration Worksheet for ETL Component based on ODI Installation
Source Golden Gate Configuration

ODI 
Weblogic 
Agent port

ODI_AGENT_PORT Port on which ODI 
Weblogic agent is 
configured to run. This is 
the port of ODI 
Weblogic Managed 
Server Port. 

Menu 
Option 

Name Used in 
Documentation

Usage  Customer 
Install Value

Menu 
Option 

Name Used in 
Documentation

Usage  Customer 
Install Value

Source 
Instance 
Name

SRC_INST_NAME Source from which 
data has to be 
extracted.

Source 
Golden Gate 
Manager Port

SRC_GG_MGR_PO
RT

Port number on which 
Golden Gate Manager 
is running on the 
source Database Server

Source 
Golden Gate 
Dynamic 
Minimum 
Port

SRC_GG_DYN_POR
T_MIN

Port number on which 
the Golden Gate 
Dynamic minimum 
port is configured on  
the source Database 
Server.

Source 
Golden Gate 
Dynamic 
Maximum 
Port

SRC_GG_DYN_MA
X_PORT

Port number on which 
the Golden Gate 
Dynamic maximum 
port is configured on  
the source Database 
Server.

Source 
Golden Gate 
Algorithm

SRC_GG_ALGORIT
HM

Algorithm for Golden 
Gate configured on the 
Source Database 
Server. Default Value is 
1.

Source 
Golden Gate 
Encryptkey

SRC_GG_ 
ENCRYPTKEY 

This is the Encryptkey 
configured in Golden 
Gate on the source 
database Server. 
Default Values is 
"DEFAULT
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Configuration Worksheet for ETL Component based on ODI Installation
Target Golden Gate Configuration

Source 
Golden Gate 
Shared Secret

SRC_GG_ 
SHARED_ SECRET

This is the SecretKey 
configured in Golden 
Gate on the Source 
Database Server. 
Default Value is 
"DEFAULT".

Source 
Database 
Name

SRC_DB_NAME This is the source 
database name, where 
ODI connects to 
reverse engineer the 
source tables.

Source 
Database 
Host

SRC_DB_HOST This is the Source 
Database Server Host.

Source 
Database Port

SRC_DB_PORT This is Source 
Database Port.

Source 
Database 
Home 

SRC_GG_DB_HOM
E

This is the Source 
Datbase Home 
installed location.

Source 
Golden Gate 
Home

SRC_GG_HOME This the Golden Gate 
installed Location.

Menu 
Option 

Name Used in 
Documentation

Usage  Customer 
Install Value

Menu Option Name Used in 
Documentation

Usage  Customer 
Install Value

Target Golden 
Gate Manager 
Port

TRG_GG_MGR_PORT Port number on which 
Golden Gate Manager is 
running on the target 
Database Server.

Target Golden 
Gate Dynamic 
Minimum Port

TRG_GG_DYN_PORT_M
IN

This is the Dynamic 
Minimum port 
configured in Golden 
Gate on the target 
Database Server.

Target Golden 
Gate Dynamic 
Maximum 
Port.

TRG_GG_DYN_PORT_M
AX

This is the Dynamic 
Maximum port 
configured in Golden 
gate on target database 
Server.
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Configuration Worksheet for Dashboard Component Installation
Configuration Worksheet for Dashboard Component Installation
Following topics are included here: 

• Environment Installation Options

• OBIEE Environment Configuration Options

Target Golden 
Gate 
Algorithm

TRG_GG_ALGORITHM This is the Algorithm 
configured in Golden 
Gate on target Database 
Server. Default value is 
1. 

Target Golden 
Gate 
Encryptkey

TRG_GG_ENCRYPTKEY This is the Encrypt Key 
Configured in Golden 
Gate on the target 
database server. Default 
value is “DEFAULT”.

Target Golden 
Gate Shared 
Secret

TRG_GG_ 
SHARED_SECRET

This is shared Secret Key 
configured in Golden 
Gate on Target Database 
Server. Default Value is 
"DEFAULT

Target 
Database 
Home

TRG_DB_HOME This is Database Home 
is installed location on 
the Target Database 
Server.

For example: 

/u00/oracle/app/
oracle/product/11.2.0/
dbhome_1 

Target Golden 
Gate Home

TRG_GG_HOME This is the Golden Gate 
Installed Location on 
target Database Server

For example:  
opt/local/
ggs_11.2.1.0.5_2

Menu Option Name Used in 
Documentation

Usage  Customer 
Install Value
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Configuration Worksheet for Dashboard Component Installation
Environment Installation Options

Menu Option Name Used In 
Documentation Usage

Customer 
Install 
Value

Oracle Client Home 
Directory

ORACLE_CLIENT_H OME The home directory of the 
Oracle Client. The application 
will use the Perl included under 
this Oracle Client.

Example location:
<ORACLE_BI_HOME>/
Oracle_BI1

Environment Mount 
Point

<SPLDIR> The mount point into which the 
application is installed. For 
example:
/OUASA for UNIX and 
C:\OUASA for Windows 

This mount point must exist 
and the administrator user ID 
must be able to write to this 
directory. (This is the user ID 
that is created specifically to 
administer the  environments; 
the installation sets permissions 
on all subdirectories installed 
under this directory.

See <SPLENVIRON> below 
for more information on how 
this mount point is used.

Log File Mount Point <SPLDIROUT> A mount point contains any 
application output or 
application logs. 

Example value is /OUASA/
sploutput for UNIX installation 
or C:\OUASA\sploutput for 
Windows

Environment Name <SPLENVIRON> A descriptive name to be used 
as both a directory name under 
the mount point <SPLDIR> 
and an environment descriptor. 
This value typically identifies the 
purpose of the environment. 
For example, DEV01 or CONV

Web Java Home 
Directory

JAVA_HOME The location on the disk where 
Java 1.6 is installed. 
For example:
$ORACLE_BI_HOME/jdk
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OBIEE Environment Configuration Options

Menu Option Name Used In 
Documentation Usage

Custome
r Install 
Value

Oracle BI Instance 
Home

ORACLE_INSTANCE Location on the disk 
where OBIEE software 
is installed instance 
home.

Example location for 
Oracle Database:
/orasw/BLDENGBI/
instances/instance1

Oracle BI Home ORACLE_BI_HOME Location on the disk 
where OBIEE software 
is installed Oracle_BI 
Home.

Example location for 
Oracle Database:
/orasw/BLDENGBI/ 
Oracle_BI1

Oracle BI Domain 
Home

DOMAIN_HOME Location on the disk 
where OBIEE software 
is installed Oracle_BI 
Home.

Example location for 
Oracle Domain home:
/orasw/BLDENGBI/ 
user_projects/domains/ 
bifoundation_domain

WebLogic Domain 
Console User Name

WLS_EM_USER WebLogic domain login 
user name.

You will be prompted 
for the password after 
installation.

WebLogic Domain 
Console Host

WLS_EM_HOST The host name on which 
the web application 
server resides.

Default value: <current 
server name>
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Target Database Details
Target database details are as listed in the blelow table: 

Menu Option Name Used In 
Documentation Usage

Customer 
Install 
Value

Target Database Name OBIEE_DBNAME Name of the target 
database

Target Database Host OBIEE_DBSERVER Host on which 
database is created.

Target Database Port OBIEE_DBPORT This is the target 
database port.

DWADM Schema 
Name

DWADM_SCHEMA Schema name of the        
star schema.

DWADM Schema 
Password

DWADM_PASS Password for 
DWADM

WebLogic Domain 
Console Port Number

WLS_EM_PORT A unique port number 
within the system that 
will be assigned to the 
HTTP port. This is the 
port number that is used 
as a part of the client 
URL request to connect 
to the host.
This will be OBIEE 
weblogic console admin 
port number.

Example value: 7001

 Provide OBIEE 
Version Installed

OBIEE_VERSION This is the version of 
Oracle Business 
Intelligence Enterprise 
Edition installed on the 
target system.

Menu Option Name Used In 
Documentation Usage

Custome
r Install 
Value
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Appendix D
Customizing Oracle Utilities Advanced Spatial 

and Operational Analytics

This chapter provides details about customizing Oracle Utilities Advanced Spatial and Operational 
Analytics. 

Following topics are discussed:

• Customizing Web Catalog

• Customizing Repository (RPD) File

• Customizing Oracle Warehouse Builder (OWB) Mappings

• Customizing the File Processor Mappings

Customizing Web Catalog
It is required that all customizations are done in a separate folder in order for those 
customizations to be preserved during the upgrade.

Note that dashboards would still be overwritten during the upgrade and any mappings between 
dashboards and custom (CM) answers will be lost and would need to be re-mapped manually.

Therefore, we recommend that the customer uses a staging (CM) environment for upgrade and 
manual re-mapping of dashboards before moving the upgraded CM content into the production 
environment.

Customizing Repository (RPD) File
It is required that all customizations are done in a separate repository (RPD) file, separated from 
the product's out-of-the-box RPD file. Any CM changes will be merged into the upgraded RPD 
file through the Merge utility of the OBIEE tool, together with the product's out-of-the-box RPD 
file. We recommend that the customer uses a staging (CM) environment for the RPD upgrade.

Customizing Oracle Warehouse Builder (OWB) Mappings
Oracle Warehouse Builder (OWB) mappings can be modified by updating the OUBI Metadata in 
the Table Mapping screen, and running the OWB Generator for the Fact or Dimension table that 
was modified, to generate TCL scripts that can then be loaded into OWB and deployed to the run-
time database.

After an upgrade, the OWB Generator would need to be rerun for any modified fact and 
dimension tables again, since the OWB Mappings will be overwritten by the default mappings in 
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Customizing the File Processor Mappings
an upgrade. We recommend that the customer user a staging (CM) environment to test the OWB 
upgrade and mapping redeployment prior to loading the OWB mappings in a production 
environment.

For other supported OWB modifications, refer to this support document in Oracle Support:

• Supported Oracle Warehouse Builder Changes for BI Oracle Utilities Business Intelligence 
[ID 877966.1]

Customizing the File Processor Mappings
For adding new mappings so that they can be processed by the File Processor perform the 
following steps:

1. Create the "cm_schedulerParm.properties.exit_1.include" file under templates folder.

For UNIX:

$SPLEBASE/templates

For Windows:

%SPLEBASE%\templates

2. Add the following entry in "cm_schedulerParm.properties.exit_1.include" in the file:

extract.file.mapping.override.count = <COUNT_NUMBER>

Where COUNT_NUMBER is scheduler parameter mapping count from source 
parameter file (viz. extract.file.mapping.count) + user configurable mappings count.

For example:

extract.file.mapping.override.count = 251

3. Add the new user parameter mappings in "cm_schedulerParm.properties.exit_1.include" file.

Example:

extract.file.mapping250 = <MAPPING1>

extract.file.mapping251 = <MAPPING2>

Note: Refer to Oracle Utilities Advanced Spatial and Operational Analytics Administrator's Guide 
for mapping format.

4. Run the initialSetup command:

For UNIX:

$SPLEBASE/initialSetup.sh

For Windows:

%SPLEBASE%\initialSetup.sh

5. Start the File Processor.

For UNIX:

cd $SPLEBASE/bin

nohup ksh ./startFileprocessordaemon.sh > ../tmp/

consoleFileprocessordaemon.log 2>&1 &

For Windows:

startFileprocessordaemon.cmd
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Changing the environment parameter values
For changing environment parameter values perform the following steps:

1. Run splenviron command to initialize the environment:

For UNIX:

$SPLEBASE/bin/splenviron.sh  -e  $SPLENVIRON

For Windows: 

%SPLEBASE%\bin\splenviron.cmd -e %SPLEVIRON%

2. Run configureEnv command for changing the configuration menus:

For UNIX: 

$SPLEBASE/bin/configureEnv.sh

For Windows: 

%SPLEBASE%\bin\configureEnv.cmd

3. Make the desired changes to the environment parameters by choosing the appropriate menu 
option from the displayed list.

4. After making all the changes, choose option P to process the changes.

5. Run the initialSetup command for applying the changes:

For UNIX: 

$SPLEBASE/bin/initialSetup.sh

For Windows: 

%SPLEBASE%\bin\initialSetup.cmd
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Appendix E
Additional Resources

Contacting Oracle Support
To contact Oracle support, visit the Oracle Support Web site at

http://www.oracle.com/support/index.html
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Appendix F
License and Copyright Notices

Third Party Products
Following topic is discussed in detail: 

Notice Concerning Usage of Mapping Data

Notice Concerning Usage of Mapping Data
This section includes the following: 

• Digital Map Data Provider

• eLocation's Regional Coverage

Digital Map Data Provider
Oracle Utilities Advanced Spatial and Operational Analytics require digital map data for providing 
the mapping functionality. This data could be obtained by licensing eLocation (http://
elocation.oracle.com), Oracle's Location Services. eLocation is a comprehensive location mapping 
tool that comprises a number of components including geo-coding, mapping and a routing engine. 
It uses Navigation Technologies Corporation's (NAVTEQ) data. 

eLocation's Regional Coverage
eLocation is currently licensed for background maps in Western Europe and North America. 
Refer http://elocation.oracle.com/elocation/legal.html for more information on eLocation’s 
regional coverage and Terms and Conditions. 

Customers outside the eLocation covered region or who don't license eLocation can license map 
data from Navteq or any other third party map data providers such as: 

• Google Maps

• Bing Maps

Oracle Utilities Advanced Spatial and Operational Analytics provide an easy plug-in feature to 
enable Google or Bing maps. 
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